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Project Build & Deploy

Enterprise Architect has been built from the ground up with the Project Manager in mind. Organizational repositories are
valuable corporate assets and must be managed and maintained accordingly. Risk can be modeled and managed in a
variety of locations, and project effort can be determined with built in support for Metrics and Estimation. Tasks can be
created and assigned to Resources performing particular roles, and these can be conveniently viewed in a built-in Gantt
Chart. There is an Audit function that allows changes to be tracked at a fine-grained level, and a Library facility and
Element Reviews and Discussions that allow users to work collaboratively on models.

Each element in Enterprise Architect has a number of default properties that are useful for project management, such as
phase, version, status, author, and creation and modified dates. Using these, coupled with the reporting engine, the
information can be extracted easily even by a novice user. The Project Manager and other users have the ability to create
elegant charts that depict the information in the repository in a compelling visual format. For example, a pie chart could
be created to show the status of stakeholder requirements for a particular phase of the project.

Facilities

Facility Detail

Metrics and Estimation Project estimation is working out how much time and effort is required to build and
deploy a solution.

Enterprise Architect provides the Use Case metrics facility as a means of:

Measuring the complexity of a system·
Getting an indication of the effort required to implement the model·
Getting an indication of the project timescale·

You base these estimates on carefully-calibrated metrics.

Resource Management Resources are the people who work on a project.

You can assign roles to resources and allocate tasks on specific model elements,
which enables tracking of effort and estimation of time to complete.

Project Maintenance During a project you monitor and manage the development and progress of
individual model elements.

You can record problems, changes, issues and tasks that affect these individual
elements as they arise, and document the solution and associated details.

Similarly, Enterprise Architect helps you to manage changes and issues that apply
to the whole system.

Project Tasks and Issues In the course of a project, there are various non-technical tasks that are vital to the
successful management and completion of the project, such as meetings.

Enterprise Architect helps you to record and monitor these, and to manage
non-technical project issues as they arise.
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Kanban Boards

Background

Kanban, which literally translates as Visual (Kan) Card (Ban) or billboard, is an operational method used to increase
efficiency. It was originally developed by the industrial engineer Taiichi Ohno while working at Toyota. Ohno analyzed
the way supermarket shelves are stocked and applied the lessons learnt to the factory floor, creating unprecedented
efficiency. The visual card (Kanban) was used to signal the need for more items to upstream suppliers on the production
line. The Kanban method can be applied to any field, including strategic planning, sales and marketing, and human skills
management, but more recently Kanban has been applied to the process of developing software-centric solutions in an
attempt to ensure that value is delivered to the customer as quickly as possible. The information technology industry has
been plagued since its beginning with projects running over schedule and over budget, but more significantly failing to
deliver value to customers in a time frame that enables them to compete and be successful. These endemic issues have
become a critical element of business in an age dominated by digital disruption and unprecedented change.

Principles

Kanban is fundamentally very simple and relies on a small number of principles, the origins of which can be attributed to
the engineers at Toyota:

Make work visible·
Traditional project management methods hide the work items from the people who carry out the work; Kanban
exposes the work to everyone, allowing any team member to contribute to the way work items flow through the
board and ultimately deliver value to the customer

Limit work in progress·
Project Managers and team leads have traditionally been under pressure to get products finished or to include more
features, and have responded to this pressure by burdening the team with more work items; this results in lots of
focus switching and inevitably half-finished items and reduced efficiency
Paradoxically, Kanban encourages the number of items in progress to be limited, resulting in greater efficiency and
more finished items; the reduced number of in-progress items allows team members to concentrate on one thing at a
time without having to switch focus
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Manage the flow of work·
Using traditional project management methods, bottlenecks or blockers are hard to identify and typically only
surface at the time of a post project review, often only after the product is delivered late and missing features
Using Kanban, the visibility of work and the ability to identify stalled processes - whether because of bottlenecks or
lack of work items - allows a flow problem to be identified and rectified quickly
The next diagram shows the way the Kanban facility in Enterprise Architect responds when the number of items in a
lane exceeds the number specified in the max items (Work in Progress or WIP limit) value for that lane; the header
is highlighted in a configurable color and the numbers (number of items/max items) also provide a visual cue that
will prompt the team to respond by swarming (a number of team members focusing) on the lane to reduce the
number of items

Example 1

A high priority User Story that is at the top of the backlog could be pulled into the 'In Progress' lane and a developer
could immediately commence work on it. The work might entail the coding of business rules, the review of detailed
requirements, changes to a database schema or the addition of an element or attribute to an information schema, and the
creation of a new or updated deployment environment.

All of these artifacts can be found inside the same repository without the need to launch other tools or schedule meetings
to locate the needed information. The strategic drivers can be seen in the context of their business owners, architectural
design and principles can be viewed, Business Rules can be visualized in relation to the policies they qualify, a live
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connection can be made to the databases and their schemas analyzed and altered, XML schemas can be inspected and
messages constructed, programming code can be written and deployment targets detailed, and all of this achieved in a
single collaborative platform.

Example 2

This diagram demonstrates a Backlog diagram in a two or three stage workflow. The entire diagram is used to manage
the backlog and items can be dragged within a lane to define their order in that lane, or between lanes to define their
importance and position in the backlog.
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Flexibility

Enterprise Architect has a flexible and integrated Kanban facility built into the core product, allowing projects of any
size and vertical market to benefit from the profound efficiencies that come with this simple, elegant and lean project
management approach. Regardless of the type of process that is being used, Enterprise Architect’s Kanban features can
be quickly and seamlessly integrated into any method, creating a compelling visual solution and team collaboration
platform that will result in products, services and solutions being delivered to customers with efficiency and in record
time - delighting both product owners and customers alike.

The Kanban features in Enterprise Architect are highly configurable and can be altered to suit any team and process,
including Agile, iterative and incremental, and even waterfall projects. There is a very low barrier to adoption and teams
can commence with Kanban immediately. The most basic Kanban board consists of a diagram divided into a small
number of lanes; a range of work items can be added to the diagram, including Features, User Stories, Defects, Changes,
Use Cases, Requirements and more. Work Items can be drawn with a compelling visual style representing a colored card,
and can be dragged anywhere in the diagram to change order in a given lane, or from lane to lane progressing from left to
right through the board, representing progress towards value for the customer. The lanes are typically bound to the values
of a 'project management aware' property such as status or phase, and as the item is dragged from lane to lane the value
of the bound property is automatically changed. This facility can, however, be switched off for an individual lane by
setting the lane to 'Not-Bound', so that the element property is not changed when it moves to that lane. You might set the
lane to 'Not-Bound' if, for example, the lane captures elements that have fallen out of the normal process and need to be
assessed according to the property value when the problem arose.

Resource Allocation

Any number of resources, performing specified roles, can be allocated to work items as they flow through the Kanban
board, and the progress can be visualized as one or more progress bars displayed at the bottom of the card. The allocation
is driven by Enterprise Architect's practical and simple resource allocation facility, which can be used to define the
relationship between resources (team members) and work items (cards). Any number of team members can assign
themselves to a work item, indicating the role they will perform, and the start date, finish date, and the expected time can
be used to record estimates of how long the task will take.
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Progress can be updated as a percentage of completion, which can be displayed visually on the card. The Kanban board
(like any diagram) can also be displayed as a Gantt chart or a list view, supporting alternative project management
representations.

Configuration

The Kanban cards can be configured to display an extensive set of properties, with compelling icons, colors and progress
bars to communicate the important aspects of the work item, resource allocation and work item progress. The properties
include the item name, type, status, version, priority, stereotype, phase, author and more.

The names, colors and number of lanes can be configured, in addition to a range of other properties such as the overfill
limits, defaults and the definition of sub-lanes. The appearance of the board and the work items can all be configured,
using different colors, fonts and styles including a hand-drawn mode that might appeal to teams more accustomed to
using a physical board with colored notes. It is also possible to set the chart appearance to highlight elements that come
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from the same hierarchies.

Enterprise Architect has built-in Kanban diagrams, and a number of workflow Patterns that are pre-built and that can be
used 'As-Is' or configured to suit any project or initiative. The workflow Patterns define one, two or three stage
workflows; for example, the two stage workflow defines a Kanban board solely for managing the prioritization of the
backlog, and items from the backlog are then moved from the backlog Kanban to the first lane of the iteration Kanban. If
necessary, the Product Owner can use Enterprise Architect's security facility to lock the backlog Kanban, ensuring that
the order of items in the backlog is not inadvertently changed.

There are a number of commercial tools that allow Kanban to be used to manage projects visually, but Enterprise
Architect’s Kanban facility is incredibly useful because the tool is also a sophisticated modeling platform for strategic
and business analysis, architecture, design, implementation, testing and deployment. This means that work items on a
Kanban Board can be linked to strategic decisions, business rules, policies, requirements, architecture and design
elements, wireframes and UX models, programming code, database tables, procedures, tests, virtual or physical
deployment nodes, and more. For the first time everyone in the team can collaborate in the same environment using a
toolbox of facilities purpose built for their discipline, while at the same time being able to visualize and manage the value
being delivered to the customer in a visually compelling set of Kanban boards.

Charts and Dashboards

Enterprise Architect has a sophisticated charting facility that can be used to create expressive charts and dashboards,
which will provide insights into the Kanban process and enable Product Owners and other team members to monitor
performance and determine ways of fine tuning how the team is working. There is a range of built-in charts including
Bar and Pie Charts, Heat Maps and more, but a team is free to create any number of user-defined charts that can be
incorporated into team processes and reviews.

Application
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The Kanban project management methodology helps you to develop a dynamic, easy-to-view progress summary of the
stages of development of a project, where the stages are represented as lanes and sub lanes of a diagram - a Kanban
Board. In Enterprise Architect, you can apply a form of this methodology to your project administration diagrams to
monitor and manage the flow of work in a particular area.

The stages of development can be defined by the value of a project management property of an element, such as Phase,
Version or Status, or a user-defined Tagged Value. The elements that represent each task or object of a task are initially
placed in the lanes for the earlier stages of the project, and work on the task is reflected by moving the corresponding
element to a different lane on the diagram. If a diagram is linked to a project management property, dragging an element
from one lane to another automatically changes the value of the property to the value that the lane represents.

In this illustration, the lanes identify what work is being performed in each stage of development.

New tasks will usually begin in the left-most lane, and completed tasks will usually pass through all lanes before coming
to rest in the right-most lane and then being moved off the diagram. A typical workflow is to choose the next task that
you are going to work on by starting in the right-most lane and seeing if it has any tasks that you are able to progress; if
not, move to the next lane and repeat, and so on.
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Kanban Quickstart

Create a Kanban Diagram

A Kanban diagram is a board that allows team members to visualize work items that are represented as colored cards.
The board is divided into a number of lanes and team members move the cards from left to right as work is completed
towards providing value to the customer.

You can create a Kanban diagram by taking an existing diagram and setting its Kanban properties, but it is easier to use
one of the diagram types provided by the Kanban Diagrams UML profile as a starting point and then change its
properties to suit your own project.

Step Action

1 In the Browser window, right-click on the parent Package and select the 'Add Diagram' command.

2 In the 'New Diagram' dialog, use the 'Select From' header to select the 'Software Construction > Kanban
Perspective' in the left-hand pane and choose one of the diagram types from the right-hand pane (Basic,
Backlog, Iteration and Complete). Give the new diagram a name in the 'Diagram' field and click on the
OK button.

3 If you cannot find 'Kanban' in the list, you must enable the Kanban MDG Technology.

Add Elements to a Kanban Diagram
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Work items are represented visually on a Kanban diagram but first must be added to the diagram. They can be elements
that already exist in the repository or new elements dragged from the Kanban Toolbox pages and dropped onto the
diagram. Any element type can appear on a Kanban board but the most typical types are Features, User Stories, Defects
and Changes. Use Cases, Scenarios and Requirements are also sometimes added.

When you drop an element onto a Kanban diagram, the lane it is added to depends on whether the diagram has a property
value defined, and also whether it has a default lane. If the Kanban diagram has a property value defined and the new
element's property matches one of the lanes, then it will be added to that lane. Otherwise, it will be moved into the
default lane, or to the right of the last lane if no default lane has been nominated.

You can define the Default lane on the 'Lanes' page of the 'Kanban Options' dialog.

The Kanban Toolbox page will open automatically whenever you open a Kanban diagram. The Toolbox page provides a
default set of elements that you can use to represent units of work on your Kanban diagrams, but any type of element can
be added.

Step Action

1 Open your Kanban diagram. The Diagram Toolbox should appear with the Kanban page selected
automatically.

If the Diagram Toolbox doesn't appear, click on the >> button in the top left corner of your diagram·

If the Kanban page isn't automatically selected, click on  to display the 'Find Toolbox Item'·
dialog and specify 'Kanban'

2 Drag elements from the Kanban page onto the Kanban diagram. The page provides these element types:

Import a Kanban Workflow Pattern

Each organization or team will typically want to define their own workflow that is appropriate for the initiatives they
work on, and each might have a number of workflows defined for different types of initiative. While this can be done
from scratch it is much easier to use one of the built-in Patterns, either 'As-Is' or as a starting point. A workflow can be
made up of any number of Kanban boards linked together into a single workflow; for example, a three stage workflow
would contain three separate boards. Each board can be configured with any number of lanes and sub-lanes representing
the stages in that part of the workflow. Team members can move Work Items between lanes in a single board and also
between the boards that make up the entire workflow.

Kanban Workflow model Patterns help you to very quickly set up a one-, two- or three-stage workflow, using and
linking the Backlog, Iteration and Complete Kanban diagrams.

Step Action

1 In the Browser window, select the Package under which to create the Workflow Pattern.

2 Click on the Browser window header and select the option 'Model Builder (pattern library)', or press
Ctrl+Shift+M.  The Model Builder dialog displays.
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3 Click on the Perspective button and select 'Project Management > Kanban'.  The panel header changes to
'Kanban Perspective' and the panel shows the three workflow patterns you can select.

Kanban One Stage Workflow·
Kanban Two Stage Workflow·
Kanban Three Stage Workflow·

When you click on one of the patterns, the right hand panel displays an example diagram and several
sections of useful information on using the pattern.

4 If you have the 'Customize Pattern on import' checkbox selected, prompts display to select the Packages to
import in the Patterns. Each Pattern contains one Package, which is automatically selected. Click on the
OK button for each Pattern.

5 Open each of the new diagrams and consider whether they fit with your own workflow preferences. The
diagrams provided can be changed to suit your style of working.

Moving Kanban Items

Work Items flow through Kanban boards typically from left to right as work is performed, moving the item closer to
delivering business value for the customer. In a one-stage workflow, work items will be moved through a series of lanes
through a single board, but in workflows that consist of more than one Kanban board the items will also jump from one
board to the next. For example, in a two stage workflow there is a backlog board and items will be prioritized in the
board based on their priority. The work items that have the highest priority in the Backlog then need to be moved to the
Iteration Board, where implementers will pull them into the In-Progress lanes.

Moving Items in a Kanban Diagram
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Moving items within a Kanban diagram is simple and intuitive and can be achieved by dragging and dropping a work
item from one location to another. If an item is moved within the same lane its position is simply changed in that lane. If
an item is dragged to a different lane and the lanes are bound to an element property or user defined Tagged Value the
value of the item's property or tag will also be changed.

Step Action

1 Select the item in the Kanban diagram.

2 Drag and drop it into a new position either in the same lane or a different lane.

Notes

When an item is moved between lanes and the lanes are bound to a property or Tagged Value, the value of the property
or Tag will be automatically changed.

Example

Moving Items between Kanban Diagrams

Items can be moved between Kanban boards by using a drop zone positioned to the right of the diagram. Each drop zone
has the name of another diagram in the workflow, and elements on the current board can simply be moved by dragging
and dropping them on the appropriate drop zone.

To create a drop zone, simply drag the target Kanban board onto the current Kanban diagram and release the mouse
button. In response to the prompt, select the 'Drop Diagram as Diagram Reference' option. You can have more than one
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drop zone, one for each of the other Kanban boards in the work flow. If you generate a set of Kanban workflow diagrams
using the Patterns in the Model Builder, the drop zones are automatically generated on each diagram.

Step Action

1 Select the item in the Kanban diagram.

2 Drag the item to the right of the Kanban diagram Lanes.

3 Drop the item onto the zone with the name of the diagram you are moving the element(s) to.

4 Select 'Move to' to move the element to the new diagram or 'Create link on diagram' to create a link on the
second diagram without removing the element from the current diagram.

Example

In this diagram a work item representing a defect is being moved from the critical lane of a Backlog Kanban board to the
Iteration board.

Search for Kanban Diagrams

A well organized repository will assist in quickly locating specific Kanban diagrams, but in large and complex initiatives
it is common for some team members to need to search for Kanban Boards. Enterprise Architect has an easy-to-use yet
sophisticated search facility with a built-in search to find all Kanban diagrams in the repository. Having located a
diagram the user can continue moving objects from left to right across the board, contributing to the team's effort focused
on providing value to the customer.

Step Action

1 Select the 'Construct > Resource Management > Kanban > Find Kanban Diagram' ribbon option.

The search is immediately executed and the located diagrams are listed in the Find in Project view.

2 Double-click on any Kanban diagram that you want to open.
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Layout Filter Panel

A project of any appreciable size will typically have a large number of in-flight work items, and product owners and
team members will often want to filter the selection of items based on a set of conditions, such as high priority
requirements or those applying to particular stakeholders or people. This can be achieved using filters at two levels;
either the expedient ribbon Filter or the more sophisticated and persistent Diagram Filters facility.

Kanban diagrams with a large number of elements can be quickly filtered in real time using the Layout ribbon Filter
panel.

Access the Filter panel.1.

Select the Filter property and the operator (if appropriate), and specify a search term.2.

Elements not matching the specified condition will be obscured in the filtered diagram.
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Kanban Options

Enterprise Architect provides a number of options for generating a new Kanban diagram or for opening an existing
Kanban diagram. Having opened the diagram, you can define its structure, content and appearance. It is also possible to
configure a diagram of any other type to be a Kanban diagram, by simply adding Kanban properties to it. This useful
design feature means that a diagram containing, for example, a set of User Stories could simply be changed to a Kanban
diagram and the team could immediately begin using this flexible, lean, project management method.

To define the structure, content and appearance of a Kanban diagram, you use the 'Kanban' dialog.

When you display the 'Kanban' dialog, it defaults to the 'Configuration' page. You use this page to:

Set up basic Kanban properties, such as whether Kanban is enabled on the diagram, if the names are shown in the·
title bar of the diagram and if the width of each swimlane is locked, and

Create, modify and delete the primary lanes on a Kanban diagram; you can:·
     -  Create the lanes manually, or define a property that the lanes bind to, so that the lanes
        are generated automatically from that property when you click on the Fill from binding button
     -  Add lanes that are not bound to the property
For each lane you can define:
     -  The maximum number of elements that can be placed in the lane before triggering
        the 'Overfilled' indicator
     -  The fill color of the lane
     -  Whether it is the default lane that new elements are added to

Access

Ribbon Construct > Resource Management > Kanban > (options to generate and/or open a
Kanban diagram)    or
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Start > Personal > My Kanban (displays personal default Kanban diagram)

     Then

Design > Diagram > Manage > Kanban (on an open Kanban diagram)

Context Menu In the Browser window, right-click on the diagram name | Kanban

On a diagram, right-click on the background | Kanban

Configuration Options

Option Action

Enabled
Select the checkbox to apply any of the Kanban functionality to the diagram. If the
checkbox is not selected, the diagram will behave as a non-Kanban diagram.

Show Names in Title
Bar Select this checkbox to display the lane names (but not the sub-lane names) in the

diagram title bar, above the lanes. These will be visible once the lanes are defined.

When you have several elements in a column and scroll down to the lower ones, the
Lane headings disappear from view, so the names in the Title Bar continue to
identify the lane names.

Swimlane width locked
Select this checkbox to prevent the lanes in the diagram from being made narrower
or wider.

Bind Kanban to

Click on the  button and select the property to bind lanes to. This will be one
of:

Element, or·
Tagged Value (enumeration or string types only), or·
None (makes all lanes unbound).·

If you select 'Element', also select one of the properties 'Phase', 'Version', 'Priority'
(for Requirement-type elements), 'Status' or 'Author'.

If you select 'Tagged Value', also choose to either 'Create' a new tag (and simply
type in the name) or 'Select' an existing one.

In the latter case, the 'Kanban Tagged Value selection' dialog displays, on which
you click on the appropriate radio button to select either from a list of 'Global
Tagged Values', or from a list of 'Tagged Values from a selected element'. Click on
the Select Element button to browse for the element anywhere in the model.

The Global Tagged Values or those from the element are provided to the 'Tagged
Value' field. Click on the drop-down arrow on the right of the field and select the
reference Tagged Value from those listed. Click on the OK button.

The 'Bind Kanban to' field now displays either the element property or the Tagged
Value you have selected.

When you move an element between two 'Bound' lanes, a pop-up prompt displays
for you to confirm the move. Click on the prompt to make the move, or click
elsewhere on the diagram to abort the move. This prevents users from moving
elements between lanes by accident.

Read-only Bind
Select this checkbox to make the effects of binding Kanban lanes read-only. This
means a user can move elements between lanes and make various element
formatting changes, but the bound property value is not updated and the element
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position is not captured. If another user views the diagram, or the first user closes
the diagram and it is subsequently re-opened, the moved elements are in their
original positions.

Fill from binding
If you have chosen an element property to bind the Kanban lanes to, click on the
Fill from binding button to fill the lane list with existing values of that property.
This will delete all old lanes before creating a new lane for each of the new values.
Once the lanes have been created in this way, they can be renamed, reordered and
added to.

Name
The name of each lane can be filled automatically using the Fill from binding
button. You can overtype the names; these do not have to be unique but they cannot
be blank.

Max Items
You can set the maximum number of elements that can be placed in each lane. If
someone tries to move an element into a lane that has reached or exceeded its
maximum number, the heading of the lane will be displayed in the 'Overfilled' color
you define and enable on the 'Appearance' page. This gives a visual indication that
action might have to be taken to clear what appears to be a bottleneck in the
workflow process.

Color
Several or all of the lanes can have the same fill color, or you can set a different
color for each lane independent of the other lanes. Either:

Leave the 'Color' value set to 'Default' (set on the 'Preferences' dialog,·
'Gradients and Background' page), or

Overtype 'Default' with the hex code number for the required color, or·
Click on the drop-down arrow and select a color from the displayed palette·

The actual color is shown in the box at the left of the field.

Default
You can nominate one of your lanes as the default; that is, the lane does not assign
a bound property value to the lane title, and therefore can be filled with varied
elements such as those added to the chart by a Kanban search. So if you had three
lanes bound on the status values 'In Testing', 'Pass' and 'Fail', for instance, with the
'In Testing' lane being the default lane, and you added an element that had the status
of 'Not Run', it would be placed into the 'In Testing' lane instead of being placed out
on the right hand edge of the diagram past all the lanes.

You can only select one 'Default' checkbox; clicking on one checkbox clears any
previously-selected checkbox.

Bind to Left
The 'Bind to Left' property essentially makes a primary lane the same as a sub-lane.
Moving an element into a 'Bind to Left' lane will set the element's bound property
to the left-most bound lane. Consider a 'Phase' Kanban diagram with these lanes, in
order:

To Do (Default, Not Bound)·
Implement (Bound)·
To Do (Bind to Left)·
Review (Bound)·
To Do (Bind to Left)·
Deploy (Bound)·

Newly added elements will be added to the left-most 'To Do' lane with whatever
priority value they previously had. Moving them to the 'Implement' lane will then
set the phase to 'Implement'. When the implementation is complete, the element can
be moved to the 'To Do' lane before 'Review' without updating the element's phase
until it is moved into the 'Review' lane.
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Not-Bound
Select the checkbox to set the property binding to 'Not Bound' for the lane, so that
the element property is not changed when the element moves into that lane. You
might set the lane to 'Not-Bound' if, for example, the lane captures elements that
have fallen out of the normal process and need to be assessed according to the
property value when the problem arose. The lane has a property value, but it is not
applied to the element.

New
Click on this button to define a new lane on the Kanban diagram.

Modify
Click on a line in the 'Lanes' list and click on this button to position the cursor in
the 'Name' field in update mode, and to highlight the lane you are modifying to
make it easier to focus on the fields you might change.

Delete
Click on a line in the 'Lanes' list and click on this button to delete the lane.

Click on an entry in the 'Lanes' list and click on this button to move the entry one
line up in the list, and one lane to the left on the diagram.

Click on an entry in the 'Lanes' list and click on this button to move the entry one
line down in the list, and one lane to the right on the diagram.

Notes

The elements in a Kanban diagram individually represent work in progress; you cannot create connectors between·
elements on the diagram

If you apply a Kanban definition to a current diagram, all connectors on the diagram are hidden; when you·
de-activate the definition, the connectors are shown again

When you first set up a Kanban diagram, any element on the diagram that does not have one of the defined property·
values is moved to the right-hand side of the diagram

Moving an element into a lane automatically sets the appropriate property of that element to the value represented by·
the lane; for a Tagged Value, if the element does not have that tag, adding the element to the lane adds the tag and
sets it to the lane value

Elements on a Kanban diagram are automatically adjusted to match the width of the lane they are in, both when the·
element is moved into a lane and when the lane width is changed

Certain types of element are automatically excluded from a Kanban diagram search; these are:·
     -  Constraint
     -  Port
     -  ProvidedInterface
     -  RequiredInterface
     -  Boundary
     -  Hyperlink
     -  State Node (such as Choice and Junction)
     -  Text
     -  Win32
     -  Wireframing
     -  Package
     -  Diagram Frame
     -  Activity Region
     -  Sequence Element
     -  Note
     -  Standard Chart
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     -  Model View
     -  Time Series Chart
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Kanban Options - Sub-Lanes

Sub-lanes are a useful device for defining another level in the workflow; for example, you might want to divide the
'In-Progress' lane into a number of sub-lanes representing the individual developers, or any lane into 'In-Progress' and
'Complete'. The 'Sub-lanes' page helps you to quickly and easily create any number of new sub-lanes for a Kanban
diagram.

Access

Ribbon Construct > Resource Management > Kanban > (options to generate and/or open a
Kanban diagram)    or

Start > Personal > My Kanban (displays personal default Kanban diagram)

     Then

Design > Diagram > Manage > Kanban > Sub-lanes (on an open Kanban diagram)

Context Menu In the Browser window, right-click on the diagram name | Kanban >Sub-lanes, or

On a Kanban diagram, either:

Double-click on a lane > Sub-lanes·
Right-click on background | Kanban > Sub-lanes·

Creating Sub-Lanes
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You add sub-lanes simply by clicking on the New button and, in the 'Name' column, typing the sub-lane name.
Alternatively, you can leave the default string '<anonymous>' to create an un-named sub-lane, which can be useful for
organizing lanes that have lots of elements. The names of the lanes on the diagram are then automatically added across
the panel.

Once you have created sub-lanes, you apply each one to one or more parent lanes, by selecting the checkbox under the
name of each lane that is to contain the sub-lane. To assign every sub-lane to every lane, you can click on the Check all
button, and to clear this total assignment click on the Uncheck all button. You can also change the order of the sub-lanes
across all their parent lanes in the Kanban diagram, by clicking on the sub-lane names and on the up-hand and
down-hand buttons.

Within a specific parent lane column you can apply custom sorting to the sub-lanes, so that the sub-lanes in that lane are
in a different sequence to the same sub-lanes in a different lane. For a column that has assigned sub-lanes (that is, it
contains selected checkboxes) right-click on the header and select the 'Set lane order' option. A small dialog displays, in
which you click on the sub-lane names and use the up-hand and down-hand buttons to put them in the required sequence.
Click on the OK button to clear the dialog and apply the sub-lane. If a sub-lane order has been customized, you can
return it to the 'across-the-board' order by right-clicking the header again and selecting the 'Reset lane order' option.

Notes

Sub-lanes are not backwards compatible with earlier releases of Enterprise Architect; if you open a Kanban diagram·
containing sub-lanes in a release of the system earlier than Release 12.1, the sub-lanes will be permanently deleted
from the diagram

Elements on a Kanban diagram are automatically adjusted to match the width of the sub-lane they are in, both when·
the element is moved into a sub-lane and when the sub-lane width is changed
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Kanban Options - Appearance

Using the 'Appearance' page, you can set the Kanban diagram appearance options, such as the line and font colors and
use of the Hand Drawn mode.

Objects on a Kanban diagram are, by default, drawn using the Info View style.

This style displays an icon on the top right corner of the element, representing the element type, with a triangular icon to
the left of it representing the priority - red for High priority, and yellow for Medium priority. No icon shows for Low
priority. The Priority, as for various other element properties, is also represented by a line of text in the body of the
element. You can specify which properties are shown by selecting the appropriate checkbox from the list at the bottom of
the 'Appearance' page.

Access

Ribbon Construct > Resource Management > Kanban > (options to generate and/or open a
Kanban diagram)    or

Start > Personal > My Kanban (displays personal default Kanban diagram)
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     Then

Design > Diagram > Manage > Kanban > Appearance (on an open Kanban
diagram)

Context Menu In the Browser window, right-click on the diagram name | Kanban > Appearance,
or

On a Kanban diagram, either:

Double-click on a lane > Appearance·
Right-click on background | Kanban > Appearance·

Appearance Options

Option Action

Line Color Click on the drop-down arrow and select the color in which to display lane borders.
This color does not apply to sub lane borders, which are automatically set to a pale
or dark color to contrast with the lane fill color.

If the color you require is not shown, click on the More colors button and either
select from a wider range of standard colors or define a custom color.

The border style is automatically set to the 'chiseled' effect to give the appearance
of 3D blocks on a background, the color of the background being the line color. The
effect is more obvious if you set the line to a pale color and not black.

Font Color Click on the drop-down arrow and select the color in which to display the text in
the Kanban lane and sub lane headings.

If the color you require is not shown, click on the More Colors button and either
select from a wider range of standard colors or define a custom color.

A Click on this button to display the 'Font' dialog, through which you define the font
and the style, size and effects of the text in the Kanban lane and sub lane headings.

If you also change the text color here, it overrides the setting of the 'Font Color'
field.

Title Color Click on the drop-down arrow and select the color to use across the lane heading
cells (separate from the fill colors you can apply individually to each of the lanes
themselves).

If the color you require is not shown, click on the More Colors button and either
select from a wider range of standard colors or define a custom color.

Overfilled Color Click on the drop-down arrow and select the color with which to fill a lane heading
cell if the lane contains more than the maximum number of elements. You set the
maximum number of elements when you define the lanes to work with, in the
'Lanes' page.

If the color you require is not shown, click on the More colors button and either
select from a wider range of standard colors or define a custom color.

Underfill Color Click on the drop-down arrow and select the color with which to fill a lane heading
cell if the column contains fewer than the maximum number of elements, in other
words there is available capacity. You set the maximum number of elements when
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you define the lanes to work with, in the 'Lanes' page.

If the color you require is not shown, click on the More Colors button and either
select from a wider range of standard colors or define a custom color.

Line Width Click on the drop-down arrow and select the line width of the Kanban lane borders
- either 1 (thinnest), 2 or 3 (thickest).

Vertical Spacing Set this to 'Small', 'Medium' or 'Large' to define the degree of vertical separation
between elements in a Kanban lane.

Hide Names Select this checkbox to hide the lane names and the column heading cells.

Bold Font Select this checkbox to display the lane headings in bold (if their font definition
does not already set them to bold).

Hand Drawn Select this checkbox to display the Kanban lanes and the elements on the diagram
in 'Hand-drawn' mode.

Enable Overfill Highlight Select this checkbox to apply the 'overfilled' color to the lane header cell if it
contains more elements than the defined maximum number (see New).

Enable Underfill Highlight Select this checkbox to apply the 'underfilled' color to the lane header cell if the
lane contains fewer elements than the defined maximum number; that is, if it has
any spare capacity.

Highlight Hierarchies Select this checkbox to highlight elements on the Kanban diagram that are part of
the same hierarchy, by drawing a colored rectangle behind each element. If there
are elements from two or more hierarchies on the same diagram, each hierarchy is
represented by background rectangles of a different color to the others. In this
illustration, Class 1 and Class 2 are both in one hierarchy, and Class 5 and Class 6
are both in a second hierarchy.

Use Kanban drawing style Select this option if you want to apply the Kanban style to the elements on this
Kanban diagram. Also, select the checkbox against each element property or
characteristic to be shown in the elements:

Type - displays the element type·
Status - displays the element status·
Version - displays the element version·
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Priority - displays the element priority·
Bold name - displays the element name in bold·
Notes - displays element notes in the elements on the Kanban diagram·
Capitalize Name - displays element names in capitals on the Kanban diagram·
Shadows - displays a shadow on the right and bottom edges of each element on·
the diagram; this effect is not affected by the 'Element Shadows On' option on
the 'Preferences' dialog

Stereotype - displays the element stereotype·
Phase - displays the element phase·
Author - displays the name of the element's author·
Truncate name - cuts off the element name as it approaches the element border,·
instead of allowing it to wrap around

Icon - selected by default; deselecting this checkbox hides the Type and·
Priority icons in the top right corner of the element

Checkboxes - when Checklist elements are displayed on the Kanban diagram,·
shows the Checklist checkboxes and items; Checklist Artifacts can be bound to
Priority on a Kanban diagram, and this option makes it easy to view any
Checklists organized by Priority

Tagged Values - shows the Tagged Values of each element on the diagram, in·
an element compartment

The property checkboxes are directly linked to the 'Use Kanban drawing style'
option. If you do not select the option, the element on the Kanban diagram has a
more basic appearance with no properties shown other than the author and element
names.

Native Element drawing
style

Select this option to render the elements on the Kanban diagram in their native,
rectangular notation style, displaying any compartments the elements might have.
The Resources compartment is particularly useful for Kanban elements, if
compartments are to be shown. This compartment lists allocated resources,
including those that are 100% complete.

Note that the element width is limited by the width of the lane the element is in, so
features in compartments might be shown truncated.

Notes

All elements added to a Kanban diagram initially have the same height and spacing, but the height can change as·
displayable information is added to an element

In a Kanban diagram, the normal element appearance option is not operational; only the Kanban appearance options·
take effect
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Kanban Options - Advanced

If you do not want to manually add elements to a Kanban diagram, you can use the 'Advanced' page to set up either
Package searches or SQL searches to automatically fill the diagram. It is not possible to use both a Package search and a
custom SQL search at the same time; if both are specified, the Package search is ignored.

The dialog automatically opens at the 'Package' tab. If you want to create a SQL Search, click on the 'Custom SQL' tab.

Access

Ribbon Construct > Resource Management > Kanban > (options to generate and/or open a
Kanban diagram)    or

Start > Personal > My Kanban (displays personal default Kanban diagram)

     Then

Design > Diagram > Manage > Kanban > Advanced (on an open Kanban diagram)

Context Menu In the Browser window, click on the diagram name | Kanban > Advanced, or

On a Kanban diagram, either:

Double-click on a lane > Advanced·
Right-click on the diagram background | Kanban > Advanced·

Kanban Options - Advanced

To fill a diagram based on a Package, simply click on the Add button and the 'Add Package' option, then select the
required Package or Packages from the 'Select a Package' browser.

If you want to include elements from child Packages, select the 'Include Child Packages' checkbox against each Package
in the list. Click on the Run Search button. This will automatically add elements, based on the search. The search is
additive (unless 'Synch with search' is selected) and will only add elements not currently on the diagram. You can refine
the Package search by creating it on the 'Filters' page and adding filters (see the Kanban Diagram Options - Filters Help
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topic).

To fill the diagram from the results of a custom SQL search, click on the 'Custom SQL' tab and type or paste the
appropriate SQL. In order for the diagram to be filled, you must include in the SQL Select statement:

     Object_ID as Element_ID

For example:

     Select Object_ID as Element_ID From t_object Where Object_Type = 'Requirement'

Option Action

Add On the 'Package' tab, if you are using a search or filter (from the 'Filters' page of the
dialog) you must define a Package or Packages for the search or filter to work on.
You do this by clicking the Add button and choosing either 'Add Package' to
browse to a selected Package, or 'Search Model' to search or filter from all elements
in the current model.

Remove If you want to clear a Package from the list (or the whole-model selection) click on
the item line and click on this button.

Include Child Packages If you have selected a Package with a child structure, select this checkbox to also
include the elements from the structure in the Kanban diagram, or clear the
checkbox to include elements from the selected Package only.

Auto fill When you select this option, the search configured for the Kanban diagram will
automatically run whenever the diagram is opened or reloaded.

Synch with search Selecting this option will synchronize the diagram with the current search when it is
run. That is:

New elements that match the search but are not currently on the diagram will·
be added and

Elements on the diagram that now do not match the search will be removed·

Run Search When you have set up either a Package search or a custom SQL search, click on the
Run Search button to fill the diagram. All elements found by the SQL search are
added to the diagram.

If you have not applied a filter to a Package Search, all elements from the selected
Packages are added to the diagram. If you have used a filter, only those elements
that meet the filter criteria are added.

A 'Progress' dialog displays during the search. If the search is taking a long time or
is finding too many elements, click on the Cancel button; any objects already added
to the diagram are removed.
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Kanban Options - Filters

The 'Filters' page can be used in conjunction with the Package search defined on the 'Advanced' page, should you want to
apply additional filtering.

It is possible to import a Model Search that has already been created, or to create new filters here exactly as you would
for any other Model Search.

When adding any of these searches or filters, you must also select at least one Package for the search or filter to work in;
you do this on the 'Advanced' page of the 'Kanban' dialog.

Access

Ribbon Construct > Resource Management > Kanban > (options to generate and/or open a
Kanban diagram)    or

Start > Personal > My Kanban (displays personal default Kanban diagram)

     Then

Design > Diagram > Manage > Kanban > Filters (on an open Kanban diagram)

Context Menu In the Browser window, right-click on the diagram name | Kanban > Filters, or

On a Kanban diagram, either:

Double-click on a lane > Filters·
Right-click on the diagram background | Kanban > Filters·
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Filter Options

Option Action

Import Search Click on this button to import a search from either an external XML file ('From
File') or from the current model ('From EA').

Add Filter Click on this button to define the properties of elements that you want to be added
automatically to your Kanban diagram during a search. Note that not all element
types can be added to Kanban diagrams; the excluded types are listed in the Notes
section.

Edit Filter Click on this button to edit the currently selected filter in the list.

Optional / Required Optional - Select this when at least one filter needs to be matched

Required - Select this if all filters need to be matched

Remove Filter Click on this button to delete the currently selected filter from the list.

Notes

These element types are not included in Kanban diagrams when running a search:·
     -  ActionPin
     -  Boundary
     -  Chart
     -  Constraint
     -  Diagram Legend
     -  ExpansionRegion
     -  GUIElement
     -  Hyperlink
     -  InterruptibleActivityRegion
     -  ModelView
     -  Note
     -  Package
     -  Port
     -  ProvidedInterface
     -  RequiredInterface
     -  Screen
     -  Sequence
     -  StateNode
     -  Text
     -  TimeSeriesChart
     -  UMLDiagram
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Kanban Patterns

Kanban provides diagram types and patterns that underpin the creation of diagrams. Whilst it is possible to create
Kanban diagrams from most UML diagram types and design the workflows on them from scratch, these diagram types
and patterns help you to generate a Kanban that matches your requirements and then adjust the settings to suit, thus
saving time and effort.

Access

On the 'MDG Technologies' dialog, in the 'Technology' panel, select 'Kanban' then click on the 'Enabled' checkbox and
on the OK button.

Ribbon Specialize > Technologies > Manage Technology

Kanban Diagram Types

The Kanban Technology has four kinds of pre-defined Kanban diagram, as described here. To create one of these
diagrams, open the 'New Diagram' dialog, use the 'Select From' header to select the 'Software Construction > Kanban
Perspective' in the left-hand pane and choose one of the diagram types from the right-hand pane.

Diagram Type Description

Basic The Basic Kanban diagram contains these lanes:

Backlog·
Queue·
In Progress·
Done·

The Basic Kanban diagram doesn't have a lane binding to any element property.

Backlog The Backlog Kanban diagram contains these lanes:

Low·
Medium·
High·
Critical·

The lanes are bound to the element Priority, so that moving elements between lanes
will automatically update their Priority to the name of the lane.

Iteration The Iteration Kanban diagram contains these lanes:

Queue·
In Progress·
Test/Review·
Done·

The lanes are bound to the element Phase, so that moving elements between lanes
will automatically update their Phase to the name of the lane.

Complete The Complete Kanban diagram contains these lanes:
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Ready for Release·
Staging·
Production·
Done·

The lanes are bound to the element Phase, so that moving elements between lanes
will automatically update their Phase to the name of the lane.

Kanban Workflow Patterns

Kanban Workflow model Patterns help you to very quickly set up a one, two or three stage workflow, using and linking
the Backlog, Iteration and Complete Kanban diagrams.

Workflow Pattern Description

1-stage Workflow Pattern The 1-stage Workflow Pattern consists of a single Kanban diagram with the
Backlog, Queue, In Progress, Test/Review, Done, and Deploy lanes. These lanes
are linked to the Phase property of elements, so that moving elements between
lanes will automatically update their Phase to the name of the lane.

2-stage Workflow Pattern The 2-stage Workflow Pattern consists of two related Kanban diagrams:

A Backlog Kanban diagram with Low, Medium, High and Critical lanes linked·
to the Priority property of elements, so that moving elements between lanes
will automatically update the Priority to the name of the lane, and

An Iteration Kanban diagram with Queue, In Progress, Test/Review, Done and·
Deploy lanes linked to the Phase property of elements, so that moving elements
between lanes will automatically update their Phase to the name of the lane

Each diagram also has a drop zone that helps you to move elements easily between
diagrams. Simply drag the elements onto the appropriate zone (having the name of
the diagram to move elements to) and select either 'Move to' to move the element to
the new diagram, or 'Create link on diagram' to create a link on the second diagram
without removing it from the current diagram.

3-stage Workflow Pattern The 3-stage Workflow Pattern consists of three related Kanban diagrams:

A Backlog Kanban diagram with Low, Medium, High and Critical lanes linked·
to the Priority property of elements, so that moving elements between lanes
will automatically update the Priority to the name of the lane

An Iteration Kanban diagram with Queue, In Progress, Test/Review, and Done·
lanes linked to the Phase property of elements, so that moving elements
between lanes will automatically update their Phase to the name of the lane,
and

A Complete Kanban diagram with Ready for Release, Staging and Production·
lanes linked to the Phase property of elements, so that moving elements
between lanes will automatically update their Phase to the name of the lane

Each diagram also has a drop zone that helps you to move elements easily between
diagrams. Simply drag the elements onto the appropriate zone (having the name of
the diagram to move elements to) and select either 'Move to' to move the element to
the new diagram, or 'Create link on diagram' to create a link on the second diagram
without removing it from the current diagram.
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Resources & Work Items

Enterprise Architect not only helps you to define the work items for a Kanban diagram or workflow but also acts as a
sophisticated platform for the allocation and management of resources and the flow of items through the board. This
functionality uses both Kanban diagrams and the Resource Allocation features.

Resources are the people who work on a project; they can be assigned roles and allocated tasks, and these roles and tasks
can be visualized on a Kanban diagram.

This example shows a number of Kanban work items, one with three resources allocated to it. The tasks performed by
the resources are at varying stages of completion, represented by the green progress bars that show the percentage of the
work completed.

When a resource allocation is set to 100% complete, it will no longer be displayed in the Kanban object. When all tasks
have been set to 100%, it might be time to move the task to the next Kanban lane, changing its status so that the next
resources can be allocated. In this example, that might be resources with a 'Review' or 'Testing' role.

Resource Allocation

To allocate a resource to a Kanban object, you must first open the Resource Allocation window ('Construct > Resource
Management > Resources'). You then select the object on the Kanban diagram or in the Browser window and click on
the 'New' icon in the Resource Allocation window. Add these details as necessary:

Resource·
Role or Task·
Start Date·
End Date·
Complete %·
Expected Time·
Allocated Time·
Time Expended·
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Description·
History·

Click on the Save icon to create the resource allocation - a progress indicator will instantly appear on the work item in
the Kanban diagram. This is an important visual cue to show that a resource has been assigned to work on this task or has
chosen it themselves. Other team members will immediately be able to see the allocation on the Kanban diagram and
make decisions about what work items they will work on. Therefore, it is important not to allocate resources too early as
this could slow down the workflow.

The resource allocations for the Kanban Work Item in the previous diagram are shown in this example:

Completed Tasks

Once you have completed a task, you set its 'Complete %' value to 100. This has the effect of preventing the task's
progress bar from being drawn in the object in the Kanban diagram. As well as setting the completion percentage on the
task, you might also want to fill in other information, such as the end date and time expended. It might also be time to
move the object into the next Kanban lane.

Resource Tracking

The Kanban features in Enterprise Architect can be used with any project management method. How the features are
used will depend largely on what works best for individual teams; the teams might be self organizing without any formal
project management controls and other teams might work with a more formal structure. Either way Enterprise Architect
provides a number of facilities that will assist with visualizing resources and their allocations to work items.

Enterprise Architect provides searches to allow you to track resources. You can get a list of tasks that each resource is
working on, overdue tasks, recently completed tasks, summaries, and more. A team or individual can also write their
own custom searches to retrieve any required information from the repository.

Access

Ribbon Construct > Resource Management > Active

Construct > Resource Management > Completed

Construct > Resource Management > Summary

Resource Tracking Searches
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Search Description

Active Tasks Searches the project for elements with assigned resources, where the end date is in
the future and the percentage completion is less than 100.

The output lists all elements with currently active tasks, and shows the details of the
resource allocation to each task.

Tasks Ending Today Searches the project for elements with assigned resources, where the task end date
is today.

The output lists all elements with tasks ending today, whether the task is complete
or not, and shows the details of the resource allocation to each task.

Tasks Starting Today Searches the project for elements with assigned resources, where the task start date
is today.

The output lists all elements with tasks starting today, and shows the details of the
resource allocation to each task.

Overdue Tasks Searches the project for elements with assigned resources, where the end date is in
the past and the percentage completion is less than 100.

The output lists all elements with overdue tasks, and shows the details of the
resource allocation to each task.

Recently Completed Searches the project for elements with assigned resources, where the end date is in
the recent past and the percentage completion is 100. In the 'Search Term' field,
specify the number of days over which to check back.

The output lists all elements with tasks completed within the specified period, and
shows the details of the resource allocation to that task. The output does not include
tasks that have already been finished in advance of a future completion date.

All Completed Searches the project for elements with assigned resources, where the percentage
completion is 100.

The output lists all elements with completed tasks, and shows the details of the
resource allocation to each task.
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30 Day Task Summary
(Brief)

Provides a brief summary of the tasks performed by resources over the previous
month.

The output groups tasks with similar project role and calculates for each resource:
the count, the sum of expected time, and the sum of expended time for all tasks that
have started in the last 30 days. To look at or change the master list of project roles
that this search uses for grouping tasks, select 'Settings > Reference Data > Model
Types > People > Project Roles'. Grouping by similar project role means that, for
example, 'Review 1' and 'Review 2' would be grouped together under 'Review' if
and only if the current project's list of project roles includes one called 'Review'.

30 Day Task Summary
(Full)

Provides a full summary of the tasks performed by resources over the previous
month.

The output groups tasks by project role and resource, and lists the count, sum of
expected time, and sum of expended time for all tasks that have started in the last
30 days.

30 Day Resources Searches the project for tasks that have started in the last 30 days where the
resource name matches (fully or partially) the text in the <Search Term>.

30 Day Roles Searches the project for tasks that have started in the last 30 days where the role
name matches (fully or partially) the text in the <Search Term>.

Charts and Dashboards

Enterprise Architect has a sophisticated charting facility that allows a wide range of charts to be created, through which
you can visualize and analyze repository information. This is particularly useful with Kanban diagrams and resource
allocations, and provides an alternative view of the Kanban cards, allowing a Product Owner, Project Manager or other
team member to get a visual image of things such as the Number of Active Tasks by developer, the Phases the Work
Items are in by developer, the Number of Work Items at each stage of a Kanban Board and much more. The charts can
provide information that will help improve the teams performance and ultimately result in high value product or service
features being available to customers in the shortest possible time frame. Any number of charts can be created from
built-in Patterns, but a team is also free to create user defined charts, dashboards and reports.

Example - Active Work Items by Team Member

This Bar Chart shows the number of active tasks by team member. The names of the team members are listed on the
vertical axis and the Number of Tasks on the horizontal axis. A small numerical value indicates the number of active
tasks allocated to each team member.
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Example - Completed Work Items by Team Member

This compelling Bar Chart shows the number of work items completed by the members of a team in a particular phase of
the process. The team members are represented on the vertical axis and the number of completed work items on the
horizontal axis. Color has been used to help visualize the work items completed in a given phase; a Diagram Legend lists
the relationship between color and phase. A small numeric indicator indicates the number of items completed in each
phase for each team member.
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Example - Weekly Work Item Summary by Phase

This expressive Bar Chart provides a weekly summary of the number of Work Items completed by phase. The Phases are
represented on the vertical axis and the Number of Work Items on the horizontal axis. The Chart can provide information
that will help improve the team's performance.
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Kanban in Context

There is a wide range of tools that allow teams to create Kanban diagrams, but Enterprise Architect stands on its own as
a tool that not only allows a team to use the Kanban features but is also a sophisticated platform for managing the work
products of every discipline working on Enterprise, Business or Technology initiatives. This means that instead of
having to access other tools or out-of-date documentation or schedule meetings the information related to a work items is
immediately available inside the same repository. An analyst, developer, tester or other team member working on a User
Story, Feature, or Defect can locate the related Requirements, Business Rules Policies, Standard Operating Procedures,
Strategies, Drivers, Goals, Stakeholders Requirements, Architectural designs, Principles, Programming Code, Database
and Information Schemas, XML definitions, Messages, Test Cases, Applications, Deployment Targets and Specifications
and more.

Relating Model Elements

Enterprise Architect allows a user to create any number of connections between model elements, using the connectors
that form part of the chosen modeling language. Any item that appears in a Kanban diagram can be dragged onto any
other diagram and then connections can be added. For example, a User Story that is coming to the top of a backlog or is
in a Queue lane in a Kanban diagram could be added to a Business or Stakeholder Requirements diagram, and Trace
relationships could be added between the User Story and the Requirements, indicating which requirements relate to the
Story.

(c) Sparx Systems 2024 Page  44 of 300 Created with Enterprise Architect



Project Build & Deploy 16 October, 2024

Finding Related Model Elements

The work items in a Kanban board can be related to any other elements in the model, allowing a graph to be defined.
While it is possible to add your own connections, quite typically other team members working in related disciplines and
parts of the repository will have already added relationships to other model elements, which in turn will be related to still
other elements and so on.

These connections can all be visualized in existing diagrams, but a modeler can create a new diagram and place the work
item in the center of the diagram, choosing the Insert Related Elements feature to insert the graph of related elements that
can be configured to draw an expressive diagram reaching out to the very corners of the repository.

This diagram shows the result of using the Insert Related Elements feature to find the important information needed
when working on a User Story.
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The Backlog

The Backlog (or Product Backlog, as it is called by some Agile methods such as Scrum) is an ordered list of items that
will deliver business value to the customer. It can consist of a heterogeneous list of item types ranging from Features,
User Stories and Requirements (including Non-functional Requirements) to Defects, Changes and more. In fact, in
Enterprise Architect any element can be placed onto a Backlog; the ones that are listed and those that appear in the
Toolbox are simply the most common. The Backlog is an ordered list based on the business value, with the higher value
items percolating to the top of the list. The list is owned and managed by the Product Owner or their equivalent; that is,
someone acting as a surrogate for the customer.

Ordering Items in a Backlog Lane

When working with a one-stage workflow, the Backlog items will typically be contained in the first lane of the Kanban
and can be dragged to a new location in the lane to change the order of items in the backlog.

Step Action

1 Select the Item to be moved in the Backlog diagram.

2 Drag-and-drop it into a new location in the backlog lane.

Prioritizing a Backlog

Typically, the order of the items in the Backlog is carefully and thoughtfully determined by the Product Owner and
reflects the business value - the items promising high business value are located at the top. The prioritization of the
Backlog is the Product Owner's responsibility, but it is not decided in isolation from other team members and the Product
Owner relies on access to important information from a range of stakeholders, from senior executive level stakeholders,
business and operation managers, requirements analysts and business analysts, through to implementation teams.

A range of strategic diagrams and materials provides a source for many of the prioritization decisions. These include:
Strategy Maps, Business Drivers, Goals and Objectives, and Roadmap diagrams that describe the time-based sequencing
of packages of work. The example Roadmap diagram could be used by the Product Owner as an input to what is of high
priority to the Business, or what has been planned by the Enterprise or Business Architecture teams. The diagram will
prove useful in discussions with both the business stakeholders and the implementers, who can gain a business context
for the work they are completing.
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Comments provided by Implementers and other stakeholders will also provide a valuable source of information and input
into the prioritization of the backlog. Enterprise Architect has a Discuss & Review window, which is a highly
collaborative facility through which any team member can enter discussion posts against an element and other users can
reply and join the discussion. This can create a rich and useful tapestry of knowledge that will not only help the Product
Owner in deciding the item's position in the backlog list but will also assist implementers when they are ready to
implement the item.

Another critical piece of information that will help the Product Owner is the item estimates completed by implementers,
who make their best estimation of how long the item is likely to take. Agile teams using User Stories tend to use Story
Points, but any unit of measure can be used as long as the team agrees upon a standard. Some teams will use actual times
based on units such as number of hours, whilst others will use effort-based estimates. Enterprise Architect has a flexible
and integrated resource allocation facility where team members can add estimates, allowed time, actual times,
completion percentages and more. This will be invaluable for the Product Owner, who might have a broad idea of the
time required to complete an item but who would rely heavily on the details supplied by the team. The time estimate can
be entered in the 'Expected Time' field of the Resource Allocation window.
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Example

This diagram shows how a backlog can be defined in a one-stage workflow, allowing items to be dragged and dropped in
a single column to define the order of the items in the backlog.

Ordering Items in a Backlog Diagram

When working with two or three stage workflows the Backlog items are contained in a Kanban board representing the
entire Backlog, allowing them to be moved between lanes from low to medium, high or critical or using any user defined
lane names or bound property.

Step Action
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1 Ensure the Backlog Kanban diagram is open.

2 Select the work item to be prioritized in the diagram.

3 Drag and drop the item into a new location, either in the containing lane or in another lane.

Securing a Backlog

The Backlog is a communication tool that insulates the implementers from the need to decide what they should be
working on. It is owned and managed by the Product Owner, who ultimately decides what should be on the Backlog and
the order of the items it contains. It therefore must be secured from inadvertent changes. The implementation team
should have access to the Backlog, but for the purposes of pulling items from a work queue to the In-Progress lane,
which could be continuous flow-based (Kanban) or time-boxed (such as a Sprint). The development team also need to
provide time estimates for the items in the Backlog, which will help the Product Owner decide upon the order of items,
particularly when two or more items have comparable business value. The item with the lowest completion estimate will
typically be given a higher position. Developers are also expected and encouraged to comment on the items in the
Backlog so that the Product Owner can understand any issues or have access to learning from prior initiatives or insights.

Enterprise Architect's security system can be used to lock the Backlog while still allowing people to make the necessary
contributions of time estimates and comments in the form of discussions.

With the Security System enabled and either a group for Product Owners or individual users who are Product Owners
added, a Backlog diagram can be locked by the individual Product Owner user or a member of the Product Owner group.
This example shows the Backlog being locked by the Product Owner group, but for a repository that is accessed by a
number of Product Owners it could be more expedient to lock the diagram to an individual.

When the Backlog diagram has been locked by the Product Owner, other team members will be able to view the diagram
but a small red marker to the left of the diagram name in the Browser window will indicate that it is locked. The Project
Manager will see a blue marker indicating that they have access to edit the diagram.
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Securing a Backlog Diagram

Secure a Backlog diagram, remembering that it can be locked at a user or a group level.

Step Action

1 Locate and select the Backlog diagram in the Browser window.

2 Right-click on the diagram name and select the 'Lock Diagram' option. The 'Lock Diagram' dialog
displays.

3 Select the 'User Lock' or 'Group Lock' option from the 'Lock Type' list.

4 Select the User, or the Group from the 'Group ID' drop-down list.

5 Click on the OK button to save the changes.

Notes

The model must have user security enabled in order to lock the backlog Kanban diagram·
To secure a Backlog a two or three stage workflow is required where the Backlog is a separate Kanban diagram·
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Elaboration and Grooming

During the process of prioritizing the Backlog, and as work items move closer to the top of the Backlog or onto the work
Queue, the work items must be prepared for the In-Progress stages of the workflow - in traditional methods, this process
is termed 'elaboration', but is known as 'grooming' in Agile methods. Enterprise Architect has a number of facilities that
can assist with the grooming of work items, so that when they are pulled onto an In-Progress lane the right information is
available for an implementer to immediately start work.

Enterprise Architect has a form of requirement that is internal to an element and allows supplementary and more specific
requirements to be added to a Work Item. These requirements are created in addition to the business, stakeholder,
functional and non functional requirements that might exist for the work item.

There is also a wide range of information that can be entered as Change Management Items for a selected Kanban Work
Item. These items include Features, Changes, Documents, Issues, Defects and Tasks, and add rich additional information
that will assist all team members, including the Product Owner and the Implementation team.

Enterprise Architect also has the 'Details' tab of the Inspector window, which is a convenient tool for viewing all the
related information about an element in a single place. The 'Details' tab can be kept open in the Inspector window and
items can be selected in a Kanban diagram, List, or Gantt chart, and the Work Item's specific information will be
displayed.
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Default Kanban Diagrams

A default Kanban diagram can be set for the entire repository, and each individual user can also set their own default
Kanban diagram; in both cases there are specific options to locate and open the diagrams. These defaults help you to
quickly and easily get access to a Kanban board and immediately start contributing to work items that will deliver value
to the customer.

To track your own work, you can select:

The 'Start > Personal > My Kanban' ribbon option, or·
The 'Construct > Resource Management > Kanban > Open My Kanban' ribbon option, or·
The 'User Default Kanban' menu option from the diagram Caption Bar·

To track the team's work, you can select:

The 'Construct > Resource Management > Kanban > Open Project Kanban' option or·
The 'Model Default Kanban' menu option from the diagram Caption Bar·

Set the Model Default Kanban

A default model Kanban diagram can help you to visually track a range of work items and their current stage of
development through an initiative. This feature ensures that all team members can visualize the important work items in
a consistent way and allows them to track the work items as they move from an idea in the backlog through to
completion ultimately delivering business value to the customer.

Step Action

1 Ensure the preferred Kanban diagram is open in the main view.

2 Select the 'Construct> Resource Management > Kanban > Model Places - Manage > Set Current as
Default' ribbon option.

Set My Default Kanban

In a shared security-enabled model environment it is possible to set a user-specific default Kanban diagram. A
personalized Kanban diagram can help each member of a team to visually keep track of a range of elements of particular
relevance to them, and their current stage of development.

Step Action
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1 Ensure your preferred Kanban diagram is open in the main view.

2 Select the 'Construct > Resource Management > Kanban > My Places - Manage > Set Current as Default'
ribbon option.

Notes

The model must have user security enabled in order to define a user default Kanban diagram·
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Alternative Views

Enterprise Architect is a modeling platform that can be used by any number of stakeholders, ranging from high level
executives to implementation teams, providing a variety of communication devices suitable for each stakeholder group.
There are four other views of a Kanban diagram that will be appealing to many stakeholders, particularly project
managers, schedulers, development managers and product owners; these can be viewed by simply toggling from view to
view:

Gantt View·
This view provides a visualization of the work items and the assigned resources in a Gantt Chart, which is
particularly useful for people who might be more familiar with this more traditional representation or who want to
get an overview of the schedule of tasks

List View·
This view is a spreadsheet representation, where the work items are the rows and the properties and Tagged Values
are the columns

Specification Manager View·
This view lists the work items with the contents of each element's Notes field

Traceability Window·
This view helps a team member to quickly review dependencies and other relationships between work items to any
depth, and to locate the items in other diagrams

Switching between Views

A Kanban diagram, like all diagrams, can be switched to an alternative view and, once in this view, can be switched to
any other view without affecting the underlying layout of the diagram.

Step Action

1 Ensure the diagram is the active tab or has focus.

2 Ribbon: Design > Diagram > Views >  <view type>

Context Menu (open diagram): Open Diagram in | <view type>

List View

The List View provides a spreadsheet-like visualization of the work items and their properties and Tagged Values. It
allows properties to be viewed and compared across the entire corpus of work items that make up the diagram and allows
properties such as status to be edited inline using drop-down lists of values where they apply. It also has a clever
mechanism that allows the list to be grouped by property down to any number of levels and a filter that is useful when
wanting to restrict the view of work items with a particular property or name - for example, all work items relating to the
Warehouse Manager.
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Access

Ribbon Design > Diagram > Views > List View

Context Menu Right-click on diagram background | Open Diagram in | List View

Gantt View

The Project Gantt View provides a traditional Gantt Chart in the form of bar chart representing the scheduling of the
work items including: their start and finish times and the percentage complete. It is a graph that provides a time oriented
view of the work items and is useful for project managers and project schedulers or other team members who want to
view all the work items in a single view.

Access

Ribbon Design > Diagram > Views > Gantt View

Context Menu Right-click on diagram background | Open Diagram in | Gantt View
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Specification Manager View

The Specification Manager is a simple document-based interface to a selected diagram (or Package) in the model,
providing the means of creating and reviewing elements as text representations of objects in the model, using a process
that is familiar to all users including business professionals and management, who might not have expertise in model
development.

The Specification Manager is also an interactive reporting tool for displaying, in icon form, the status of various other
features against each entry and providing access to edit each feature.

Access

Ribbon Design > Diagram > Views > Specification View

Context Menu Right-click on diagram background | Open Diagram in | Specification Manager

Traceability View

The Traceability Window provides an insightful view of how a work item is connected to other elements in the model
including other work items and how these connected elements are themselves connected down to any level. It is a general
purpose mechanism and so can be used with any type of element but is particularly useful when working with Kanban
boards and for product owners and other team members who need to understand the dependenies between work items
and to find the related information that will help with the analysis, grooming, testing and implementation of a work item.
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Access

Ensure a Work Item is selected in a diagram or other view.

Ribbon Design > Element > Trace
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Other Methods

Kanban is not a process in traditional classification but more of a way of visualizing work items, and a method for
creating efficiencies and ensuring customer value is delivered as soon as possible. Kanban can be used in isolation or in
combination with any existing processes, including Scrum, Iterative and Incremental and Waterfall Processes. Each of
these processes has their place and can be used with Kanban even though much of the literature about process is
currently focused on iterative families of processes such as Agile.

The compelling thing about Kanban is that it provides a visualization of the flow of Work Items from the ideas stage
through to delivering demonstrable value to the customer transparently to every team member.

Scrumban

Scrumban is a hybrid methodology combing aspects of Scrum and Kanban. Scrum teams can typically work with the
same process they have always used, including Sprints, Standups, Retrospectives and Demos, but incorporate Kanban as
a way of visualizing the Work Items, allowing just-in-time planning and benefiting from being able to set
Work-In-Progress (WIP) Limits. The work items that have been selected for the Sprint or Iteration can be pulled from a
Backlog Kanban board onto the Queue lane of an Iteration Kanban board.

Using Scrumban overcomes limitations or issues that some Scrum teams experience such as: excessive time required in
Sprint planning, a loss of focus due to implementers working concurrently on too many User Stories, Defects or other
items and information being forgotten over the period of the Sprint. The built-in one, two or three stage workflows would
all be suitable for Scrumban but a team is free to define their own workflow, create their own Kanban boards and define
their own lanes and sub-lanes.

Iterative Methods

Iterative and incremental methods have been in use since the mid nineteen seventies and have been incorporated into a
number of waterfall processes as well as being used in isolation These processes can all benefit from the use of Kanban
diagrams as a way of visualizing the work items in an iteration and any number of Kanban diagrams can be created to
manage concurrent iterations.
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Waterfall

Waterfall or modified methods have been in use since the mid nineteen-seventies and have been baked into a number of
standards, particularly in industries such as the military, aviation, travel and finance, where outcomes typically need to be
determined in advance of a development cycle. Waterfall methods are often used when requirements are locked down
and scope is determined in advance, the product is stable and the technology platforms are well known and understood.
These processes can all benefit from the use of Kanban diagrams as a way of visualizing the work items as they flow
from phase to phase.
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Tasks & Resources

In the life cycle of a project, there are various non-technical tasks that are vital to the successful management and
completion of the project, such as allocation of resources and allocation of time to the tasks and to meetings. Enterprise
Architect helps you as a project manager or as a team member to record and monitor such tasks.

Facilities

Enterprise Architect provides a range of project management facilities as described in this table.

Facility Description

Manage Project Resources Resources are the people who work on a project. You can assign roles and allocate
tasks to them, which helps you to track effort and estimate time to complete tasks.
You can also define the effort, risks and metrics to support resource management.
You add, modify and delete resources using the Resource Allocation window.

The Project Gantt View In Enterprise Architect, you can visualize elements and assigned project resources
easily in a Gantt Chart format, to review the breakdown of work for a specific
project and for specific sections of the project. The Project Gantt View illustrates a
project schedule by showing the start and finish dates of assigned resources, so that
you as Project Manager can quickly see the current project status using the
percent-complete bar shading and the percent-complete, resource name and status
columns. Information can be filtered, and overdue items can quickly be highlighted
and identified. You can also access specialized versions of the Project Gantt View
from diagrams, Packages and the Personal Tasks list.

Project Task Allocation A particular feature of the Project Gantt View is the facility to review the allocation
of work to elements in the project, focusing on either the elements that require
work, or the resources required to perform the work.

Review Personal Tasks Using the Personal Tasks view, each team member can record, review and manage
their personal work within the project.

Project Management
Windows

Enterprise Architect provides five specialized tabs in the Project Tools window to
help you to define each of the management quantities associated with an element in
the model, namely:

Decisions - the choice made on a requirement of the element·
Events - the action taken on a requirement of the element·
Effort - the effort expended in work on the element·
Risks - the risks associated with the element, and·
Metrics - the metrics measured for an element·

Notes

In the Corporate, Unified and Ultimate Editions of Enterprise Architect, if User Security is enabled, you must have·
'Manage Project Settings' permission to perform Resource Allocation
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Project Resources

Resources are the people who work on a project. They can be assigned roles and allocated tasks, which enables tracking
of effort and estimation of time to complete. You also define the effort, risks, metrics, events and decisions to support
resource management.

You can also review and delete listed allocated resources using the Resource Allocation window.

Access

Ribbon Construct > Resource Management > Resources

Keyboard Shortcuts Select a Resource item on a diagram or on the 'Details' tab of the Inspector window,
then press Shift+Enter

Uses

Use to

Allocate a resource to an element.

Record additional project management information for an element.

Obtain a report of resource allocation details.

Show Project Management information on elements in a diagram.

Configure Project Management data and populate the drop-down lists used on the tabs of the Project Tools window.

Notes

In the Corporate, Unified and Ultimate Editions of Enterprise Architect, if User Security is enabled, you must have·
'Manage Project Settings' permission to perform Resource Allocation and to update and manage project resources,
effort, metrics, risks, decisions and events
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Resource Allocation

In developing a model, people (or resources) in a number of roles might perform tasks on model structures. As a Project
Manager, you can assign resources to tasks on elements (including Packages) in the model, planning and monitoring the
work that they do within the timeframe you have allocated for that work to be completed. You can do this using the
Project Gantt View and/or Construct facilities.

The Resource Allocation window, displays a Gantt chart that shows all of the resources assigned to a particular model
element.  As you select different model elements, the Gantt chart updates to show the resources assigned to the selected
element.  As you select an individual resource on the Gantt chart, the Properties window and the Notes window (if
visible) will update to show the details for the selected resource.

Access

Ribbon Construct > Resource Management > Resources,  or

Start > All Windows > Construct > Resources > Resource Allocation

Create Resource Allocations

New resource allocations are made using the 'Assign Resources' dialog.  To access the dialog, first select a model
element for which you wish to create resource allocations and then, either:

Click on the   button in the Resource Allocation window toolbar, or·
Right-click on the Gantt Chart and choose the context menu option 'Assign Resource...'.·

Assign Resources Dialog

The initial details for a resource allocation are entered using the 'Assign Resources' dialog.

This table describes the fields appearing on the dialog.

Field Action

Resource
Click on the drop-down arrow and click on the name of the resource to assign to
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work associated with the element.

To assign multiple resources at once, click on the browse button, then select the
resources to assign from the 'Select Resources' dialog.

(You can type the name of the resource into the 'Resource' field, as long as the
name is one of those defined in the system; if it is not, the assignment will not
validate. As you type, the field auto-fills with names matching the characters that
you have typed.)

Role or Task
Click on the drop-down arrow and click on the required role of the resource in this
task. You cannot type a role into the field.

The field initially defaults to the first role in the defined list; in subsequent
assignment entries, the role defaults to the one posted for the immediately previous
assignment to this or any other element.

Start Date
This field defaults to today's date.

If you want to assign a different start date for the task:

Click on the drop-down arrow.1.

If necessary, click on the Left or Right Arrow to select the previous or next2.
month.

Click on the appropriate day of the month as the start date.3.

The field immediately changes to the selected date.

End Date
This field defaults to today's date.

If you want to assign a different end date for the task:

Click on the drop-down arrow.1.

If necessary, click on the Right Arrow to select the next month.2.

Click on the appropriate day of the month as the end date.3.

The field immediately changes to the selected date.

Save / Save & Close
To save the resource allocation you have defined, click on one of the 'Save' buttons.

If you intend to define further resource allocations for the same model element,
click the Save button - the dialog will remain open, ready for you to create another
allocation.

When you have finished creating allocations for the selected model element, click
'Save & Close' (or 'Close'), to close the dialog.

Modify Existing Resource Allocations

Existing resource allocations can be modified directly on the Gantt chart, by dragging the start or end dates to a new
position on the time line, or by dragging the entire task to a new position.
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The percentage completed can also be updated by clicking on the value and dragging a slider (or using the left and right
arrow keys) to select a new value.

If the Properties window is visible, the resource allocation's properties can be updated there, by simply entering new
values. Similarly, if the Notes window is visible, entries for Description and History can be updated directly in the Notes
window.

Alternatively, you can use a dialog designed specifically for this purpose.

To use the dialog, first select the model element for which to modify resource allocations; then, in the Resource
Allocation window, double-click the allocation to be modified, or right-click and choose the menu option 'Modify
Resource'.

Modify Resource Allocations Dialog
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The 'Modify Resource Allocations' dialog, is used to update the details of existing Resource Allocations.

This table presents a detailed description of each field on the 'Modify Resource Allocations' dialog and how it is intended
to be used.

Field Action

Resource
Click on the drop-down arrow and click on the name of the resource to assign to
work associated with the element.

To assign multiple resources at once, click on the browse button, then select the
resources to assign from the 'Assign Resource' dialog.

(You can type the name of the resource into the 'Resource', as long as the name is
one of those defined in the system; if it is not, the assignment will not validate. As
you type, the field auto-fills with names matching the characters that you have
typed.)

Role or Task
Click on the drop-down arrow and click on the required role of the resource in this
task. You cannot type a role into the field.

The field initially defaults to the first role in the defined list; in subsequent
assignment entries, the role defaults to the one posted for the immediately previous
assignment to this or any other element.

Description
Type (and, if you prefer, format) a description of the work being done by the
resources.

History
As the task progresses, you add text to this tab to record the activities, progress,
problems and outcomes of the task.

Expected Time
Type in the number of time units the task is expected to take. (The value must be an
integer, so you cannot record part units.)

The unit of time you adopt is by agreement within the project, and depends on the
granularity of the work being recorded. Most tasks are completed in a number of
hours or a number of days; use the smallest practical unit that you can record as a
whole number.

Apply the same units as used for the 'Allocated Time' and 'Time Expended' fields.
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Allocated Time
Type in the number of time units the task can be spread over. (The value must be an
integer, so you cannot record part units.)

The unit of time you adopt is by agreement within the project, and depends on the
granularity of the work being recorded. Most tasks are completed in a number of
hours or a number of days; use the smallest practical unit that you can record as a
whole number.

Apply the same units as used for the 'Expected Time' and 'Time Expended' fields.

Complete %
If the task is already in progress, type in the current percentage completion.

Time Expended
(When the task is eventually 100% complete, you will type in the number of time
units it actually took. The value must be an integer, so you cannot record part
units.)

The unit of time you adopt is by agreement within the project, and depends on the
granularity of the work being recorded. Most tasks are completed in a number of
hours or a number of days; use the smallest practical unit that you can record as a
whole number.

Apply the same units as used for the 'Expected Time' and 'Allocated Time' fields.

Start Date
This field defaults to today's date.

If you want to assign a different start date for the task:

Click on the drop-down arrow.1.

If necessary, click on the Left or Right Arrow to select the previous or next2.
month.

Click on the appropriate day of the month as the start date.3.

The field immediately changes to the selected date.

End Date
This field defaults to today's date.

If you want to assign a different end date for the task:

Click on the drop-down arrow.1.

If necessary, click on the Right Arrow to select the next month.2.

Click on the appropriate day of the month as the end date.3.

The field immediately changes to the selected date.

Notes

In the Corporate, Unified and Ultimate Editions of Enterprise Architect, if User Security is enabled, you must have·
'Manage Project Settings' permission to perform Resource Allocation

If you allocate resources to Use Cases, the information you enter contributes to the Use Case Estimation calculation·
for estimating the project size in terms of time, resources and cost

To edit existing Resource Allocation items for this element, display the allocation in the 'Assigned Resources' dialog·
by either:
     -  Clicking on the 'Construct > Resource Management > Resources' ribbon option, right-clicking on the required
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item in the Resource
        Allocation window and selecting the 'Modify Selected' option
     -  Double-clicking on the item in the Resources list in the 'Details' tab of the Inspector window   or
     -  Clicking on the item in the 'Element View' tab of the Project Gantt Chart

You can also edit an existing Resource Allocation using the Properties window for that selected item; the fields·
behave in the same way as those described in this topic

To delete existing Resource Allocation items for an element, click on the item in the Resource Allocation window·

and click on  in the window toolbar
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Assign Multiple Resources

When you have a large unit of work associated with an element - such as a Package element - you might want to assign
several resources to that element to perform that unit of work. You can assign each person individually, but if the
resources have the same role or task you can assign all of them together in one operation, using the 'Assigned Resources'
dialog.

This dialog is also used to edit Resource Allocations entered previously through either the same dialog or the Resource
Allocation window.

Access

First, select an element, then:

Ribbon Construct > Resource Management > Gantt > Element View > right-click on
element > Assign Resource

Other On the Resource Allocation window, right-click on a resource assignment and click
on the 'Modify Selected' option

Assign Multiple Resources to an Element

Option Action

Resource (To assign a single resource, simply type in the name or click on the drop-down
arrow and select the name from the list. In Project Management, it is simpler to
assign single resources directly through the Resource Allocation window.)
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For multiple resources, on the 'Assigned Resources' dialog, click on the  button
on the 'Resource' field to display the 'Assign Resource' dialog.

Select the checkbox against each resource to assign to the element; to select all1.
resources listed, click on the Select All button.

Click on the OK button to close the dialog and to add the selected resources to2.
the 'Resource' field.

The 'Resource' field now shows the selected resources, but grayed out. The
drop-down arrow also is not active. To change the resources in the field, click on

the  button again and select/clear the appropriate checkboxes.

Role or Task Either:

Type in the role name or task that is common to all the selected resources, or·
Click on the drop-down arrow and click on the role that is common to all the·
resources

Description Type (and, if you prefer, format) a description of the work being done by the
resources.

History As the task progresses, you add text to this tab to record the activities, progress,
problems and outcomes of the task.

Start Date This field defaults to today's date.

If you want to assign a different start date for the task:

Click on the drop-down arrow.1.

If necessary, click on the Left or Right Arrow to select the previous or next2.
month.

Click on the appropriate day of the month as the start date.3.

The field immediately changes to the selected date.

Expected Time Type in the number of time units the task is expected to take. (The value must be an
integer, so you cannot record part units.)

The unit of time you adopt is by agreement within the project, and depends on the
granularity of the work being recorded. Most tasks are completed in a number of
hours or a number of days; use the smallest practical unit that you can record as a
whole number.

Apply the same units as used for the 'Allocated Time' and 'Time Expended' fields.

Allocated Time Type in the number of time units the task can be spread over. (The value must be an
integer, so you cannot record part units.)

The unit of time you adopt is by agreement within the project, and depends on the
granularity of the work being recorded. Most tasks are completed in a number of
hours or a number of days; use the smallest practical unit that you can record as a
whole number.

Apply the same units as used for the 'Expected Time' and 'Time Expended' fields.

End Date This field defaults to today's date.

If you want to assign a different end date for the task:

Click on the drop-down arrow.1.

If necessary, click on the Right Arrow to select the next month.2.

Click on the appropriate day of the month as the end date.3.
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The field immediately changes to the selected date.

Complete % If the task is already in progress, type in the current percentage completion.

Time Expended (When the task is eventually 100% complete, you will type in the number of time
units it actually took. The value must be an integer, so you cannot record part
units.)

The unit of time you adopt is by agreement within the project, and depends on the
granularity of the work being recorded. Most tasks are completed in a number of
hours or a number of days; use the smallest practical unit that you can record as a
whole number.

Apply the same units as used for the 'Expected Time' and 'Allocated Time' fields.

Milestone This checkbox and drop-down list allow linking the end date to the date of a
Milestone element that is no more than seven days old.

(Milestone elements form part of the structures developed using the Project
Management Technology, which you can activate by selecting the 'Start > All
Windows > Perspective > Construct > Project Management' ribbon option.)

Click on the checkbox to activate the field, then click on the drop-down arrow and
select the Milestone element from the list.

Previous Click on this button to display the previous resource record in the sequence.

Next Click on this button to display the next resource record in the sequence.

New Click on this button to clear the fields on the dialog so that you can define a new
resource allocation.

Apply Click on this button to apply the changes to the currently-displayed element on a
diagram, without closing the dialog.

OK Click on this button to save the data you have entered, and close the dialog.

Close Click on this button to discard the data you have entered, and close the dialog.

Help Click on this button to display this Help topic.

Notes

When the resource details are displayed on the Project Gantt Chart or Resource Allocation window, each resource·
has their own record containing, initially, the same data; however, each resource can be monitored and their progress
recorded separately

If you assign resources that are already in a multiple resource assignment to the selected element, a prompt displays·
for you to confirm that you are updating the assignment of that resource, or now omitting that resource from the
existing assignment
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Effort Management

In Enterprise Architect, the Project Manager can allocate effort (as time) to work on a given model element. To select the
element to which to allocate effort, click on the required element in the Browser window or a diagram.

Access

Ribbon Construct > Project Management > Effort : right-click | Add New

Keyboard Shortcuts Select an Effort item on a diagram or on the 'Details' tab of the Inspector window,
then press Shift+Enter

Enter effort allocation details for an element

Effort
Type the name or a brief description of the effort.

Type
Type in the effort type or click on the drop-down arrow and select the type. The
selection list is drawn from the global Effort Type list, but any new efforts you type
in this field are not added to the list.

Time
Type in the amount of time the effort is expected to expend.

Notes
Type in any additional notes or description of this effort.

 OK
Click on this icon to save the data you have entered and to add the entry to the
'Effort' list in the Effort window and the 'Details' tab of the Inspector window, and
close the dialog.

Cancel
Click on this button to discard the data you have entered, and close the dialog.

Notes

To edit existing Effort items for this element, display the record in the Project Tools window by either:·
     -  Clicking on the 'Construct > Project Management > Effort' ribbon option and on the required item in the 'Effort'
tab of the window, or
     -  Double-clicking on the item in the Project > Effort  list in the 'Details' tab of the Inspector window

To delete existing Effort items for an element, right-click on the item in the 'Effort' tab of the Project Tools window·
and click on the 'Delete' option

Although Enterprise Architect does not currently provide detailed reports on effort within a model, you can use the·
Automation Interface or similar tools to create your own custom reports based on effort information you enter
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Risk Management

In Enterprise Architect, the Project Manager can allocate the possible weighting of defined risks that might impact work
on a given model element.

To select the element to which to allocate risk weightings, click on that element in the Browser window or a diagram.

Access

Ribbon Construct > Project Management > Risks: right-click | Add New

Keyboard shortcut Select a risk item on a diagram or Element tab of the browser then use Shift+Enter

Enter risk details for an element

Risk
Type the name or a brief description of the risk.

Type
Type in the risk type or click on the drop-down arrow and select the type.

The selection list is drawn from the global Risk Type list, but any new risks you
type in this field are not added to the list. If there are no global risk types defined,
the drop-down arrow is not displayed.

Weight
Defaults to the weighting for the defined type. You can change this weighting if
necessary.

Notes
Type in any additional notes or description of this risk. You can use the Notes
Toolbar at the top of the field to format the text, if you prefer.

 OK
Click on this icon to save the data you have entered and to add the entry to the Risk
list in the Risk window and the 'Details' tab of the Inspector window, and close the
dialog.

Cancel
Click on this button to discard the data you have entered, and close the dialog.

Notes

The risks described here are not the same as those represented by Risk elements; the risks are properties of a single·
element, whilst the Risk element represents something that can impact a range of other elements

If you select a global risk type from the 'Type' drop-down list and the associated 'Weight' field is empty, the default·
Weight value is allocated to the 'Weight' field on the 'Risks' tab

To edit existing Risk items for this element, display the record in the 'Risks' dialog by either:·
     -  Clicking on the 'Construct > Project Management > Risks' ribbon option and on the required item in the 'Risks'
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tab of the Project Tools window, or
     -  Double-clicking on the item in the Project > Risk list in the 'Details' tab of the Inspector window

To delete existing Risk items for an element, right-click on the item in the 'Risk' tab of the Project Tools window and·
click on the 'Delete' option

Although Enterprise Architect does not currently provide detailed reports on risks within a model, you can use the·
Automation Interface or similar tools to create your own custom reports based on risk information you enter
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Metrics

The Project Manager can allocate the possible weighting of defined metrics to work on a given model element.

To select the element to which to allocate a metric weighting, click on the required element in the Browser window.

Access

Ribbon Construct > Project Management > Metrics : right-click | Add New

Keyboard shortcut Select a metric item on a diagram or the 'Details' tab of the Inspector window, and
press Shift+Enter

Enter metric details for an element

Field/Icon Description

Metric
Type the name or a brief description of the metric.

Type
Type in the metric type or click on the drop-down arrow and select the type.

The selection list is drawn from the global Metric Type list, but any new metrics
you type in this field are not added to the list. If there are no global metric types
defined, the drop-down arrow is not displayed.

Weight
Defaults to the weighting for the defined type. You can change this weighting if
necessary.

Notes
Type in any additional notes or description of this metric.

You can use the Notes Toolbar at the top of the field to format the text, if you
prefer.

 OK
Click on this button to save the data you have entered and to add the entry to the
'Metrics' list in the Metrics window and the 'Details' tab of the Inspector window,
and close the dialog.

Cancel
Click on this button to discard the data you have entered, and close the dialog.

Notes

If you select a global metric type from the 'Type' drop-down list and the associated 'Weight' field is empty, you can·
allocate the default Weight value in the 'Weight' field in the 'Metrics' dialog

To edit existing Metric items for this element, display the record in the 'Metrics' dialog by either:·
     -  Clicking on the 'Construct > Project Management > Metric' ribbon option and on the required item in the
Project Tools window, or
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     -  Double-clicking on the item in the Project > Metrics list in the 'Details' tab of the Inspector window

To delete existing Metric items for an element, right-click on the item in the Project Tools window or the 'Details'·
tab and select the 'Delete' option

Although Enterprise Architect does not currently provide detailed reports on metrics within a model, you can use the·
Automation Interface or similar tools to create your own custom reports based on metric information you enter
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Show Project Items in a Diagram

When you have created a Project item (Decision, Event, Effort, Risk, Metric), it is useful to make the record visible on its
parent element. You can do this by displaying the record within a 'Project' compartment on the element as it displays in a
diagram. Any element that is capable of displaying a compartment, and that has Project items assigned to it, can show the
items in a diagram.

Note that:

An Event records the action taken for the current model element·
A Decision records the choice taken for the current model element·

Show Project Items in Project Compartment

Step Action

1 Open a diagram containing the element for which Project Items exist.

2 Double-click on the diagram background to display the diagram properties dialog.
Click on the 'Elements' tab.

3 In the 'Show Compartments' panel, click on the 'Project' checkbox.

4 Click on the OK button.

Each Project Item now appears in the Project compartment of the element on the
diagram. Items of each type are grouped together so that, for example, all Effort
items on the element are grouped under the heading 'Effort', and all Risk items on
the element are grouped under the heading 'Risk'.
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Effort Types

When setting up the project management parameters for monitoring work on elements, you can create types of effort to
add to the global list of effort types that can be assigned to any element in the model. You can also select and edit
existing effort types. The global list of effort types displays in the 'Type' drop-down list on the 'Effort' page of the Project
Indicators window.

Access

Open the 'Project Indicators' dialog using one of the methods outlined here, then select the 'Effort' tab.

Ribbon Settings > Reference Data > Model Types > Project Indicators : Effort

Keyboard shortcut Select an Effort item on a diagram or the 'Details' tab of the Inspector window, then
press Shift+Enter

Add a new effort type to the global list

Click the 'New' button to define a new Effort type

Option Action

Effort Type the name of the effort type. (Or, to edit an existing effort type, click on the
effort name in the Defined Effort Types panel.)

Description Type a short description of the effort type.

Weight Type the default weighting to apply to the effort type.

<note> Type any additional information on the effort type.

Save Click on this button to save the changes that you have made to the dialog.

New Click on this button to clear the data fields ready to define a new effort type.

Delete Click on an entry in the Defined Effort Types panel, and click on this button to
immediately delete the effort type.

Close Click on this button to close the 'Project Indicators' dialog. If you have not saved
your changes, the system prompts you to save or abort those changes.

Notes

Although Enterprise Architect does not currently provide detailed reports on effort within a model, you can use the·
Automation Interface or similar tools to create your own custom reports based on effort information you enter
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You can transport effort types between models, using the 'Settings > Model > Transfer > Export Reference Data' and·
'Import Reference Data' ribbon options
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Metric Types

Enterprise Architect enables you to add a metric type to the global list of metric types that can be assigned to any
element in the model. The global list of metric types displays in the 'Type' field drop-down list on the Metrics window.

Access

Open the 'Project Indicators' dialog using one of the methods outlined here, then select the 'Metric' tab.

Ribbon Settings > Reference Data > Model Types > Project Indicators : Metric

Add a new metric type to the global list

Click the 'New' button to define a new Metric

Option Action

Metric Type Type the name of the metric type. (Or, to edit an existing metric type, click on the
metric name in the Defined Metrics panel.)

Description Type a short description of the metric type.

Weight Type the default weighting to apply to the metric type.

<note> Type any additional information on the metric type.

Save Click on this button to save the changes that you have made to the dialog.

New Click on this button to clear the data fields ready to define a new metric type.

Delete Click on an entry in the Defined Metrics panel, and click on this button to
immediately delete the metric type.

Close Click on this button to close the 'Project Indicators' dialog. If you have not saved
your changes, the system prompts you to save or abort those changes.

Notes

Although Enterprise Architect does not currently provide detailed reports on metrics within a model, you can use the·
Automation Interface or similar tools to create your own custom reports based on metric information you enter

You can transport metric types between models, using the 'Settings > Model > Transfer > Export Reference Data'·
and 'Import Reference Data' ribbon options
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Risk Types

Using Enterprise Architect you can add a risk type to the global list of risk types that can be assigned to any element in
the model. The global list of risk types displays in the 'Type' field drop-down list on the 'Risks' page of the Project
Indicators window.

Access

Open the Project Indicators window using one of the methods outlined here, then select the 'Risk' page.

Ribbon Settings > Reference Data > Model Types > Project Indicators : Risk

Add a new risk type to the global list

Click on the New button to define a new Risk

Option Action

Risk Type Type the name of the risk type. (Or, to edit an existing risk type, click on the risk
name in the 'Defined Risks' panel.)

Description Type a short description of the risk type.

Weight Type the default weighting to apply to the risk type.

<note> Type any additional information on the risk type.

Save Click on this button to save the changes that you have made to the dialog.

New Click on this button to clear the data fields ready to define a new risk type.

Delete Click on an entry in the 'Defined Risks' panel, and click on this button to
immediately delete the risk type.

Close Click on this button to close the 'Project Indicators' dialog. If you have not saved
your changes, the system prompts you to save or abort those changes.

Notes

Although Enterprise Architect does not currently provide detailed reports on risks within a model, you can use the·
Automation Interface or similar tools to create your own custom reports based on risk information you enter

You can transport risk types between models, using the 'Settings > Model > Transfer > Export Reference Data' and·
'Import Reference Data' ribbon options
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Project Task Allocation

Using the Project Gantt View, you can review the allocation of work to elements in the project, focusing on either the
elements that require work, or the resources required to perform the work. The view primarily shows information that is
entered through other windows and dialogs, but once a record exists in the view you can edit it and, for example, add to
or change the resources on an element.

Access

Ribbon Construct > Resource Management > Gantt
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The Project Gantt View

In Enterprise Architect, you can visualize elements and assigned project resources in a Gantt Chart format, to review the
breakdown of work for a specific project and for specific sections of the project. The Project Gantt View illustrates a
project schedule by showing the start and finish dates of assigned resources, so that a Project Manager can quickly see
the current project status using the percent-complete bar shading and the percent-complete, resource name and status
columns. Information can be filtered, and overdue items can quickly be highlighted and identified.

You can also access specialized versions of the Project Gantt View from diagrams, Packages and the Personal Tasks list.

Access

Ribbon Construct > Resource Management > Gantt > Project Gantt View

Project Gantt View

This example shows four resources, two of whom are working in different capacities on one task, and two on another
task. The resource names and roles are listed in the left panel of the chart, together with the actual percentage completion
of each person's work on the task. In the right panel of the chart, completed work is indicated by the green section of the
bar, work yet to be completed but not yet due is indicated in blue, and work not completed and overdue is indicated in
red (as a result of the option to highlight overdue work being applied).

Tabs of the Project Gantt View

The Project Gantt View has three tabs, the first two of which use the Gantt chart itself to show the progress of work
against the resources performing the work or the elements having the work performed on them. (Other variations of the
Gantt chart do not have these separate tabs.)

View Detail

Resource View When you initially open the Project Gantt View, it defaults to the 'Resource View'
tab, in which the focus is on the current commitments of each allocated resource in
the project.

Element View The Element View lists the elements in the project that have resources assigned to
them, and the resources assigned to each element.
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Report View A Resource report shows how your resources are deployed in your project,
displaying a list of all elements that have resources allocated to them.

Project Gantt View Facilities

The facilities of the Project Gantt View are common to the Resource and Element Views, and in some cases to all three
tabs, as described here.

Option Action

Display tasks for today
only, or for another day
only

Right-click on the display and select the option:

'Show Only Active Tasks for Today' - to show only tasks that are in progress·
today

'Show Only Active Tasks for Other Day' - to show only tasks that were in·
progress on a specific day in the past, or that are scheduled to be in progress on
a day in the future; a calendar dialog displays from which you select the day to
examine

Display the properties of
the element to which a
resource is assigned

Right-click on the element entry and select the 'Show Element Properties' option.

The 'Properties' dialog for the element displays.

Display the Resource
Allocation details for an
element or resource

Right-click on the entry and select the 'Show Task Properties' option.

The 'Assigned Resources' dialog displays; you can edit the details and, if necessary,
change the resource allocated to the element.

Display the Resource
Allocation records for an
element

(Also available in the Report View.) Right-click on the entry and select either of the
context menu options:

'Show Element Resource Allocation window' (if the window is closed or·
hidden)

'Find Task in Element Resource Allocation window' (if the window is visible·
but showing the details of another element)

The Resource Allocation window displays, with the details of the selected entry
shown in the fields and the other resource allocations for the element listed in the
left-hand panel.

You can edit the details and, if necessary, change the resource allocated to the
element.

Assign a new resource to
an element

Right-click on an element in the display, and select the 'Assign Resource' option.

The 'Assigned Resources' dialog displays; complete this as for the Resource
Allocation window.

Change the scale of the
display

By default, the Project Gantt View shows periods of time in units of days of the
month, each date column being approximately one centimetre wide. Weekends have
a darker fill color.

You can change the scale of the date columns by clicking on the column header,
pressing Ctrl and rolling the mouse wheel. As you do this:

At one extreme the date columns expand to approximately 2.5 centimetres, and·
the date header shows the full date in dd/mm/yyyy format

Rolling to the other extreme changes the scale of the column from date through·
week, labeled month, numbered month and labeled year to numbered segments
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of a decade

This allows you to represent a wide range of tasks on a single chart and to condense
or expand the view - in conjunction with filters - to investigate the short term and
longer term work clearly.

Change the duration of a
task, on the Project Gantt
View

You might want to make broad adjustments to the timeline of an event, which you
can easily do on the Project Gantt View itself. For example, the resource is ill, or
another resource has taken over other tasks that the resource was allocated to. In
neither case has the task itself changed, but in the first case the resource needs a
longer elapsed time in which to complete the task, and in the second they have less
other work to do and can finish the task sooner.

To make these adjustments, you simply drag the right end of the time bar further or
back along the chart. This changes the task end date to wherever you drag the time
line to, and adjusts the division into complete and incomplete/overdue work to
maintain the percentage completion value. The work time allocated to the task does
not change.

If you drag the left end of the time line, this moves the whole line without changing
its length or proportions; you are just indicating that the task started earlier or later
and will finish earlier or later by the same amount of time.

Grouped work A resource is likely to be allocated to several tasks either simultaneously or
consecutively. In the Resource View the tasks assigned to a resource are grouped
under the resource name, and a narrow group bar displays in gray on the chart
against the name, spanning the period from when work is scheduled to begin on the
first task to when work is scheduled to finish on the final task.

Similarly, a body of work, represented by an element, might involve several
resources starting and finishing at different points. The resources are grouped under
the element name and the group bar displays on the chart against the element name,
spanning the period from when the first resource is scheduled to start work to when
the last resource is scheduled to complete work on the task.

If any adjustments are made that impact the initial start point or final completion
point of the work, the end of the group bar automatically adjusts. If any task or
resource in the group is overdue, the group bar turns red to reflect that there is a
potential problem in the allocated work.

Filter the display to
exclude elements by status

(This feature takes effect under your user ID.)

Right-click on the window and select the 'Apply Element Status Filter' option.

The 'Excluded Status Types' dialog displays; select the checkbox against one or
more statuses to exclude elements having those statuses from the list.

You can select every checkbox at once by clicking on the Select All button, and
clear all selections by clicking on the Clear All button.

Click on the OK button to immediately apply the filter, which stays in effect until
you specifically change it.

Filter the display to include
elements having certain
properties

Right-click on the list and select the 'Show Filter Bar' option.

The Filter Bar displays underneath the heading bar. Type a text string in the field
above a column to immediately filter the list for entries that have the text string in
the values in that column.

To delete a filter string altogether, click on the blue cross at the right of the field.

If you no longer want to use the filter bar, right-click on the list and select the 'Hide
Filter Bar' option.

Filter the display by Start
or Completion date

The display default is to show current tasks for which the end date has not yet
occurred. Right-click on the list and select one of the options:
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'Include Completed Tasks Within the Last ...' - to display incomplete tasks and·
tasks completed only within the specified period; you can set this period to 7,
30 or 90 days, or you can include all completed tasks, or hide all completed
tasks

'Include Future Tasks Starting in ...' - to display current incomplete tasks and·
completed tasks (depending on the setting of the 'Include Completed Tasks
Within the Last ...' option) and future tasks that have been recorded and are due
to start within the next period; you can set this period to 7, 30 or 90 days, or
you can show all tasks that have been recorded but are not yet due to start

Identify overdue tasks Right-click on the display and select the 'Display Highlight For Overdue items'
option and one of its sub-options:

'Show in Red' - to display the uncompleted percentage of the task bars for·
overdue items on the Gantt chart in red

'Show in Red to Current Date' - to extend the task bars of the overdue items to·
today's date, and display them in red

'None' - to cancel any overdue item highlighting that has been set·

Display ONLY overdue
tasks

Right-click on the display and select the 'Show Overdue Items Only' option.

The display shows only those items for which the end date has passed but that are
not 100% complete. These items do not have red highlighting.

Refresh the report Right-click on the entry and select the 'Refresh' option.

The content of the display is refreshed and collapsed to element or resource level.

Reposition the Project
Gantt View to
automatically show the end
date of a selected allocation

Right-click on the display and select the 'Go to | Auto Sync with Task End Date'
option.

Whilst this option is selected (with a tick next to it), whenever you click on an
allocation the display adjusts to show the end date of the task in the center of the
chart.

Reposition the Project
Gantt View to show the
start date or end date of an
allocation, or today's date

Right-click on the entry and select the required option:

Go To | Task Start Date·
Go To | Task End Date·
Go To | Today's Date·

The display shifts to put the required date in the center of the chart.

Locate the element in the
Browser window

(Also available in the Report View.) Right-click on the element name and select the
'Find in Project Browser' option.

The area of the Browser window containing the element is brought into focus and
expanded, and the element is highlighted.

Send a Model Mail to the
resource

It is possible to send a Model Mail directly from the Project Gantt View to a
selected resource if the resource's Author name matches their:

Enterprise Architect security user ID (Security has been enabled) or·
Their workstation login ID (Security has not been enabled)·

Right-click on the resource or one of their activities and select the 'Post Model
Message' option. This opens a Model Mail message addressed to the resource, for
you to complete and send.

Save an image of the
Project Gantt View to file

Right-click on the tab and select the 'Save Image to File' option.

The 'Save As Image' dialog displays, on which you specify the file name, location
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and graphics file type to save to.

Save an image of the
Project Gantt View to the
clipboard

Right-click on the tab and select the 'Copy Image to Clipboard' option.

You can paste the image from the clipboard into your preferred graphics
application.

Notes

Items in the list pane can be filtered; right-click on the column headings in the list pane to toggle the Filter Bar·
between hidden or shown, or to edit the filter
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Resource View

The 'Resource View' tab shows the current commitments of each allocated resource in the project as a list of allocation
records and a Gantt chart of the progress of the allocations.

The display initially shows the resources and their overall commitment; click on the 'plus-box' to the left of the name of
the resource to expand the entry to show the elements and the allocation period for each element.

The display shows both complete allocations and those that are still in progress; an internal filter hides completed
allocations two weeks after the end date, and incomplete allocations one month after the end date. Tasks you can perform
include checking the:

Dates on which specific resources or all resources are currently allocated·
Elements to which each resource is allocated·
Dates on which a resource is allocated to work on a specific element·
General progress of the resource in completing the work·
Specific details of the allocation of a resource to an element and task or role·

Access

Ribbon Construct > Resource Management > Gantt : Select the 'Resource View' tab
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Element View

The 'Element View' tab of the Project Gantt View lists the elements in the project that have resources assigned to them. It
shows the resources assigned to each element as a list of allocation records and as a Gantt chart of the progress of the
allocations. An allocation can be partial, in that a role or task is assigned but no specific resource has been identified.

The display initially shows the elements and their overall resource commitment; click on the 'plus-box' to the left of the
name of the element to expand the entry to show the resources and the allocation period for each resource. You can then:

Check the dates on which specific elements have resources currently allocated·
Check which resources are currently allocated to an element·
Assign further resources to the element·
Check the dates on which a resource is allocated to work on a specific element·
Check the general progress of the resource in completing the work·
Check the specific details of the allocation of a resource to an element and task or role·

The display shows both complete allocations and those that are still in progress; an internal filter hides completed
allocations two weeks after the end date.

The 'Element View' complements the 'Resource View' and 'Personal Tasks View' of work allocation on the project.

Access

Ribbon Construct > Resource Management > Gantt    or

Design > Diagram > Views > Gantt View

Context Menu Browser window | right-click on an open diagram | Switch View | Switch to Gantt
View

In diagram, right-click on background | Switch View | Switch to Gantt View

Browser window | Right-click on Package | Open Package in | Gantt View
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Report View

The Report View shows how your resources are deployed in your project, displaying:

A list of all elements that have resources allocated to them, and the type of each element·
The resource allocated, and the role played by that resource·
The start and end dates of the allocation·
The time allocated, expected and expended·
The percentage completion of the allocation·

You can tailor the displayed information by:

Hiding columns of information·
Grouping types of information·
Filtering the data by status·
Filtering the data by start date or end date·
Filtering any column to show only a specific value·

Having displayed the information you require, you can print it.

Access

Ribbon Construct > Resource Management > Gantt : Select the 'Report View' tab

Report View Options

Option Action

Run the report Click on the first icon in the Report View toolbar (the rotating arrows).

The report results display.

If you have the report open for a while, you can update the information; either:

Run the report again or·
Right-click on the content and select the 'Refresh' option·

Adjust column headings Drag and drop column headings into the sequence you require.

Right-click on the column headings and select the 'Field Chooser' option, to add or
remove columns using the 'Field Chooser' dialog.

Group entries by column
heading

Right-click on the column headings and select the 'Enable Group Box' option, to
cluster the report information according to your preferred hierarchy of column
headings.

Filter columns Either:

Click on the third toolbar icon from the right (the spy glass), or·
Right-click on the column headings and select the 'Toggle Filter Bar' option·
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The filter field displays at the top of every column.

Type in whatever text string you require in the appropriate column to filter the
report to show only entries containing that text string in that column.

Filter by degree of
completion

In the first field in the toolbar, click on the drop-down arrow and select one of these
values:

'All' - Display all entries regardless of degree of completion·
'Completed' - Display only those entries where the allocation is 100%·
completed

'Above cut-off' - Display only those entries that are more than a certain·
percentage complete

'Below cut-off' - Display only those entries that are less than a certain·
percentage complete

In the second field in the toolbar, either type a threshold value or increment to the
value using the up/down arrows, to set the percentage completion for the
'Above/Below cut-off' options.

Filter according to start/end
date

Click on the fourth toolbar icon from the right (the funnel).

The 'Resource Filters' dialog displays.

In the 'Start Date' and/or 'End Date' field, click on the drop-down arrow and select
the appropriate qualifier:

'After'·
'Before'·
'Equal To'·
'Not Equals'·

In the date fields, click on the checkbox to activate the fields and either type in the
day, month and year or click on the drop-down arrow to select the date from a
calendar.

The fields have an AND relationship; an entry must satisfy both date criteria before
it is displayed.

Print the report Either:

Click on the second toolbar icon from the right (the printer) or·
Right-click on an entry in the report and select the 'Print' option·

The 'Print' dialog displays, on which you specify the printer to use and the
characteristics of the print job.
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Progress Bars

Progress bars are horizontal bands that show the degree of completion of a task or process. They give a quick indication
of the current status of, for example, projects, tasks or budgets, which can be useful for checking how close a task or
project is to completion or if a project is coming close to hitting its total allowed budget.

Progress bars can be especially useful in large projects that consist of multiple smaller projects, as you can display within
one element separate bars showing the degree of completion of each sub-project and of the main project, giving you an
overview of progress at a single glance. Separate elements within the diagram can contain further progress bars for the
metrics of the individual projects, adding levels of detail that can, again, be assessed in a brief review.

In Enterprise Architect, progress bars are implemented using Tagged Values on elements. They are automatically added
to elements on a Kanban diagram or Construction diagram, where progress or resource consumption are indicated.
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Using Progress Bars

You can add progress bars to any element that can show compartments and that can display any numerical value within a
range, when displayed on a diagram.

Progress bars can be used to display things such as:

The current progress of a task or project·
How much of project's budget has been used·

By default a progress bar will display a value between 0 and 100 (inclusive); however, it is possible to adjust both the
minimum and maximum values to set any range of values required.

This illustration shows an example of a default progress bar:

Creating a Progress Bar using a new Tagged Value

Follow the steps below to display a progress bar within an element, using a simple Tagged Value.

Step Action

1 On a diagram, create an element that can display compartments (such as a Requirement or Feature) and
add a simple Tagged Value to it.

2 From the 'Tags' tab of the Properties window open the tag's notes and add 'Type=ProgressBar;' (including
the semi-colon) and then click on the OK button.

(You can add further options to the Tagged Value, as described in the Additional Progress Bar Options
table.)

3 Click on the element and either press Ctrl+Shift+Y or right-click and select the 'Compartment Visibility'
option. The 'Compartment Visibility' dialog displays.
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4 Select the 'Tags' checkbox in the 'Show Element Compartments' panel, then click on the OK button.

The progress bar will now display on the element on the diagram, with the Tagged Value name above the
bar.

5 In the 'Tags' tab of the Properties window, indicate progress by typing a number between 1 and 100 into
the 'Value' field for the tag. On the diagram, the appropriate length of the progress bar is filled in green.

Creating a Progress Bar from the 'UML Types' dialog

You can also define a progress bar Tagged Value from the 'UML Types' dialog that can then be applied to any element,
without having to set the Tagged Value notes each time.

Step Action

1 Select the 'Settings > Reference Data > UML Types' ribbon option to display the 'UML Types' dialog and
click on the 'Tagged Value Types' tab.

2 In the 'Tag Name' and 'Description' fields, type a name and description for the Tagged Value. In the
'Detail' field type the option parameters and their values for the Tagged Value. Click on the Save button
and on the Close button.

(The option parameters are described in the Additional Progress Bar Options table.)

3 Select the 'Start > Application > Design > Properties' ribbon option to open the Properties window (if it is
not already open) and select the 'Tags' tab.

On a diagram select an element, then on the 'Tags' tab click on the  (New Tagged Value) button.

In the 'Tag' field of the Tagged Value dialog, click on the drop-down arrow and select the Tagged Value
you created in step 2, then click on the OK button.
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4 On the diagram, right-click on the element and select the 'Compartment Visibility' option to display the
'Compartment Visibility' dialog.

5 Select the 'Tags' checkbox and click on the OK button.

6 On the 'Tags' tab, change the number in the value field a few times, clicking off the field each time. Notice
the effect this has on the progress bar.

Creating a Progress Bar using the Custom Drawn Element

Custom-drawn elements allow the use of the element's fill color to represent the progress in the progress bar, so the
element itself becomes the progress bar.

To display progress using the element's fill color as the progress bar, setup a Tagged Value for the progress bar as
described in the previous sections, then add the following line to the Tagged Value's Notes: FillElement =true;  You
will also need to set the Diagram property "Appearance > Custom Style", by placing a check against that property.

You can set the fill color, background color and border color, by adding further parameters to the Notes of the Tagged
Value.

For example:

FillClr=val;·
BackClr=val;·
BorderClr=val;·

When setting the colours of a progress bar, 'val' can be supplied in a variety of ways, such as:
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RGB(0,128,0);·
HSL(300, 50,86);·
#00FF00;·

Default web colour names such as AliceBlue, Green or Khaki can also be used. Additionally, it is possible to use the
current fill, line, or text color of the element for the properties mentioned above by using ‘elementfill’, ‘elementborder’,
or ‘elementtext’.

For example:

FillClr=elementfill;·
BorderClr=elementtext;·

Examples of Setting Colors When Displaying Progress Using Element Fill Color

Example Tagged Value Note

Using Hex Values Type=ProgressBar;

FillElement=true;

FillClr=#2F4550;

BorderClr=#629677;

BackClr=#586F7C;

Using  HSL, RGB and
Default HTML Colors

Type=ProgressBar;

FillElement=true;

FillClr=hsl(210,100,97);

BorderClr=RGB(23,12,202);

BackClr=LightSeaGreen;

Using RGB and Current
Element Fill and Border
colors

Type=ProgressBar;

FillElement=true;

FillClr=rgb(230,214,239);

BorderClr=elementline;

BackClr=elementfill;

Using the current element
fill

Type=ProgressBar;

FillElement=true;

FillClr=elementfill:s=-30:l=70:;

BorderClr=elementline;

BackClr=elementfill;

In this example the current element fill is used for both the fill color of the·
progress bar as well as the background color.  However, the fill color is
modified from the original element fill to be less saturated (30% less) and
brighter (70% increased luminosity):

Additional Progress Bar Options
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A default progress bar will show the Tagged Value name and reflect values in the range 0-100. You can change the range
values if required, and display text to the right of the bar if more information has to be provided. The background, border
and fill colors of the progress bar are, by default,  determined by the currently-applied inbuilt diagram theme. However,
you can apply your own colors to one of more of these properties.

Add these parameters to the Notes field of the Tagged Value, to enhance the progress bar.

Parameter Description

MinVal Use the MinVal option to set the lowest allowed value to be represented on the
progress bar.

Syntax: MinVal=<number>;·
A progress bar with the setting MinVal=10; will start at 10. Values lower than 10
will not be shown on it.

If a maximum value (MaxVal) has been defined, the progress bar will show any
values between MinVal and MaxVal (inclusive); otherwise, the maximum value
will default to MinVal + 100. So, if MinVal=10, the progress bar can show values
between 10 and 110 (inclusive).

MaxVal Use the MaxVal option to set the highest allowed value to be represented on the
progress bar.

Syntax: MaxVal=<number>;·
A progress bar with the setting MaxVal=300; will show values up to and including
300. Values higher than 300 will not be shown.

If a minimum value (MinVal) has been set, the progress bar will show any values
between MinVal and MaxVal (inclusive); otherwise the minimum value will
default to 0. So, if MaxVal=300 the progress bar can show values between 0 and
300 (inclusive).

Text Use the Text option to define additional text to display on the right hand side of the
progress bar. The text might be a resource name or the current take up of the total
allowed budget of a project.

Syntax: Text=<text>; - displays the defined text string, such as 'David Brown's·
Tasks'

Syntax: Text=#Value#; - displays the value of the progress bar Tagged Value,·
such as '462' (where the Tagged Value name itself might indicate the type of
value or unit)

Syntax: Text=<text> #Value# <text>; - displays the value of the progress bar·
Tagged Value with text before and/or after it, such as '$<value> of $100,000'

This illustration shows a number of examples of using the Text option.

Compartment By default, progress bars in an element display together in a separate compartment
from other types of Tagged Value (provided that the diagram and/or element is set
to display tag compartments).
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When there are several progress bars on an element, each relating to a different
factor of the project, it can become harder to distinguish between them. In these
cases it is possible to set the progress bars to display in specific compartments in
order to increase clarity. This also provides an additional level of labeling. So you
might have an element relating to costs, and two or more compartments that
indicate costs of different departments, where the department name is reflected in
the compartment name. Or compartments that each contain two or more progress
bars indicating, say, the costs and percentage completion of tasks in each
department.

Syntax: Compartment=<name>;·
To add multiple progress bars to the same compartment simply give the progress
bars the same compartment name.

This example shows the element from the Text parameter example, but with the use
of compartments to aid in readability.

BackClr Use the BackClr option to override the color used for the unfilled portion of the
progress bar.

Syntax: BackClr=<color>;·
<color> can be one of a variety of values, such as the RGB value rgb(198,198,198)
for a light gray color.

See the Progress Bar Color Options table for a full list of available values when
setting colors.

FillClr Use the FillClr option to override the color used for the filled portion of the
progress bar.

Syntax: FillClr=<color>;·
<color> can be one of a variety of options, such as the hex value #0000ff for a
bright red.

See the Progress Bar Color Options table for a full list of available values when
setting colors.

BorderClr Use the BorderClr option to override the color that is drawn around the edges of the
progress bar.

Syntax: BorderClr=<color>;·
<color> can be one of a variety of options, such as the keyword elementtext to
select the same color as the current element's text color.

See the Progress Bar Color Options table for a full list of available values when
setting colors.
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Example

The Requirement element 'REQ015 - Process Credit Card Payment' is given a Tagged Value named 'Completion', with a
value of '66'.

In the Tagged Values Notes, we specify 'Type=ProgressBar;' along with display text and color settings.

The result is the Progress Bar seen here:
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Progress Bar Color Options

This table lists the different types of value that can be used with the options BackClr, FillClr and BorderClr when setting
custom colors for a progress bar.

Value Description

rgb(red,green,blue) Using rgb values you can set the red, green and blue color components to create the
color you require.

Example:

BackClr=rgb(46, 139, 87); //Sets the unfilled portion of the progress bar to a sea
green color.

The red, green and blue values each have a range of 0 to 255·
This option can be useful in conjunction with the color pickers from the 'Layout' tab
as they give an RGB value for the currently selected color.

hsl(hue, saturation,
luminosity)

Using hsl is very similar to using rgb. Unlike rgb, however, it is easier to create a
lighter or darker version of the same color by simply adjusting the luminosity, or to
increase or decrease the intensity of the color by adjusting the saturation.

Example:

FillClr=hsl(197, 71, 73); //Sets the filled portion of the progress bar to a sky blue
color.

The hue value has a range of 0 to 360·
The saturation and luminosity values each have a range of 0 to 100·

Hex Values Colors can also be defined using a hex value.

Example:

BorderClr:#000000; //Sets the border color of the progress bar to black.

Hex values range from #000000 to #ffffff·

HTML Color Names It is also possible to use the standard web color names when defining a color for
progress bars.

Example:

fillclr=aliceblue; //Sets the filled portion of the progress bar to the standard color
'aliceblue'

Enterprise Architect supports the 140 standard HTML color names.·

Element Colors Using ElementFill, ElementLine or ElementText will set the color value to the fill,
line or text color of the currently-selected element (that is, ElementFill will apply
the element's current fill color).

Colors set this way can be further refined by using the modifiers s=<value> and
l=<value> to modify the color's saturation and luminosity, making the color
assigned to the progress bar a slightly altered version of the currently selected
element color.

These settings can be useful if the element is expected to change color (such as
from the use of a Diagram Legend) to keep the progress bars themed correctly with
the element.

Example:

backclr=elementfill:s=-10:l=20:;   //Sets the unfilled portion of the progress bar to
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be the same as the element's fill color but with a 10% decrease in the color's
saturation and a 20% increase in the luminosity.

s and l can be any value; however, the results can vary depending on the·
currently selected color (for example, a luminosity increase of 20% might not
be as noticeable on a very light color compared to a darker color)

none The none keyword is used to indicate that no color should be applied to the selected
field.

Example:

borderClr=none; //Removes the border from the progress bar.

Progress Bars with MDG Technologies

Progress bars can also be created within MDG Technologies to define a consistent set of progress bars for use with
multiple projects.
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Personal Tasks

Using the Personal Tasks view, you can record and manage your personal work within the project. This view displays
information based upon your identity as a defined Author on the project.

Access

Ribbon Start > Personal > My Gantt

Work Category

Category Detail

Allocated Work Presents a Gantt chart on which you record the work that you are currently engaged
in.

Project Tasks Enables you to monitor and maintain the work tasks that have been assigned to you,
or that you have created yourself.
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Review Allocated Work

The 'Allocated Work' tab lists the elements to which your model Author ID has been allocated as a resource, where your
Author ID is the same as:

Your Enterprise Architect security user ID, if security has been enabled, or·
Your workstation login ID if security has not been enabled·

For each element, the tab:

In the left-hand panel lists the roles or tasks assigned to you as a resource on that element, for which the 'Complete·
%' field value is less than '100'

In the right hand panel displays a Gantt chart showing your progress in performing each role or task·
You can add further work items for an element through the 'Allocated Work' tab; however, you cannot delete any
records. A record is no longer listed when the 'Complete %' field value is '100'.

You or your supervisors can also add records through the Resource Allocation window.

Access

Ribbon Start > Personal > My Gantt > Allocated Work

Select Allocated Work options

Option Action

Review element properties Double-click on the element name.

(Alternatively, right-click on the element name and select the 'Show Element
Properties' option.)

The 'Properties' dialog for the element displays; review the pages as required.

Review resource task
details

Double-click on the task item.

(Alternatively, either:

Double-click on the progress bar for the item on the Gantt chart, or·
Right-click on the task or role name and select the 'Show Task Properties'·
option)

The 'Assigned Resources' dialog displays, which has the same content, format and
functions as the Resource Allocation window, in 'Item' mode.

Should it be necessary to reassign the item to another resource, click on the
drop-down arrow on the 'Resource' field and select the appropriate 'Author ID';
when you save the changes, the item no longer appears in the list of tasks assigned
to you.

Create new task item Right-click on the element name and select the 'Add Resource' option.

The 'Assigned Resources' dialog displays, with your Author ID in the grayed-out
'Resource' field.

Complete the dialog as for the Resource Allocation window.
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Refresh display to
incorporate changes

Your work item can be edited in a number of places in Enterprise Architect, such as
the Project Task Allocation window and the 'Resource Allocation' tab; the element
to which it is assigned can be edited in these and many other areas.

To refresh the display with any changes made elsewhere, right-click on the display
and select the 'Refresh' option.

Display the Resource
Allocation records for the
element

Right-click on the entry and select either of the options:

'Show Element Resource Allocation window' (if the window is closed or·
hidden)

'Find Task in Element Resource Allocation window' (if the window is visible·
but showing the details of another element)

The Resource Allocation window displays, with the details of the selected entry
shown in the fields and the other resource allocations for the element listed in the
left-hand panel.

You can edit the details and, if necessary, change the resource allocated to the
element.

Display tasks for today
only, or for another day
only

Right-click on the display and select the option:

'Show only Active tasks for today' - to show only tasks that are in progress·
today

'Show only Active tasks for another day' - to show only tasks that were in·
progress on a specific day in the past, or that are scheduled to be in progress on
a day in the future; a calendar dialog displays from which you select the day to
examine

Filter the display by Start
or Completion date

The display default is to show current tasks for which the end date has not  yet
occurred. Right-click on the list and select one of the options:

'Include Completed Tasks Within the Last ...' - to display incomplete tasks and·
tasks completed only within the last period; you can set this period to 7, 30 or
90 days, or you can include all completed tasks, or hide all completed tasks

'Include Future Tasks Starting in ...' - to display current incomplete tasks and·
completed tasks (depending on the setting of the 'Include Completed Tasks
Within the Last ...' option) and future tasks that have been recorded and are due
to start within the next period; you can set this period to 7, 30 or 90 days, or
you can show all tasks that have been recorded but are not yet due to start

Identify overdue tasks
amongst the items

Right-click on the display and select the 'Display Highlight For Overdue items'
option and one of its sub-options:

'Show in Red' - to display the uncompleted percentage of the task bars for·
overdue items on the Gantt chart in red

'Show in Red to Current Date' - to extend the task bars of the overdue items to·
today's date, and display them in red

'None' - to cancel any overdue item highlighting that has been set·

Display ONLY overdue
tasks

Right-click on the display and select the 'Show Overdue Items Only' option.

The display shows only those items for which the end date has passed but that are
not 100% complete. These items do not have red highlighting.

Locate the element in the
Browser window

Right-click on either the element or the work item and select the 'Find in Project
Browser' option.

The appropriate Package hierarchy expands in the Browser window, and the
selected element is highlighted.
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Reposition the Gantt chart
to automatically show the
end date of a selected
allocation

Right-click on the display and select the 'Go to | Auto Sync with Task End Date'
option.

Whilst this option is selected (with a tick next to it), whenever you click on an
allocation in the 'Allocated Work' tab the display adjusts to show the end date of the
task in the center of the chart.

Expose hidden sections of
the work item progress

Some items might operate over a long period of time, and you might not be able to
display the complete progress line for the item in the Gantt chart.

To locate the start point, expected end point, or today's date on the progress line for
an item, right-click on either the item or the progress line and select the appropriate
option:

Go To | Task Start Date·
Go To | Task End Date·
Go To | Today's Date·

The Gantt chart shifts left or right to position the required point in the center of the
display.

Execute Scripts If scripts have been defined for analyzing the task data, click on the 'Scripts' option
to display the list of script names. Click on the appropriate name to execute the
script on the selected item or items.

Filter the work items You can refine the list of work items to show only those containing text that
matches the filter item.

Right-click on the tab and select the 'Show Filter Bar' option.

The filter bar displays at the top of the panel; type in the filter text.

As you type, the items listed and the Gantt chart are filtered to show only items
where the item names match the text string.

The filter does not operate on the element names.

If you do not want to use the filter, right-click on the tab and select the 'Hide Filter
Bar' option.

Capture an image of the
Allocated Work data as a
graphics file

Right-click on the tab and select the 'Save Image to File' option.

The 'Save As Image' dialog displays, on which you specify the file name, location
and graphics file type to save to.

Copy an image of the
Allocated Work data to the
clipboard

Right-click on the tab and select the 'Copy Image to Clipboard' option.

You can paste the image from the clipboard into your preferred graphics
application.
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Monitor Your Tasks

The 'Project Tasks' tab lists the tasks that you either:

Own, or·
Are assigned to·

You can use the tab to review the status and progress of tasks that you are responsible for, and to modify and filter the
display of task information. You can create the tasks through the:

'Project Tasks' tab of the My Gantt display itself·
The Project Management Project Tasks view (of all tasks in the project), or the·
'Project Tasks view of the Resource Calendar·

Access

Ribbon Start > Personal > My Gantt > Project Tasks

Make selections from the options

Option Action

Add or Modify a task You add or modify a task through the 'Task Detail' dialog, which displays when you
double-click on an entry (edit) or blank line (create).

Delete a task Right-click on the message and select the 'Delete' option.

You are prompted to confirm the deletion.

Select columns Right-click on the column headings and select the 'Field Chooser' option, which
enables you to add or remove specific columns from the display.

You can also click on the column headings and drag them across the header bar to
reposition the columns in a different sequence.

Reorganize tasks in the list Either:

Click on the column heading and click on the arrow head to list items in order·
or reverse order, or

Right-click on the column headings and select the 'Enable Group Box' option·
to organize the messages into groups

You can also use the filter bar to filter the display on an appropriate column value,
such as the value 'New' in the 'Status' column; to display or hide the filter bar,
right-click on the column headings and select the 'Toggle Filter Bar' option.

Set persistent Status filter Right-click on the tab and select the 'Set term filter' option.

The 'Filter by Status' dialog displays, which enables you to select to list tasks of any
status or only of one specific status.

The filter you set persists when you close the Personal Tasks window or exit from
Enterprise Architect.
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Print the task list Right-click on the tab and select the 'Print List' option.

The 'Print' dialog displays, on which you specify the local printer and the print
characteristics.
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Project Tools Window

The Project Tools window shows the records of these quantities associated with an element contained in the model:

Decision - a choice made on a requirement of the element·
Event - an action taken on a requirement of the element·
Issue - a failure of the element to meet a requirement·
Task - an item of work on the element assigned to a resource to meet a requirement·
Effort - effort expended in work on the element·
Risks - risk associated with the element·
Metrics - metrics measured for an element·

A separate tab of the Project Tools window or - for Issues and Tasks - report list displays for each of these quantities.

Access

Ribbon Construct > Project Management and as required, one of:

> Events | Show Events Window·
> Decisions | Show Decisions Window·
> Issues-Tasks | Project Tasks·
> Issues-Tasks | Project Issues·
> Effort·
> Risks·
> Metrics·

Keyboard Shortcuts Click on the required Project item on a diagram or on the 'Details' tab of the
Inspector window, then press Shift+Enter

Context Menu Options

You can add or delete individual items in any of the tabs of the Project Tools window, using the window context menu
options.

Icon Action

Add New Create a new Decision/Event item, using the '<type> details for <element type>
<element name>' dialog, in the same way as you create Maintenance items.

Create a new Risk/Metric/Effort item, using the '<type>' dialog.

Modify Selected Update the selected Decision/Event item, using the '<type> details for <element
type> <element name>' dialog.

Update the selected Risk/Metric/Effort item, using the '<type>' dialog.

Create as New Element Create a new element based on the Project Decision/Event item, in the same way as
you generate elements from Maintenance items.
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Print List Print the list of items.

Delete Delete the selected item from the list.

Notes

Click on an element in the Browser window to switch to the project management items for that element in the·
Project Tools window

Columns in the item list can be reorganized, added, removed, grouped, filtered and sorted using the options provided·
in the List Header facilities

Right-click on the list to view the context menu, which you can use to also add and delete items in the window·
You can move Decision and Event items between elements; see the Move Decisions/Events Between Elements Help·
topic
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Move Decisions/Events Between Elements

A Decision or Event you define for one element might be usefully moved to another if, for example, you are moving
your model through stages in a lifecycle or, indeed, modeling a lifecycle. It is possible to simply drag a Decision or
Event from either the appropriate tab of the Project Tools window or the 'Details' tab of the Inspector window, onto a
different element on a diagram.

Access

From the Browser window, open the diagram containing the target element, then click on the element from which to
move the Decision or Event. It is convenient to have both source and target elements on the same diagram, but it is
possible to select the source element in the Browser window or on a different open diagram.

It is also convenient to have compartments enabled on the target element, with the 'project'  compartment selected, so that
you can observe the addition of the moved item. (Right-click on the element and select 'Compartment Visibility', then
select the 'Project' checkbox.)

Ribbon Start > Application > Design > Browser > Element - expand the 'Project' category
or

Construct > Project Management > Decisions > Show Decisions Window

Construct > Project Management > Events > Show Events Window

Keyboard Shortcuts Alt+2 | Project > Decisions   or   > Events

Move the Decision or Event to the Target Element

Click on the item that you intend to move, and simply drag it onto the target element. The item name will display in the
'project' compartment of that element. What you would observe might resemble this illustration.
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Testing & QA

 

It is important in any project to perform quality control of both the process and the output of the project; Enterprise
Architect provides several facilities for testing and validating your model structure and content, including Integration
with the unit testing tools JUnit and NUnit.

Facilities

Facility Description

Testing Create and manage test scripts for model elements. Explore the Testing user
interface, supporting unit, integration, scenario, system, acceptance and inspection
tests.

Model Validation Check UML elements, diagrams or Packages against known UML rules (identified
in configuring validation) and constraints defined within the model, using the
Object Constraint Language (OCL). Define your own checks against custom rules
and constraints. See the Model Validation Help topic for more information on
setting up model validation rules.

Testpoint Management Pass or fail application tasks, viewing test results in real time as the program
executes and results are saved. See the Help section on Testpoints for more
information on setting up and running automated tests.
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Test Management

Enterprise Architect is not only a UML Modeling environment, it is also a complete Test Management environment.
Using Enterprise Architect you can create and manage test scripts for model elements, developing unit, integration,
scenario, system, acceptance and inspection tests; these can include test cases generated from xUnit testing and Testpoint
Management.

You can also import or move tests from other elements, generate them from scenarios, and generate test documentation
and reports; you can indicate the presence of tests on an element by displaying test information in a compartment of the
element in a diagram.

It is simple to attach even complex tests to any model element. Keeping the model elements and the testing
documentation in one integrated model significantly improves the communication between the test-team and the software
developers and architects.

The system's detailed search facilities make it easy to find failing test cases, test cases not run and test cases that have
been passed; using the testing and search capabilities, it is easy to navigate through the model and quickly locate problem
spots, design flaws and other critical issues.

Test Tasks

Tasks Detail

Create Tests You initially create tests in either the 'Test Details' dialog or the Test Cases
window.

Typically, you create:

Unit tests for things that are being built, such as Classes and components·
Integration tests to test how components work together·
System tests to ensure the system meets business requirements·
Acceptance tests to test user satisfaction·
Scenario tests to test the end-to-end suitability and functionality of the·
application

Inspection tests for peer review of things that are being built using a well·
defined process

These test categories are otherwise referred to as test Classes.

There is also a 'Full Test Suite' tab that displays a read-only list of all the Test items
on the element, grouped by type. If you double-click on an item in this list, the
appropriate tab displays with the item highlighted.

Using Tests Tasks that you might perform via the Test Cases window when working with tests
include:

Create and edit test records·
Import a scenario from an element or a Package as a test·
Import an internal requirement or constraint as a test·
Import a test from another element·
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Create a maintenance item from a test·
Move or copy tests between test classes·
Move a test from one element to another·
Print the list of tests of the current test class for the element·
Delete the test·

Notes

Most of the listed tasks relate to a tests for a single element·
You can display the Test Cases window for an element on a diagram, by clicking on the element and pressing the T·
key

You can make a set of tests available to a number of elements by performing the listed tasks on a Test Case element·
and then associating that Test Case with each of the other elements; the Test Case element also helps to make tests
more visible in diagrams, the Browser window, windows and searches
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Create Test Records

When you need to create or edit a test record on an element, for any of the six types of test, you can do so using either:

The Test Cases window (to quickly set up or change test records, and perform operations on them)·
The 'Test Details' dialog (To create test records with more Notes information, which you can also add through the·
Notes window)

The Properties window for Test items (to edit the properties of existing tests - see the Properties Window for Test·
Items Help topic)

Whichever type of test you are recording, you complete effectively the same fields.

Access

Ribbon Construct > Test Management > Tests > <test class> :  overtype Add new
<testtype> (Test Cases window)

Keyboard Shortcuts Click on the element : Alt+2 > Testing : <test class>  :  overtype Add new
<testtype> (Test Cases window)

Click on the element on a diagram | Press the T key   (Test Cases window)

Other On the Test Cases window, double-click on the Test item to display the 'Test
details' dialog

Create a Test Record in the Test details Dialog
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Field/Button Action

Test Type the name of the test. This can be any alphanumeric text string you want to
use.

Auto As an alternative to typing in the name, click on this button to insert predefined
auto-counter text; if you do not have auto-counter text configured, an information
message displays.

If you already have some text in the 'Test' field, it is over-written by the
auto-counter text.

Class This defaults to the class of test you selected in displaying the dialog. If this is not
the class you require, click on the drop-down arrow and select the appropriate
value.

Type Click on the drop-down arrow and select the value indicating the type of test (Load,
Regression or Standard). You cannot type in any alternative types.

Click on the check box and then on the drop-down arrow and select the date on
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Run Date which the test is to be run (or when it was last run).

Run By Click on the drop-down arrow and select the name of the person who is to run, or
has run, the test. The list selection defaults to your name as the current user.

(Possible values are derived from the Project Author definitions in the 'People'
dialog - select the 'Settings > Reference Data > Model Types > People > Project
Authors' ribbon option.)

Result Click on the drop-down arrow and select the value indicating the current status of
the test (Not Run, Pass, Fail, Deferred or Canceled). You cannot type in any
alternative values.

Checked By If you have provided a Run date, when you click on this field it defaults to your
user name as the current user.

If you have not provided a Run Date, click on the drop-down arrow; the list
selection defaults to your user name as the current user.

If you are not the person who is to check, or has checked, the results of the test,
scroll to and select the name of the relevant person .

Description Type a description of the test; you can format the text using the Notes toolbar at the
top of the field. The text you type here is also shown in the Notes window, under
the 'Description' heading.

Input Type in the input data provided to the test; you can format the text using the Notes
toolbar at the top of the field. The text you type here is also shown in the Notes
window, under the 'Input' heading.

Acceptance Criteria Type the acceptance or test success conditions; you can format the text using the
Notes toolbar at the top of the field. The text you type here is also shown in the
Notes window, under the 'Acceptance Criteria' heading.

Results Type the results of the last test; you can format the text using the Notes toolbar at
the top of the field. The text you type here is also shown in the Notes window,
under the 'Results' heading.

Apply Click on this button to save the data you have entered and to add the entry to the
Test Cases window and the Browser window, keeping the 'Test details' dialog open.

OK Click on this button to save all new data and close the 'Test details' dialog.

New Click on this button to clear the data entry fields ready for defining another test.

left chevron/right chevron If there are existing tests, click on these buttons to display the details of the
previous test or next test in the sequence.

Close Click on this button to discard all unsaved data and close the dialog.

Create a Test Record in the Test Cases Window
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Depending on your screen width and the fields you have exposed in the Test Cases window using the 'Field Chooser'
dialog, you might need to scroll the window left and right to see all fields. As it is possible to change the sequence of
fields across the window, the fields might not be in the order as documented.

Field/Button Action

Test Overtype the Add new <test type> text with the name of the new test.

Status Click on the field and on the drop-down arrow, and select the appropriate status.

Type Click on the drop-down arrow and select the appropriate test type - Load,
Regression or Standard.

Run By Click on the drop-down arrow and select the name of the person who ran - or will
run - the test.

You can also start typing the name of the person, until the auto-complete facility
fills in the rest of the name.

Checked By Click on the drop-down arrow and select the name of the person who checked - or
will check - the results of the test.

You can also start typing the name of the person, until the auto-complete facility
fills in the rest of the name.

Description Type in a short description or explanation of the test.

Run Date Type in the date on which the test was last executed, in dd/mm/yyyy format.

Notes

To delete an item, right-click on it in the Test Cases window and click on the 'Delete' option in the context menu; in·
response to the confirmation prompt, click on the Yes button

A further possibility for generating and editing Test items is to right-click on the Testing category in the 'Details' tab·
of the Inspector window - or the required item within the list - and select menu options to perform the required
operation

To change the element for which to create or edit Test items, click on the element in a diagram or the 'Project' tab of·
the Browser window

In the Corporate, Unified and Ultimate Editions of Enterprise Architect, if security is enabled you must have·
'Manage Tests' permission to add, update and delete Test records
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Show Test Script Compartments

When you have created a Test record, it is useful to make the test visible on its parent element. You can do this by
displaying the test within a Test Script compartment on the element as it displays in a diagram. Any element that is
capable of displaying a compartment, and that has a test assigned to it, can show test scripts in a diagram.

Show the Test Scripts on an Element in a Diagram

Step Action

1 Open a diagram containing the element with the attached test items.

2 Double-click on the diagram background to display the diagram 'Properties' dialog.

Click on the 'Elements' tab.

3 In the 'Show Compartments' panel, select the 'Testing' checkbox.

4 Click on the OK button to save the setting.

Each test item now appears in the test scripts compartment of the diagram element. Items of each type are
grouped together so that, for example, all Unit tests on the element are grouped under the heading 'Unit',
and all Integration tests on the element are grouped under the heading 'Integration'.

If you click on a test item, and the Notes window and/or Test Cases window are open, the test details are
immediately displayed in them. If you double-click on the item, the 'Test details' dialog opens, showing
the details of that test.

Example
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Properties Window for Test Items

When the Properties window is open, it displays the properties of the selected object or assigned item, including a Test
record for an element. You might select the Test in the Test Cases window, the test scripts compartment of an element on
a diagram, or in the 'Details' tab of the Inspector window.

The Properties window identifies the test class of the test just under the toolbar, and shows the current values for the:

Test name·
Test type·
Run date·
Result·
'Run by' user, and·
'Check by' user·

You can change the value for each of these fields (except for the 'Test' field), clicking on the drop-down arrow and
selecting a new value. For the 'Run by' and 'Check by' fields, you can also start typing in the user name until the
autocomplete facility provides the rest of the name.

For the 'Test' field, you can either overtype the test name or click on the  icon and apply any autonaming convention
you have configured for test items.

The toolbar options operate on the parent element for the test. Any changes you make are automatically saved and
displayed elsewhere when you click off the field.
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Move or Copy Tests Between Test Classes

After you define a test within one test class (Unit, Integration, System, Acceptance, Inspection or Scenario), you might
decide that the test either is better suited to another test class, or forms a good template for tests in other classes. If so,
you can either move or copy the test to the other class lists.

Access

Click on the element containing the test records.

Ribbon Construct > Test Management > Tests > <test class> > Right-click on test to
move/copy

Start > All Windows > Construct > Testing > <test category> > Right-click on test

Keyboard Shortcuts Alt+2 > Testing : right-click on test to move/copy

Move or Copy a Test

Step Action

1 Click on the appropriate option - 'Move to' or 'Copy to'.

A list of test classes displays.

2 Click on the test class to which to move or copy the test.

A confirmatory prompt displays.

3 Click on the Yes button to confirm the move or copy.

4 In the Test Cases window, click on the tab for the test class you moved/copied the test into, to check that
the Test has been added.

Double-click on the test to open the 'Test details' dialog, and make any necessary changes to the Test
record.

5 If you are copying the test to more than one other test class, repeat steps 1 to 4 for the next class to copy
to.

Notes

If you move or copy a test into the Scenario Tests class, some unassociated data could be lost·
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Create Maintenance Item From Test

If an element fails a test, one likely consequence is that a Defect (Issue) item has to be raised in model maintenance to
correct the problem. You can generate this Defect item directly from the test that failed.

Access

Select the element containing the failed test, then use one of the methods outlined here to display the Test Cases window
or 'Details' tab of the Inspector window

Ribbon Construct > Test Management > Tests > <test class> > Right-click on test > Create
a Maintenance Defect from this test

Start > All Windows > Construct > Testing > <test class> > Right-click on test >
Create a Maintenance Defect from this test

Design > Element > Properties > General > Element Browser > Testing > <test
class> > Right-click on test > Create a Maintenance Defect from this Test

Keyboard Shortcuts Alt+2 > Testing : <test class> | Right-click on test | Create a Maintenance Defect
from this Test

Create a Maintenance Item from a Test

Step Action

1 The system immediately creates the Defect item and displays a confirmation message box.

Click on the OK button to clear the message.

2 Open the Defects window (the 'Construct > Change Management > Defects > Show Defects Window'
ribbon option).

The window shows a Defect item having the same name as the test.

3 Double-click on the Defect item to open it in the 'Defect details' dialog, and edit the item as necessary -
you might provide values for the 'Reported By', 'Status' and 'Priority' fields.
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Move Tests Between Elements

A test you define for one element might be usefully moved to another if, for example, you are moving your model
through stages in a lifecycle or, indeed, modeling a lifecycle. It is possible to simply drag a test of any class and type
from either the appropriate tab of the Test Cases window or the 'Details' tab of the Inspector window, onto a different
element on a diagram.

Access

From the Browser window, open the diagram containing the target element, then click on the element from which to
move the tests. It is convenient to have both source and target elements on the same diagram, but it is possible to select
the source element in the Browser window or on a different open diagram.

It is also convenient to have compartments enabled on the target element, with the Testing (test scripts) compartment
selected, so that you can observe the addition of the moved test. (Right-click on the element and select 'Compartment
Visibility', then select the 'Testing' checkbox.)

Ribbon Start > Application > Design > Browser > Element - expand the 'Testing' category
or

Construct > Test Management > Tests | <Test class>

Keyboard Shortcuts Alt+2 | Testing > <test class> tab

Click on the source element on a diagram : T

Move the Test to the Target Element

Click on the test that you intend to move, and simply drag it onto the target element. The test name will display in the
'test scripts' compartment of that element. What you would observe might resemble this illustration.
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Import Test From Other Elements

If you have created useful tests in one element, you can import those tests into any other element through the Test Cases
window or 'Details' tab of the Inspector window, and so avoid having to duplicate the test information manually. You
open the Test Cases window for the empty target element and then select the source element that contains the tests to
import.

Access

Select target element, then:

Ribbon Construct > Test Management > Tests > <test class> | Right-click on test list |
Import Test from other Element (s)

Start > All Windows > Construct > Testing > <test class> > Right-click on test list |
Import Test from other Element(s)

Keyboard Shortcuts Alt+2 > Testing | Right-click on test list | Import Test from other Element(s) or

Alt+9 : Testing > <test class> > Right-click > Import Test from other Element(s)

Import a Test

The 'Import Element Tests' dialog displays.

Field/Button Action

Select element Click on the drop-down arrow and locate and select the source element.

This list identifies elements that have tests that can be imported.

Show related elements only Select this checkbox to restrict the list of selectable elements to those that are
related to the target element.

Limit selection to these
Object Types only

If you want to restrict the list of selectable elements to only those of specific types,
type in those element types in a comma-separated list.

Refresh Click on this button after changing any of the field values, to refresh the list of
available elements in the 'Select element' field.

Select items to import Lists the tests defined in the source element. Select the test(s) to import.

If you have not used the 'Select element' field, any tests listed are from the current
element to which this test record belongs. There is no purpose in importing these.

Import As Defaults to the test class of the Test you selected to populate from the other
element. If you need to change this, click on the drop-down arrow and select a
different test class from the list.

All Click on this button to select all tests listed in the 'Select items to import' field.

None Click on this button to clear the selection of tests listed in the 'Select items to
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import' field.

Import Click on this button to import the selected test(s).

Notes

In the Corporate, Unified and Ultimate Editions of Enterprise Architect, if security is enabled you must have·
'Manage Tests' permission to add, update and delete test records
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Import Scenario as Test

If you are creating a test for a scenario from either a single element or many elements in a Package, you do not have to
manually re-type the scenario details into the test record. You can generate the test into the 'Scenario Tests' class of one
element from one or more scenarios in any element in the model.

Within the Scenario Test record, the scenario description is copied to the 'Description' tab. If a scenario contains a
specification, its Action steps are also copied to the 'Description' tab under the heading 'Structured Specification'.

Access

Click on the element containing the test records, and use one of the methods identified here to display the 'Import
Scenario' dialog.

Ribbon Construct > Test Management > Tests > <test class> > right-click on test list >
Import Element Scenario(s)  or

Construct > Test Management > Tests > <test class> > right-click on test list >
Import Package Scenario(s)  or

Start > All Windows > Construct > Testing > <test class> > right-click on test list >
Import Element Scenario(s)

Start > All Windows > Construct > Testing > <test class> > right-click on test list >
Import Package Scenario(s)

Keyboard Shortcuts Alt+2 > Testing : right-click on test list | Import Element Scenario(s)  or

Alt+2 > Testing : right-click on test list | Import Package Scenario(s)

Import a Scenario from a Single Element

Field/Button Action

Select element If you are copying scenarios from a different element to the target element, click on
the drop-down arrow and select the source element. The list identifies elements that
have scenarios that can be imported.

Otherwise, leave this field blank.

Show related elements only Select this checkbox to restrict the list of selectable elements to those that are
related to the target element.

Limit selection to these
Object Types only

If you want to restrict the list of selectable elements to only those of specific types,
type in those element types in a comma-separated list.

Refresh Click on this button after changing any of the field values, to refresh the list of
available elements in the 'Select element' field drop-down.

Select items to import Lists the scenarios defined in the source element. Select the scenario(s) to import.

If you do not use the 'Select element' field, any scenarios listed are from the current
element to which this test record belongs.

If you have selected a different element, the scenarios come from that element.
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Import As Defaults to the test class of the Test you selected to populate from the scenario. If
you need to change this, click on the drop-down arrow and select a different test
class from the list.

All Click on this button to select all scenarios listed in the 'Select items to import' field.

None Click on this button to clear the selection of scenarios listed in the 'Select items to
import' field.

Import Click on this button to import the selected scenario(s).

Import Scenarios from the Elements in a Package

Field/Button Action

Limit selection to these
Object Types only

If you want to restrict the selected elements to only those of specific types, enter
those element types in a comma-separated list.

This version of the 'Import Scenario' dialog lists all scenarios against all elements in
the Package; it does not enable you to select a specific element, but does enable you
to filter the list of scenarios to those from specific types of element.

Refresh Click on this button after changing the 'Limit Selection...' field value, to refresh the
list of available elements in the 'Select items to import' field.

Select Items to import Lists the scenarios defined in the selected elements in the Package. Select the
scenario(s) to import.

All Click on this button to select all scenarios listed in the 'Select items to import' field.

Import As Defaults to the test class of the Test you selected to populate from the scenario. If
you need to change this, click on the drop-down arrow and select a different test
class from the list.

None Click on this button to clear the selection of scenarios listed in the 'Select items to
import' field.

Import Click on this button to import the scenarios from each element as Scenario tests.

Notes

In the Corporate, Unified and Ultimate Editions of Enterprise Architect, if security is enabled you must have·
'Manage Tests' permission to add, update and delete test records
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Import Requirement or Constraint as Test

If you are creating a test against an internal requirement or internal constraint of an element, you do not have to manually
re-type the details into the test record in the 'Test details' dialog. You can generate a testing record on the element from
the requirement or constraint.

The test record is generated into the Test Cases window under the currently-selected test class, and the requirement or
constraint description is copied to the 'Description' for the test record.

Access

Select an element, then use one of the methods outlined here to display the Test Cases window or 'Details' tab of the
Inspector window.

Ribbon Construct > Test Management > Tests > <test class> > Right-click on test list >
Import Element Constraint(s)    or   Import Element Requirement(s)

Start > All Windows > Construct > Testing > <test class> > Right-click on test list
> Import Element Constraint(s)   or   Import Element Requirement(s)

Design > Element > Properties > General > Element Browser > Testing > <test
class> > Right-click on test list > Import Element Constraint(s)   or   Import
Element Requirement(s)

Keyboard Shortcuts Alt+2 > Testing : <test class> | Right-click on test list | Import Element
Constraint(s)    or   Import Element Requirement(s)

Alt+9 : Testing > <test class> > Right-click > Import Element Constraint(s)   or
Import Element Requirement(s)

Import a Requirement or Constraint as a Test

Step Action

1 On the 'Import Constraint' or 'Import Requirements' dialog (the two dialogs are identical) review the list of
internal requirements or constraints in the selected element.

2 Click on one of the items to import as a Test, or press Ctrl+click on more than one to import several.

The 'Import As' field defaults to the test class of the Test into which you are importing the requirement or
constraint details. If you need to change this, click on the drop-down arrow and select a different test
class.

3 Click on the OK button.

Each item is added to the list of tests in the Test Cases window, under the appropriate <test-type>, as a
standard, 'Not Run' test.

Double-click on one item to open the 'Test details' dialog to edit the test details; thereafter, just click once
on the next test item to edit that in the 'Test details' dialog.

Notes
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In the Corporate, Unified and Ultimate Editions of Enterprise Architect, if security is enabled you must have·
'Manage Tests' permission to add, update and delete test records
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Test Documentation

After you have recorded a number of test scripts and results against elements in the model, you can output the
information as a report in Rich Text Format, using the 'Generate Test Documentation' dialog. You can select the types of
test to include or exclude in the report and whether to include child Packages, and enter the file location to which to
generate the report.

Click on the Generate button to produce the report.

You can also run a number of searches to show the results - where generated - of tests:

Not Run·
Not Checked·
Recently run·
Recently Passed·
Recently Failed·
Recently Deferred·
Run on recently modified elements·
Run in the last week·
Run in the last 30 days·

Access

Select a Package, then use the ribbon options:

Ribbon Construct > Testing > Outcomes > Report      (to display the 'Generate Test
Documentation' dialog)

Construct > Testing > Not Run

Construct > Testing > Not Checked

Construct > Testing > Outcomes > <report type>
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Changes, Defects & Issues

In the course of your team's work on a model, changes and issues can arise at a number of levels, for problems that apply
system-wide through areas of the model and down to within a specific element. A Change, very broadly, defines an
addition or alteration to a requirement, whilst an Issue identifies either a failure to meet a requirement, or a risk in
meeting the requirement.

There are two mechanisms that can be used to identify a change or issue, and the work required to resolve it:

Change and Issue (or Defect) elements - structured comments that identify a problem at system-level, although they·
can also be attached to a specific element from which a problem arises; both types of element can be linked by
relationships such as Association, Dependency and Realize to one or more other elements that have to be reviewed,
and for complex problems can form hierarchies or groups

Maintenance items - properties raised against a specific element and recorded for that element in the Maintenance·
window; these provide a distinction between Defects (a failure to meet a requirement) and Issues (a risk factor that
might affect satisfying the requirement) and also include Tasks, which record work items associated with the
element
Maintenance items are very specific, but if an item begins to have a wider impact on other elements or the system in
general, you can translate that item into a Change, Issue, or any other type of element that best identifies the problem
and its solution

Maintenance items are defects, changes, issues, tasks, features and documents that apply at the model element level.
They are properties of individual model elements that can be used to record and capture problems, changes, issues and
tasks as they arise, and document the solution and associated details.

Maintenance Tasks

Task Area Detail

Maintenance Items -
Element-level

You create maintenance items in the Maintenance window. Typically you create:

A defect to record a failure to meet a requirement for the current model·
element

A change to record a change in requirement for the current model element·
An issue to record a risk factor that might affect the project being recorded for·
the current model element

A task to record work in progress and work outstanding for the current model·
element

A feature to record a feature in requirement for the current model element·
A document to record supporting documentation such as Help, release notes·
and user comments

Creating and Editing
Maintenance Items

Tasks that you might perform when working with maintenance items include:

Moving or copying maintenance items between maintenance types·
Generating new items of one type from an item of a different type·
Creating elements from maintenance items·
Showing maintenance items on elements in a diagram·
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Adding a maintenance item directly to an element via in-place editing·
Generating a report on the status of maintenance items of specific types or all·
types

Maintenance -
System-level

To represent changes, defects and issues that apply to the model you can create
Change and Issue elements with - if necessary - subordinate structures.

To represent issues and tasks that apply to the progress of the project as a whole
and that are not related to model structures, you create Project Issue and Project
Task records in Project Management.
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Maintenance Overview

If your work in managing a project identifies issues, defects or required changes in the model rather than internal to a
single element, you can represent these using Change, Issue or Defect elements as structured comments with which you
can track and manage the problems.

A Change element corresponds to a change in requirements for the current system·
An Issue element corresponds to a failure to match the requirements for the current system due to newly arisen·
organizational or legal factors such as staffing problems, changes in laws or guidelines, or business unit restructuring

A Defect element corresponds to a failure to match the requirements for the current system due to a flaw in the·
model, system or process, such as a missing element or module, or no inclusion of a necessary actor

You can also define any specific work to be done in researching or resolving the problem using Task elements, and
assign resources to these or directly to the Change, Issue or Defect elements internally, in Resource Allocation, or
externally as Actors.

The use of maintenance elements provides a broad scope for managing changes, defects and issues, providing the facility
to fully define the problem and its resolution with Linked Documents, both internal and external Notes, and Composite
Structure diagrams including Interaction and Activity diagrams.

You can create Change, Defect and Issue elements in various UML diagrams (especially Maintenance diagrams) and
connect them using Realization, Dependency, Aggregation and other relationships to show what model elements each
problem affects and how each is resolved. Within the element 'Properties' dialog for Changes, Defects and Issues you can
identify the problem as the element name and record relevant management details, such as owner and dates.

A useful tool in managing problems and changes is the Relationship Matrix, in which you might - for example - link staff
(Actors) through Realization connectors to Issues. Each highlighted square in the Matrix indicates the responsibility of a
staff member to work on or correct a named Issue.
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Issues

In your modeling, issues concerning the development of the system or model might arise; more formally, you encounter
a failure to meet defined requirements for the current system. You can represent this failure using an Issue element,
which is a structured comment containing information about the issue and the measures taken to manage it. The element
is rendered as shown.

You can link Issues to model elements that are responsible for the issue, using Realize connectors. You can also create a
hierarchy of related Issues using Aggregation connectors. Each Issue element has a status band at the left end, which is
color coded to visually represent the value of the 'Status' field in the element properties. The element has an identifying 'I'
in the top right corner, which you can hide if you prefer not to show it.

You can create Issue elements on most types of diagram, although the Maintenance diagram is specifically designed for
displaying and managing them. You can also create your own issue-management diagram as a Custom diagram. You can
add the Issue (and other) elements to the diagram from the Diagram Toolbox, or directly to a Package in the Browser
window.

Add an Issue to the model using the Toolbox

Step Action

1 Open the Maintenance or Custom (or other) diagram to define the problem.

2 From the 'Custom' pages or 'Common' page of the Diagram Toolbox, drag the Issue icon onto the diagram.

3 If the Properties window is not already displayed, press Ctrl+2 on the element. Record the name and
details of the Issue, in the Properties window.

Add an Issue to the model using the 'New Element' dialog

Step Action

1 Identify the Package in which to record the Issue, in the Browser window.

Right-click on this Package and select the 'Add Element' option.

2 Complete the fields on the 'New Element' dialog - in the 'Type' field, click on the drop-down arrow and
select 'Issue'.

3 When you have created the element, record the name and details of the Issue, in the Properties window.

Notes
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To toggle display of the letter 'I' in the top right corner of the element, select or deselect the 'Show stereotype icon·
for requirements' checkbox on the 'Preferences' dialog, 'Objects' page
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Defects

In your modeling, problems in the development of the system or model might arise; more formally, you encounter an
obstacle to meeting defined requirements for the current system, through a defect of the model, system or process. You
can represent this failure using a Defect element, which is a structured comment containing information about the defect
and the measures taken to manage it. The element is rendered as shown.

You can link Defects to model elements that are responsible for the problem, using Realize connectors. You can also
create a hierarchy of related Defects using Aggregation connectors. Each Defect element has a status band at the left end,
which is color coded to visually represent the value of the 'Status' field in the element properties. The element has an
identifying 'D' in the top right corner, which you can hide if you prefer not to show it.

You can create Defect elements on most types of diagram, although the Maintenance diagram is specifically designed for
displaying and managing them. You can also create your own defect-management diagram as a Custom diagram. You
can add the Defect (and other) elements to the diagram from the Diagram Toolbox, or directly to a Package in the
Browser window.

Add a Defect to the model using the Toolbox

Step Action

1 Open the Maintenance or Custom (or other) diagram to define the problem.

2 From the 'Custom' pages of the Diagram Toolbox, drag the Defect icon onto the diagram.

3 If the Properties window is not already displayed, press Ctrl+2. Record the name and details of the Defect,
in the Properties window.

Add a Defect to the model using the 'New Element' dialog

Step Action

1 Identify the Package in which to record the Defect, in the Browser window.

Right-click on this Package and select the 'Add Element' option.

2 Complete the fields on the 'New Element' dialog - in the 'Type' field, click on the drop-down arrow and
select 'Defect'.

3 When you have created the element, record the name and details of the Defect, in the Properties window.

Notes

To toggle display of the letter 'D' in the top right corner of the element, select or deselect the 'Show stereotype icon·
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for requirements' checkbox on the 'Preferences' dialog, 'Objects' page
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Changes

In your modeling it might become necessary to change an aspect of the system or model; more formally, you need to
request and manage a change in the defined requirements for the current system. You can represent this change request
using a Change element, which is a structured comment containing information about the change and the measures taken
to manage it. The element is rendered as shown.

You can link Changes to model elements that are impacted by the change, using Realize connectors. You can also create
a hierarchy of related Changes using Aggregation connectors. Each Change element has a status band at the left end,
which is color coded to visually represent the value of the Status field in the element properties. The element has an
identifying C in the top right corner, which you can hide if you prefer not to show it.

You can create Change elements on most types of diagram, although the Maintenance diagram is specifically designed
for displaying and managing them. You can also create your own change-management diagram as a Custom diagram.
You can add the Change (and other) elements to the diagram from the Diagram Toolbox, or directly to a Package in the
Browser window.

Add a Change to the model using the Toolbox

Step Action

1 Open the Maintenance or Custom (or other) diagram in which to define the problem.

2 From the 'Custom' or 'Common' pages of the Diagram Toolbox, drag the Change icon onto the diagram.

3 If the Properties window is not already displayed, press Ctrl+2. Record the name and details of the
Change, in the Properties window.

Add a Change to the model using the 'New Element' dialog

Step Action

1 Identify the Package in which to record the change, in the Browser window.

Right-click on this Package and select the 'Add Element' option.

2 Complete the fields on the 'New Element' dialog - in the 'Type' field, click on the drop-down arrow and
select 'Change'.

3 When you have created the element, record the name and details of the Change, in the Properties window.

Notes
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To toggle display of the letter 'C' in the top right corner of the element, select or deselect the 'Show stereotype icon·
for requirements' checkbox on the 'Preferences' dialog, 'Objects' page
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Maintenance Diagram

A Maintenance diagram is a type of Custom diagram, an extension to the UML model. It is a change management tool,
used to record:

Requests for change to the model structure or project process, as Change elements·
Issues that impact the development and progress of the project, as Issue elements, and·
Groups of tests that can be applied to many elements rather than specific elements, as Test Cases·

Each Change, Issue or Test Case element can link to other model elements in the project, to illustrate how they
contribute to or are impacted by the item, and how they must be modified, removed, applied or extended to provide a
solution. This includes identifying areas of work, represented by Task elements, to which resources can be allocated as
either external (Actor) elements or internal properties (resource allocation).

You generate Maintenance diagram elements and connectors from the 'Maintenance' pages of the Diagram Toolbox,
although you might also make frequent use of connectors from other pages.

Example Diagram

Example Maintenance Diagram

 

Maintenance Diagram Element Toolbox Icons

Icon Description

A Package is a namespace as well as an element that can be contained in other
Packages' namespaces.

Issue elements represent a failure to meet defined requirements for the current
system.

This element represents a change in the defined requirements for the current system
and can be used to request and manage the change process.

A Task element represents a task that must be performed in relation to an element.

A Test Case is a stereotyped Use Case element. You might use it to extend the
facilities of the Test Cases window, by applying element properties and capabilities
to the tests of a feature represented by another element or - more appropriately - set
of elements.

An Entity is a stereotyped Object that models a store or persistence mechanism that
captures the information or knowledge in a system.

A Test element represents a step in the Basic, Alternate and Exception Paths of a
Scenario created in a Use Case or other element.

The defect element represents an obstacle to meeting defined requirements for the
current system.

The Review element acts as a focus for performing a formal review of one or more
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model elements. It defines the parameters of the review.

Maintenance Diagram Connector Toolbox Icons

Icon Description

An Aggregation connector is a type of association that shows that an element
contains or is composed of other elements.

(c) Sparx Systems 2024 Page 145 of 300 Created with Enterprise Architect



Project Build & Deploy 16 October, 2024

Example Maintenance Diagram

Very simply, this example diagram depicts a request for a change (C) to a process represented by an Activity element
(Transfer WH Receipts to Active Stock). The change currently involves the Task (T) of reviewing the interface between
two recording systems, one of which could be affected by an Issue (I) concerning an external stocktaking system.
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Working with Maintenance Items

Creating, viewing and modifying the Maintenance items - changes, issues, defects, tasks, feature and documents -
associated with a particular model element is quick and convenient, using the  Maintenance window. If the Maintenance
window is open, when you select an element in a diagram or in the Browser window, the appropriate maintenance items
for that element are immediately listed in the window, and you can select them there to modify. The Maintenance
window provides several facilities for managing the maintenance items.

You can include the maintenance items in the document and web reports generated on your model. The 'Document Setup'
dialog has checkboxes to show or hide element maintenance items.

Access

Click on an element in the Browser window or diagram and select the appropriate option.

Ribbon Construct > Change Management and:

> Features > Show Features Window·
> Changes > Show Changes Window·
> Documents > Show Documents Window·
> Issues > Show Issues Window·
> Tasks > Show Tasks Window·
> Defects > Show Defects Window·

Keyboard Shortcuts Ctrl+8 | <Required tab>

Select any of the items on a diagram or the 'Details' tab of the Inspector window,
then use Shift+Enter

Facilities

Facility Detail

Maintenance Item Types The six types of Maintenance Item you can create records for are each listed on a
separate tab of the Maintenance window:

Defects - each recording a failure to meet a requirement for the current model·
element

Changes - each recording a change in requirement for the current model·
element

Issues - each recording a risk factor that might affect the project, associated·
with the current model element

Tasks - each recording work in progress and work outstanding for the current·
model element

Features - each recording a feature in requirement for the current model·
element

Documents - each recording the supporting documentation such as Help,·
release notes and user comments

There is also a 'Maintenance Overview' tab that displays a read-only list of all the
Maintenance items on the element, grouped by type. If you double-click on an item
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in this list, the appropriate tab displays with the item highlighted.

Adding New Items To add new items, right-click on the main panel of the Maintenance window and
select the 'Add New' option. The appropriate fields for the item type are displayed
on the '<Maintenance Item Type> details for <element>' dialog, where you create
the item.

The fields you complete for each type of maintenance item are very similar.

Applying Automatic
Naming/Numbering

On the '<Maintenance Item Type> details for <element>' dialog, you can apply an
automatic naming/numbering convention that you have previously defined, to each
new item record. To do this, simply click on the Auto button next to the 'Detail'
field.

If you already have some text in the 'Detail' field, it is over-written by the
auto-counter text.

Details tab You can also use the 'Details' tab of the Inspector window to create, select and
display specific items on the '<Maintenance Item Type> details for <element>'
dialog. Select the 'Start > Application > Design > Inspector' ribbon option to open
the Inspector window, select the 'Details' tab and the 'Maintenance > <maintenance
type>' list, and either:

Double-click on an existing item to show and - if necessary - change the·
details, or

Right-click on the appropriate '<maintenance type>' folder name and select the·
'New <item type>' option to create a new item

Move items between
elements

You might have a maintenance item on one element that can be usefully moved on
to another element. You can move the item very simply, by dragging it from the
Maintenance window or 'Details' tab onto the target element on a diagram.

Notes

Columns in the item list can be reorganized, added, removed, grouped, filtered and sorted using the options provided·
in the List Header facilities
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Create Maintenance Items

When you need to create a new maintenance record for an element, you can do so by selecting the 'Add New' context
menu option in the Maintenance window.

Access

Use one of the access paths outlined here to display first the Maintenance window at the appropriate tab for the type of
maintenance item to create, then the '<Maintenance Item Type> details for <element type>' dialog for that item type.

Ribbon Construct > Change Management > Features > Show Features Window >
right-click | Add New

Construct > Change Management > Changes > Show Changes Window >
right-click | Add New

Construct > Change Management > Documents > Show Documents Window >
right-click | Add New

Construct > Change Management > Issues > Show Issues Window > right-click |
Add New

Construct > Change Management > Defects > Show Defects Window > right-click |
Add New

Construct > Change Management > Tasks > Show Tasks Window > right-click |
Add New

Keyboard Shortcuts Ctrl+8 > <required tab> | Right-click | Add New

Select any of the Maintenance items on a diagram or on the 'Details' tab of the
Inspector window, then press Shift+Enter

Create Maintenance items on the Maintenance dialog

Option Action

Detail Type the name or a short description of the feature, change, defect, task, issue or
document.

Auto As an alternative to typing in the name, click on this button to insert predefined
auto-counter text.

If you already have some text in the 'Detail' field, it is over-written by the
auto-counter text.

Reported by / Requested by
/ Raised by

Click on the drop-down arrow and select the user name of the person who initiated
the maintenance item.

Alternatively, start typing in the user name until the auto-complete facility fills in
the rest of the name.

Date Defaults to today's date as the date on which the maintenance item was raised; if
necessary, change this by clicking on the drop-down arrow and selecting a different
date.
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Status Click on the drop-down arrow and select the appropriate status of the maintenance
item, such as 'New' or 'Complete'.

Priority Click on the drop-down arrow and select the priority for completing the
maintenance item.

Resolved by / Implemented
by / Completed by

Click on the drop-down arrow and select the user name of the person who
completed and closed the maintenance item.

Alternatively, start typing in the user name until the auto-complete facility fills in
the rest of the name.

Date Select the date on which the maintenance item was completed; click on the
checkbox to select today's date or, if necessary, change the field by clicking on the
drop-down arrow and selecting a different date.

Version / ID Displays the version number assigned to this defect, change, task, issue or
document.

If you want to refer to this maintenance item from another element or document,
click on the Copy button to copy the ID to the clipboard, from where it can be
pasted into the other text.

Description Type a longer description of the maintenance item; you can format the text using
the Notes toolbar at the top of the field.  The text you enter here is also displayed
and can be edited in the Notes window.

History Over time, enter any notes on the actions concerning this maintenance item; you
can format the text using the Notes toolbar at the top of the field. The text you enter
here is also displayed and can be edited in the Notes window.

Apply Click on this button to save the record data and keep the dialog open.

OK Click on this button to save the record data and close the dialog.

Close Click on this button to discard the unsaved record data and close the dialog.

New Click on this button to clear the dialog fields ready to define a new maintenance
item.

left chevron/right chevron If there are existing items, click on these buttons to display the details of the
previous item or next item in the sequence.

Create Maintenance Items on the Maintenance Window

An alternative method of creating simple Maintenance items is to display the Maintenance window as indicated in the
Access section, but complete the fields on the window rather than go on to display the 'Maintenance' dialog. In this way
you can quickly create a set of basic Maintenance items at once and then add more detail to individual items as necessary
at a later time.

To create an item:

Display the appropriate tab for the type of item.1.

Double click on the Add new <item type> text and type in the name of the item.2.
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Tab to the 'Status' field; the 'Status', 'Priority' and 'Date Reported' fields display default values. If these are acceptable3.
to you, the Maintenance item is created and available for future editing.

If you want to change the field values, click once on the field and once on the drop-down arrow, and select the4.
appropriate value.

Notes

To edit an item, double-click on it on the Maintenance window; the item details display in the '<Maintenance Item·
Type> details for <element type>' dialog for editing

To delete an item, right-click on it on the Maintenance window and select the 'Delete' option; in response to the·
confirmation prompt, click on the Yes button

A further possibility for editing and deleting items is to right-click on items in the 'Details' tab of the Inspector·
window and select menu options there; select the 'Start > All Windows > Design' ribbon option and then 'Explore >
Inspector > Details > Maintenance > <maintenance type>'

To change the element for which to create or edit maintenance items, click on the new element on a diagram or in·
the 'Project' tab of the Browser window
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Properties Window for Maintenance Items

When the Properties window is open, it displays the properties of the selected object or assigned item, including a
Maintenance record for an element. These items include Changes, Issues, Defects, Tasks, Features and Documents.

You might select the item in the appropriate tab of the Maintenance window, the maintenance compartment of an
element on a diagram, or the 'Details' tab of the Inspector window.

The Properties window identifies the type of item just under the toolbar, and shows the current values for the:

Item name·
User who raised the item·
Date the item was raised·
Status·
User who implemented or resolved the item·
Date that action was completed·
Priority of the item·
Version of the item·

You can change the value for each of these fields (except for the 'Name' and 'Version'  fields), by clicking on the
drop-down arrow and selecting a new value. For the user name fields, you can also start typing in the name until the
auto-complete facility fills in the rest of the name.

For the 'Name' field, you can either overtype the item name or click on the  icon and apply any autonaming
convention you have configured for maintenance items. If you click on the icon for the 'Version/ID' field, that value is
copied to the clipboard to be pasted into a discussion or document.

The toolbar options operate on the parent element for the maintenance item. Any changes you make are automatically
saved and displayed elsewhere when you click off the field.
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Move or Copy Maintenance Items Between Types

After you define a maintenance item of one type (Defect, Change, Issue, Document, Feature or Task), you might decide
that the item either is better suited to another type or forms a good template for items of other types. If so, you can either
move or copy the item to the other types.

Access

Display the Maintenance window using one of the methods outlined here.

In the Maintenance window:

Right-click on a maintenance item | Move to | <item type> or·
Right-click on a maintenance item | Copy to | <item type>·

Ribbon Construct > Change Management > Features > Show Features Window

Construct > Change Management > Changes > Show Changes Window

Construct > Change Management > Documents > Show Documents Window

Construct > Change Management > Issues > Show Issues Window

Construct > Change Management > Tasks > Show Tasks Window

Construct > Change Management > Defects > Show Defects Window

Keyboard Shortcuts Ctrl+8 > <required tab>

Move or copy a maintenance item

Step Action

1 Click on the appropriate option - 'Move to' or 'Copy to'.

A list of maintenance item types displays.

2 Click on the item type to which to move or copy the item.

A confirmatory prompt displays.

3 Click on the Yes button to confirm the move or copy.

4 Switch to the appropriate tab of the Maintenance window to ensure that the item has been added.

5 If you are copying the item to more than one other item type, repeat steps 1 to 4 for the next item type to
copy to.
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Show Maintenance Items in Diagram

When you have created a maintenance item, it is useful to make the record visible on its parent element. You can do this
by displaying the record within a maintenance compartment on the element as it displays in a diagram. Any element that
is capable of displaying a compartment, and that has maintenance items assigned to it, can show the items in a diagram.

Show maintenance items in a diagram

Step Action

1 Open a diagram containing the element with the attached maintenance items.

2 Double-click on the diagram background to display the diagram 'Properties' dialog.

Click on the 'Elements' tab.

3 In the 'Show Compartments' panel, select the 'Maintenance' checkbox.

4 Click on the OK button to save the setting.

Each maintenance item now appears in the maintenance compartment of the diagram element. Items of
each type are grouped together so that, for example, all Issues on the element are grouped under the
heading 'Issue', and all Tasks on the element are grouped under the heading 'Task'.

If you double-click on a maintenance item, the '<maintenance item type> for <element>' dialog displays
and you can edit the details of the item.

Maintenance Compartment - Example
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Move Maintenance Items Between Elements

A maintenance item you define for one element might be usefully moved to another if, for example, you are moving your
model through stages in a lifecycle or, indeed, modeling a lifecycle. It is possible to simply drag a maintenance item of
any type from either the appropriate tab of the Maintenance window or the 'Details' tab of the Inspector window, onto a
different element on a diagram.

Access

From the Browser window, open the diagram containing the target element, then click on the element from which to
move the tests. It is convenient to have both source and target elements on the same diagram, but it is possible to select
the source element in the Browser window or on a different open diagram.

It is also convenient to have compartments enabled on the target element, with the Maintenance compartment selected,
so that you can observe the addition of the moved item. (Right-click on the element and select 'Compartment Visibility',
then select the 'Maintenance' checkbox.)

Ribbon Start > Application > Design > Browser > Element - expand the 'Maintenance'
category  or

Construct > Change Management > <item type> | Show <item type> Window

Keyboard Shortcuts Alt+2 | Maintenance > <item type> tab

Click on the source element on a diagram : T

Move the Item to the Target Element

Click on the maintenance item that you intend to move, and simply drag it onto the target element. The item name will
display in the 'maintenance' compartment of that element. What you would observe might resemble this illustration.
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Create Elements From Maintenance Item

A maintenance item identifies a defect, change, issue, task, feature or document concerning an element. The maintenance
item could itself be represented by an element if it has wider implications for the project or identifies - for example - an
actor, activity or action that requires further definition.

You can create one or more elements from any maintenance item, using the Maintenance window. The new element is
connected to the maintenance item's parent element by a Dependency connector. The original maintenance item remains
unchanged as a characteristic of its parent element.

Access

Use one of the methods outlined here to display the Maintenance window appropriate to the maintenance item from
which to create a model element.

In the Maintenance window: Right-click on the maintenance item > Create as New Element

The 'New Element' dialog displays.

Ribbon Construct > Change Management > Features > Show Features Window

Construct > Change Management > Changes > Show Changes Window

Construct > Change Management > Documents > Show Documents Window

Construct > Change Management > Issues > Show Issues Window

Construct > Change Management > Tasks > Show Tasks Window

Construct > Change Management > Defects > Show Defects Window

Keyboard Shortcuts Ctrl+8 > <required tab for item type>

Select any of the Maintenance items on a diagram or in the 'Details' tab of the
Inspector window, then press Shift+Enter

Create an element from a maintenance item

On the 'New Element' dialog, complete the fields.

Field/Option Action

Toolset The two 'Toolset' fields default to the last-set domain and Perspective. If these are
not appropriate to this task, click on the drop-down arrows and select the correct
domain and Perspective.

Name The 'Name' field defaults to the name of the Maintenance item. If necessary you can
overtype it with a different name, or click on the Auto button to apply a name from
your auto naming and numbering system.

Type Click on the drop-down arrow and select the required element type; you might
create:

An Issue element for an Issue maintenance item·
A Defect element for a Defect maintenance item·
A Change element for a Change or Feature maintenance item, or·
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A Task for a Task maintenance item·
The types are filtered by the Toolset you have selected; if the element type you
require is not listed, you can change the Toolset to provide that type. You can,
therefore, create a wide range of other element types should any of these be more
appropriate.

Stereotype If you require the element type you have selected to be refined by a stereotype,
click on the drop-down arrow and select the stereotype name. The stereotypes are
listed in alphabetical order.

Add Element to Diagram This option is enabled when you have a diagram open. If you want the new element
to be added to a diagram, have that diagram open and select this checkbox.

Save Click on this button to add the new element to the Browser window and, if
appropriate, the diagram.
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Construct History Window

The Construct History window provides a summary of all project management transactions over a given period, with
separate tabs for Tests, Resource Allocations and Maintenance objects (Changes, Features, Issues, Defects, Tasks and
Documents). You can set the period for which the window lists the transactions, and display details of each record in the
appropriate item Properties dialog (in which the record is defined).

Access

Ribbon Start > All Windows > Construct > Resources > Resource - History

Start > All Windows > Construct > Testing > Tests - History

Start > All Windows > Construct > Change > Maintenance - History

Context Menu Options

Right-click on an entry or on the window background to display the options for working on the listed item or on the
display of items in the Construct History window.

You can also adjust the number and position of the columns displayed, and filter the information shown, using the List
Header facilities, as described in the List Header Help topic.

Option Description

Properties For a selected resource, test or maintenance item, displays the properties of that
item in the appropriate create/edit dialog for the item type.

Double-clicking on the item has the same result.

Find Parent in Browser For a selected resource, test or maintenance item, locate and highlight - in the
Browser window - the element to which the item has been assigned.

Find Parent in Diagram For a selected resource, test or maintenance item, locate and highlight - in the
parent diagram - the element to which the item has been assigned. If the element is
present in more than one diagram, the 'Element Usage' dialog displays, from which
you select the diagram to open.

Visible Timeframe -
Resources

Click anywhere in the window and select this option to display a submenu. Select
one of these options:

'Today' to list resources with today as the task Start Date or End Date·
'Today +X' to list resources with a task Start Date or End Date of today or up to·
3, 7 or 30 days after today

'Today -X' to list resources with a task Start Date or End Date of today or up to·
3, 7 or 30 days prior to today

'Today +/-X' to list resources with a task Start Date or End Date of today or up·
to 3, 7 or 30 days either side of  today; for example,
'Today +/-30' lists resources with a task Start Date or End Date within the
61-day period between 30 days prior to today and 30 days after today

Visible Timeframe - Tests Click anywhere in the window and select this option to display a submenu. Select
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one of these options:

'Today' to list tests with today as the Run Date·
'Today X Days' to list tests with a Run Date of today or up to 7, 30 or 90 days·
prior to today

Visible Timeframe -
Maintenance

Click anywhere in the window and select this option to display a submenu. Select
one of these options:

'Today' to list maintenance items with today as the Reported Date or Resolved·
Date

'Today X Days' to list maintenance items with the Reported Date or Resolved·
Date of today or up to 7, 30 or 90 days prior to today

Check for Update Every Click anywhere in the window and select this option to display a submenu, then
select 'Minute', '2 minutes', '5 minutes' or '10 minutes' to automatically refresh the
list of items at that interval and display any new items that now match the selection
options.

Refresh Click anywhere in the window and select this option to manually refresh the display
immediately, to display any new items that now match the selection options.

Set This Tab as Default Select this option to set the Construct History window at the current tab to
automatically redisplay when you log back in to the model in a new work session.
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The Construct View

The Construct View is an aid to Project Management, helping you to quickly review the resources and maintenance
items of the elements in any Package (including a View, but not a Root node) or its diagrams in the model.  You can
filter the view to show resources, or a single category or all categories of Maintenance item; that is:

Features·
Changes·
Issues·
Defects·
Tasks and/or·
Documents·

You can also manipulate what data to show for each item, using the 'Field Chooser' dialog and the Filter Bar. (See the
List Header Help topic.)

As you select individual items in the View, they become the focus of various Enterprise Architect windows such as the
Notes window, 'Details' tab of the Inspector window, and the Properties window.

Access

Ribbon Select an open diagram in the Browser window or right click on the diagram
background, then Design > Diagram > Views > Construct View

Context Menu In the 'Project' tab of the Browser window, right-click on the View or Package |
Open Package in | Construct View

In a diagram, right-click on the diagram background | Switch View | Switch to
Construct View

Other Right-click on the diagram tab for the diagram | Switch to Construct View

Context Menu Facilities

To select and display the information in the Construct View, you select options on the View's context menu. Right-click
anywhere on the View display.

Option Description

Load Resources Select this option to display the status and activity details of the resources assigned
to each element in the Package or on the diagram. This option is mutually exclusive
with 'Load Maintenance'.

Load Maintenance Select this option to display the details of either all Maintenance items on the
elements in the Package or diagram, or all those of a particular type - Features,
Changes, Defects, Issues, Tasks or Documents.  This option is mutually exclusive
with 'Load Resources'.

Refresh Select this option to update the display after changes have been made, to ensure that
they are reflected in the data fields for every view, dialog and window as well as
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the Construct View.

Clear Window Select this option to remove all data from the window.

Collapse All / Expand All The display initially shows the data in an expanded hierarchy of elements, child
elements and maintenance items or resources. Select the 'Collapse All' option to
show just the top-level elements with no data, and select the 'Expand All' option to
reveal the full hierarchy again.

Display as flat list Select this option to display only those elements that have resources or maintenance
items, with those items. The elements are listed in alphabetical order at the same
level, regardless of where they occur in the model hierarchy.
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The Construction Diagram

A Construction diagram is a graphical version of the 'Details' tab of the Inspector window. It shows the assigned
characteristics and features of the selected element, where these features have been created. Each type of feature is
shown in a separate element compartment.

To access a Construction diagram for an element, either:

In a diagram, right-click on the element | New Child Diagram | Construction Diagram, or·
In the 'Project' or 'Context' tab of the Browser window, right-click on the element | Add | Construction Diagram·

To create a new Construction diagram for multiple elements:

Select a Package in the Browser·
Select 'Add Diagram' from the Browser context menu·
Set the Perspective to 'ALL Perspectives'·
Select 'Extended' in the 'Select From' pane·
Select 'Construction' in the 'Diagram Types' pane.·

The Construction diagram for the element displays a 'C' in the bottom right corner of the element, indicating that it is the
Construction rendition of the element. The list of potential properties displayed in compartments on an element include:

Tags·
Requirements·
Constraints·
Testing·
Maintenance·
Discussions·
Reviews·
Resources·
Projects for Decisions, Events, Issues and Tasks·
Notes·
Package Contents·
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The visibility of compartments is dependent on there being detail in the specific features.

The possible compartments shown on the element are user-selectable from a range of element compartments. To alter
this;

Click on the diagram (or press F5)·
In the Properties window, select 'Elements'·
Tick the options in the 'Show Compartments' group.·

An example of a Construction diagram with multiple elements.

Note that an Actor element defaults to the Rectangular Notation on a Construction diagram.

(c) Sparx Systems 2024 Page 165 of 300 Created with Enterprise Architect



Project Build & Deploy 16 October, 2024

Project Issues

You can record and review issues - events, occurrences and situations that impact on project development and delivery -
against the current project using the Project Issues view  and its 'Issue Detail' dialog . For each Issue, you record the
description, date, owner and status. You can also generate a document report on the issue items.

Access

Ribbon Construct > Project Management > Issues-Tasks > Project Issues

Operations

Operation

Add, delete and modify Issues using the 'Issue Details' dialog.

Generate and view a rich text format report of your issue list

Notes

You can transport these issue definitions between models, using the 'Settings > Model > Transfer > Export·
Reference Data' and 'Import Reference Data' ribbon options

To print out the currently displayed items, select the 'Print List' context menu option·
You can re-organize the display of the listed tasks using the List Header facilities for reported information·
In the Corporate, Unified and Ultimate Editions of Enterprise Architect, if security is enabled you must have·
'Manage Issues' permission to update and delete Issues records
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Add, Delete and Modify Issues

You can maintain project issue records using the 'Issue Detail' dialog from the Project Issues view.

Access

Ribbon Construct > Project Management > Issues-Tasks > Project Issues

Maintain Project Issues

Step Action

1 If creating a new issue, double-click in a blank area to display the 'Issue Detail' dialog and complete the
blank fields.

If editing an existing item, double-click on the item to display the 'Issue Detail' dialog and edit the fields.

2 Enter or update these issue details, selecting a value from the field's drop-down list where appropriate:

The issue name·
Automatic naming - if you have set up automatic naming conventions, click on the Auto button to·
insert the predefined element name and counter text; if you already have some text in the 'Name'
field, it is over-written by the automatic naming text

The issue priority·
The date the issue was raised·
The issue status·
The issue owner·
A description of the issue·
The date on which the issue was resolved (select the checkbox to activate the date)·
The name of the person who resolved the issue·
Any comments on the resolution·

3 Click on the Apply button.

4 If the issue is closed (and all the 'Resolution' fields are completed), click on the Close Issue button.

5 To create another entry click on the New button or, to close, click on the OK button.

6 To delete an issue in the Project Issue view, right-click on the entry and select the 'Delete' option, then
click on the Yes button on the confirmation prompt.

Notes
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You can filter the list of issues by status, to show all issues or just Open, Closed or Under Review issues, using the·
'Set term filter' context menu option
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Report From Project Issues View

You can generate a document report on your project issue records from the Project Issue view.

Access

Ribbon Construct > Project Management> Issues-Tasks > Project Issues > Right-click on
Issues list > Create Report

The 'Save As' dialog displays.

Generate your project issues report

Step Action

1 Browse for and select the appropriate file location.

In the 'File name' field, type the file name for the report.

2 Click on the Save button.

A status message displays when the report has been generated.

3 Click on the OK button and then on the View RTF button.

The report displays in your default viewer.
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Report Output Sample

This is an example of the output of an Issues report.
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Project Tasks

The  Project Tasks view provides a convenient 'To Do' list of major project work items that are not recorded elsewhere. It
can be used to track events such as requests or corrections.

Access

Ribbon Construct > Project Management > Issues-Tasks > Project Tasks

Notes

Right-click on the list to view the context menu, and select to add, modify or delete tasks, or to set a status filter·
You can re-organize the display of the listed tasks using the List Header facilities for reported information·
To print out the currently displayed items, select the 'Print List' context menu option·
You can transport task definitions between models using the 'Settings > Model > Transfer > Export Reference Data'·
and 'Import Reference Data' options

You can add or work on an item in the Project Tasks view by right-clicking (context menu) or double-clicking on·
the blank or completed item line

The Project Tasks view context menu has options for filtering tasks and issues by status; you can also re-arrange the·
sort-order by clicking in the title bar of the column that the items are to be indexed on
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Add, Modify and Delete Tasks

To add, edit and delete project tasks you can work in either the Project Tasks view, or the Project Calendar.

Access

Ribbon Construct > Project Management > Issues - Tasks > Project Tasks

Start > Collaborate > Calendar > Project Tasks mode

Maintain Tasks

Step Action

1 If creating a new task:

Double-click in a blank area of the Project Tasks view, or on a cell of the Calendar·
If editing an existing item:

Double-click on the item on the Project Tasks view or Calendar·
The 'Task Detail' dialog displays.

2 Enter or update these details of the task, selecting a value from the field's drop-down list where
appropriate:

The task name·
Automatic naming - if you have set up automatic naming conventions, click on the Auto button to·
insert the predefined element name and counter text; if you already have some text in the 'Name'
field, it is over-written by the automatic naming text

The task type·
The task owner·
The expected start and end date for the task (select the checkboxes to activate the dates)·
The current status of the task·
The person this task has been assigned to·
The task priority, such as high, medium, low or undetermined·
The expected total time for the task and the actual time expended (in complete units; the type of unit·
must be agreed across the project)

The percentage completion·
The phase associated with this task·
A description of the task·
Any progress history appropriate to the task·

3 Click on the Apply button.

4 To create another entry click on the New button or, to close, click on the OK button.

5 To delete a task, in the Project Tasks view:
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Right-click on the task and select the 'Delete' option1.

Click on the Yes button on the confirmation prompt2.

Notes

'Owner' and 'Assigned' fields are filled from the Project Authors, Resources and Project Clients·
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Update Package Status

Often a complete Package structure moves from one status to another (such as for release) in one operation. To help
facilitate this, Enterprise Architect supports a 'bulk' update of Package and element Status, Phase, and Version, which
also provides the option of defining the scope of the update.

Access

Ribbon Design > Package > Manage > Update Status

Update Status across a Package

Field Action

New Status Type in or select the new status of the Package.

New Phase Type the new phase.

New Version Type the new version.

Modified Date System set; you cannot change this field.

Set Date Defaults to selected to apply the Modified Date; if necessary, deselect to ignore the
date stamp on the change.

Recursively update all
child packages

Select to apply the changes through all child Packages of the selected Package;
deselect to apply the changes to only the selected Package.

Include Elements Defaults to selected; if the changes are to apply only to Package elements, deselect
the checkbox.

Include Element
Requirements

Defaults to selected, to update the element requirements' 'Status' field; deselect to
ignore this field.

Include Element
Constraints

Defaults to selected, to update the constraints' 'Status' field; deselect to ignore this
field.

OK Click on this button to update all required elements to the new status.
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Monitor Change Events

You can automatically monitor work events in your project, using the Model Views facility.

Guide

Aspect Detail

Model Views This facility enables you to:

Automatically refresh a search in a View at an interval that you define·
Notify you if the results of the search change between two consecutive·
searches

You can therefore use Model Views to monitor various events in the development
project, depending on how you set up the search in a View.

Example You could set up a search to detect:

Change items, or Issue items, so that Enterprise Architect would notify you as·
new items were created

Element Status, Type, Phase, Version, Priority and/or date of last update, so·
that Enterprise Architect would notify you as items were progressed to:
     -  Fall in to the level of work represented by the search categories
     -  Move out of the categories into the next level of work

Tagged Values, so that - again - as items were changed to satisfy the criteria of·
a sequence of searches, the progression of items through a set of stages could
be checked and managed

Personalization People responsible for different stages in a process could have their own Model
View searches so that:

As a development, validation or authorization task falls due the responsible·
person is automatically notified, and

When the work is complete both the next person in line and the overseeing·
manager are notified

Notes

This facility is available in the Enterprise Architect Corporate, Unified and Ultimate Editions·
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Model Watches

Enterprise Architect provides you with the facility to watch for a range of activities linked to your user ID, across not just
one project but any or all of those to which you have access. This helps you to stay up to date with changes,
developments and conversations in the projects in which you are working or have an interest.

Specifically, you can set up a Watchlist to notify you of:

New model chats·
New model messages·
Recent element discussions·
Recent team reviews·
Recently flagged watched items·
Recently modified diagrams·
Recently modified elements·
Active tasks·
Tasks ending today, and/or·
Tasks overdue·

You can monitor for these events in the project or projects from a specific date onwards, or over a rolling interval of time
such as the previous seven days.

Access

Other Start page > Recent drop-down arrow > Configure Watched Models

Configure a Watchlist

(c) Sparx Systems 2024 Page 176 of 300 Created with Enterprise Architect



Project Build & Deploy 16 October, 2024

Step Description

1 In the 'Showing Activity From' field, click on the drop-down arrow and select the date from which to start
monitoring events.

If you want to accumulate information over time, leave the 'Relative Time' checkbox unselected to collect
the data starting from the set date as the absolute date.

If you want to show information gathered only over the previous fixed interval, select the checkbox. The
system then calculates the interval between the set date and today, displaying the length of that interval
next to the date field. Adjust the selected date to give you the interval you require. The system will then
provide information gathered only during that interval, rolling forward.

2 Click on the New button to add a project to the Watchlist. A short menu displays, offering options to
access the project through a:

Local file path - a browser displays through which you locate and select the project file·
Connection Wizard - the Windows 'Data Link Connection' dialog displays through which you can·
open a model on a DBMS

Cloud Connection - the 'Cloud Connection' dialog displays; ensure that all the connection details are·
correct

Connection string that you have copied - the 'Connection String' dialog displays; paste the copied·
string into the 'Enter Value' field and click on the OK button

The name of the project displays in the 'Connections' panel, with the 'Enabled' checkbox automatically
selected. At any point, if you want to drop the project out of the watch, you can simply de-select the
'Enabled' checkbox.

In the 'User Name' and 'Password' fields, type the login parameters necessary for the system to open the
watched model under your ID.

3 Click on the connection name and then on the Configure button.  The 'Model Watchlist' dialog displays.

Click on each checkbox to select the items to monitor, or to clear selected items as required. You can also
use the Select All button or Clear All button to act on all items at once, and then select or clear individual
items. When you have made your selection, click on the OK button to save the changes.

On the 'Manage Models' dialog, click on the OK button to save the model Watch and close the dialog.

To check for any events picked up by your Watchlist, on the Start page click on the 'Models' drop-down
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4 arrow and select the 'Watched' option. The list of recently-accessed projects is updated to show just those
included in your Watchlist.

The message 'Querying watched models' displays, followed by a login prompt for each project that has
controlled access. Type in your login parameters.

Under each project name, a summary list of the watched items and events is displayed.

You can review the flagged items by clicking on the watched model name and running the appropriate
Model Search or displaying the Discussions window. This closes the original project in which you
checked the Watchlist.

5 After you have checked the Watched projects, and if necessary, you can click on the 'Models' drop-down
arrow and select the 'Configure Watched Models' option to update the Watchlist configuration, as in steps
1, 2 and 3.

If it is necessary to remove a project entirely from the Watchlist, on the 'Manage Models' dialog click on
the project name and on the Delete button.

If you have finished working with the Watchlist, click on the 'Models' drop-down arrow and select the
'Recently Used' option to restore the model list to the full list of recently-accessed models.
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Teams & Collaboration

Enterprise Architect allows any number of people to work on models and diagrams simultaneously, in a cooperative and
team effort. The suite of Collaboration tools - introduced in the Available Facilities table - ensure that communications
concerning elements, diagrams, lists and matrices are available in the model alongside those objects, and links can be
created between the communications and the objects via those tools.

The 'Collaborate' panel in the Enterprise Architect Start ribbon conveniently brings these tools together, ensuring that
you are informed about what you need to attend to and made aware of information that is important to your role. The
'Support Collaboration' option in a diagram's properties also keeps you in the flow of a Chat conversation with a user or
user group, or a Discussion concerning an element, whilst you are modeling in diagrams.

Available Facilities

Facility Description

Review Elements These elements enable you to define a formal review of a part of the model, in
particular a small number of elements and/or diagrams. Each element enables you
to define when the review should start and end, and which members of the team are
responsible for performing the review.

Apart from the Review elements themselves, you use these windows to set up and
manage reviews:

The Discuss & Review window at the 'Review' tab, on which you can join a·
review and create new discussion points or responses within that review, on
any element or diagram

The Reviews view, listing all current and recent reviews of elements·
The Discuss & Review - History window at the 'Reviews' tab, showing the·
elements included in a selected review; you can switch to the 'Review' tab of
the Discuss & Review window to show the details of a selected element under
review

Discussions Discussions are grouped threads of conversation concerning an element or diagram
in the model. One user creates a topic of discussion on an object, other users reply
to that topic and to each other's responses, and so a conversation develops.

Discussions are created and managed through these facilities:

The Discuss & Review window at the 'Discuss' tab, on which you can create a·
new discussion or add to an existing discussion on a specific element or
diagram

The Discuss & Review - History window at the 'Discussions' tab, on which you·
can review the various discussions of elements recorded in the model, for
Today, Yesterday, This Week, Last Week, This Month and Last Month

The Recently Discussed Elements report, which presents elements that have·
been the subject of discussion in the last 7 days (by default; you can change the
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number of days in the 'Search Term' field)

Chats Chats are informal conversations between team members identified by either their
user ID or a Group name. The conversations are not directly linked to any model
structure, and can concern any subject in or outside the model.

Comments Comments are unstructured, ad-hoc notes or reminders lodged against specific
elements by any user. The user can create a comment or add to or edit an existing
comment, or remove the comment.

Diary Enterprise Architect provides a great facility for maintaining a daily diary. You can
record all kinds of ideas, comments, notes, suggestions, events, to-do lists and other
reminders of what you have done or intend to do within the model. This is a great
way to keep the momentum flowing day to day. The facility is simple to use,
allowing you to quickly jot down your thoughts as they occur to you.

Model Library Within the Library you can  review and add to a hierarchically-structured repository
of comments, reports, reviews and documents on any feature or aspect of the
project or related projects.

Mail The Model Mail facility provides you with the ability to send, receive and respond
to emails within the project team, under your User Security ID, either as an
individual user or as a member of a group that has a shared mail inbox.

Calendar The Project Calendar allows the team members to record scheduled meetings and
reminders of events for today or any day in the future, and to check for such events
falling due.

Personal Kanban Diagram Within the extensive Kanban facilities, each user can identify their personal Kanban
diagram and display it as a default diagram.

Personal Gantt Chart The Gantt chart facilities include an extracted chart for each user, listing tasks and
showing status as completed or incomplete.

Collaboration in Diagrams

Enterprise Architect has an additional feature that enables you to work on sections of your model in diagrams, and be
notified on the diagram of any posts in relevant Discussions or Chats concerning the elements you are working on. A
floating toolbar against the elements also enables you to instantly access various tabs of the Discuss & Review window,
Chat & Mail window, and the 'Model Message' dialog, displaying posts and messages concerning the selected element.
For more information, see the Collaboration Support in Diagrams Help topic.
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The Modeling Team

Enterprise Architect has been built from the ground up as a team modeling platform, and has extensive support for
groups of people working together on the same projects, sharing information, ideas and models. Features in team support
include Baselines, Version Control and a Reusable Asset Service, which protect the valuable modeling assets in a team
environment, plus tools such as a Discussion Forum, Library window and Gantt Charts to facilitate collaboration
between project members. The role-based security system has also been designed to encourage collaboration, allowing
team members to work together confident that there will be no conflicts in accessing or changing model data.

A choice of deployment options will support any team development environment, allowing people to work centrally or
remotely in highly distributed environments. Corporate policy and standards can also be built into the models with the
use of Workflow Scripts. A free 'Lite' version of Enterprise Architect offers team members 'view only' access to their
models, yet also allow them to generate high quality corporate documentation in a wide number of formats to
communicate with people outside the modeling platform.

Overview

Facility Description

Team Development Set up a collaborative modeling environment, taking advantage of security,
workflow and shared reference data, as discussed in the rest of this topic.

Formal Model Reviews A simple yet effective mechanism for capturing, in real time, reviews of a section
of the model in line with a particular event. Typically, a Project Manager or
coordinator will create a Review element specifically to discuss one or more
elements for a project phase or other category of review, over a defined period.

Project Management Explore some of the ways you can manage your project and team within Enterprise
Architect.

Project Resources Track and manage the people and resources in your project.

Glossary Define a common vocabulary between your different teams, ensuring common
understanding.
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Task Allocation Assign and Track team tasks in a Gantt View.

Personal Tasks Record and manage your personal tasks within the project.

Model Mail Use Model Mail in the Chat & Mail window to securely communicate with your
team via an internal email system embedded within the model.

Project Calendar Track the deployment of resources, time-frames for tasks, and upcoming project
events such as meetings and milestones, in a calendar format.

Use Case Estimation Form an estimate of the complexity of a system and an indication of the effort
required to implement the model.

Library Window Provides access to a team-based library of documents to record and discuss the
development and progress of the project.

Making Project Data Available in a Distributed Environment

Enterprise Architect offers a diverse set of functionality designed specifically for sharing projects in team-based and
distributed development environments; for example: Cloud-based solutions, network deployment of model repositories,
replication and Native/XMI Import/Export.

Applying Security to the Model

User Security is a means of improving collaborative design and development by preventing concurrent editing and
inadvertent model changes by users not designated as model authors.

(c) Sparx Systems 2024 Page 182 of 300 Created with Enterprise Architect



Project Build & Deploy 16 October, 2024

Using an Internal Discussion Forum

The Discussions facility provides several mechanisms to support your development team community, generally in
discussing the development and progress of the model across the project, or specifically in discussing individual
elements in the model, the discussions becoming a component of each element.

Building Company Policy and Project Development Guidelines into the Project

You can create workflow scripts that provide a robust approach to applying company policy and strengthening project
development guidelines, by validating the work against the policy and procedures within the model itself.

Standardizing and Re-using Project Data

You can import and export Reference data (including Glossary and Issue information) from .XML files of another
iteration of the same model, or of a different model.
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Typical Project Roles

Enterprise Architect is an effective multi-disciplinary modeling platform that supports common work practices and
provides features to assist the entire spectrum of roles and disciplines across enterprise, business, engineering and
software projects. Each role will typically use different features of the tool. A number of the roles and their
responsibilities that the system supports are outlined here.

You can review a summary of the typical tasks supported for each role, or review the Help topic for the appropriate role
title to explore how Enterprise Architect can assist you in carrying out that role within a model-driven project.

Roles and Responsibilities

Role Responsibilities

Business Analyst Create high-level models of business processes.

Software Architect Map functional requirements, perform real time modeling of objects, design the
Deployment model and detail the deliverable components.

Software Engineer Map Use Cases onto Class diagrams, detail the interactions between Classes, define
the system deployment and define software Packages.

Developer Perform round trip code engineering, including reverse engineering of existing code
and generation of code from Class elements.

Project Manager Assign resources to elements, measure risk and effort, estimate project sizes, and
manage element status, change control and maintenance.

Tester Create test scripts against elements in the modeling environment.

Implementation Manager Track and assign maintenance-related items to elements within Enterprise·
Architect

Rapidly capture and keep records of maintenance tasks such as features,·
changes, documents, issues, defects and tasks

Trace the maintenance of the items and processes involved in system·
deployment

Technology Developer Create customized additions to the functionality already present within Enterprise
Architect.

Database Developer Develop databases, including modeling database structures, importing database
structures from an existing database and generating DDL for rapidly creating
databases from a model.
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Summary of Typical Tasks

Throughout a design and development project there are many different tasks to be performed, which could be carried out
either by one person or - more probably - by members of a team with different responsibilities. In either case, Enterprise
Architect supports most - if not all - of the responsibilities you might have on your project. The descriptions in this topic
identify a number of job roles that the system supports. For those that most resemble your role on a project, refer to the
Help topic for that job title to read a description of how that role might make use of Enterprise Architect, then use the
references within those topics to explore some of the features of importance to the role.

Summary of Typical Job Roles

Most of these roles work with specific types of diagram, so you might want to learn more about diagram types in general
and specific types of diagram in particular.

Several types of project team member might want to generate documentation on their work and report on how the project
is developing and changing. Using Enterprise Architect you can generate project reports in either document or web
format.

Role Responsibilities

Business Analyst For modeling:

Requirements·
High-level business processes·
Business activities·
Work flows·
System behavior·

Database Developer Developing databases·
Modeling database structures·
Creating logical data models·
Generating schema·
Reverse engineering databases·

Software Architect Mapping functional requirements of the system·
Mapping objects in real time·
Mapping the deployment of objects·
Defining deliverable components·

Tester Developing test cases·
Importing requirements, constraints and scenarios·
Creating Quality Test documentation·
Tracking element defects and changes·

Software Engineer Mapping Use Cases into detailed Classes·
Defining the interaction between Classes·
Defining system deployment·
Defining software Packages and the software architecture·

Project Manager Providing project estimates·
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Resource Management·
Risk Management·
Maintenance Management·

Developer Forward, reverse and round-trip engineering·
Visualizing the system states·
Visualizing Package arrangements·
Mapping the flow of code·

Implementation Manager Modeling the tasks in rolling-out a project, including network and hardware·
deployment

Assigning and tracking maintenance items on elements (issues, changes,·
defects and tasks)

Technology Developer For creating or customizing:

UML Profiles·
Patterns·
Code Templates·
Tagged Value Types·
MDG Technologies·
Add-Ins·

Notes

The Corporate, Unified and Ultimate Editions of Enterprise Architect have a User Security feature that can be·
applied or turned off; if security is turned on, you need to have the appropriate access permissions to use many of the
facilities
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Enterprise Architect

Enterprise Architects can use the tool to create a deep representation of an enterprise, including Business, Information,
Application, and Technology architectures.

You can create Roadmaps as overlays on any diagram type, and capability models can ensure the architectures align with
what the enterprise does. You can create Business, Information, Application, and Technology Architectures, and these
and the teams that create them can be managed through the tool. Architects and other stakeholders can automatically
generate business-friendly publications, including charts and graphs, to visualize critical parts of the architectures.

Enterprise Architect Tasks

Task Detail

Create Strategic Roadmaps Roadmaps guide an organization from its current state to a target state, thus
transforming the enterprise and steering it on a strategic course through a series of
transition states.

Enterprise Architect has productive and flexible roadmap facility, allowing you to
create roadmaps from pre-built model patterns for a solution, segment, and
enterprise architectures. You can develop roadmaps for any architecture artifacts,
including capabilities, applications, and technology items.

Define Business Capability
Models

Business Capabilities are the cornerstone for the work carried out by the other
architecture domains, including Information, Application, and Technology
Architecture. They provide a way of viewing what the business does or needs to do.
They are considerably easier and less time-consuming to create than business
processes and directly correlate to what the enterprise does.

You can model capabilities using ArchiMate capability elements or UML Activities
and diagrams of nested elements modeling the hierarchal structure of these
all-important business elements. The capabilities can be automatically colored in
two dimensions using dynamic diagram legends.

Catalog Application
Portfolios

The Application Architecture provides an essential catalog of the applications in the
enterprise describing the work that they do to transform, transmit and store
information. The architecture also describes the interfaces required or provided by
the applications and how the applications interact to carry out the activities
described in the business models, such as the Business Process diagrams.

You can model application portfolios in Enterprise Architect and visualize the list
in various ways, including diagrams, list views, specification manager, and charts
and graphs.

Model Information
Architectures

Information Architecture is key to the success of an Enterprise Architecture
Program, as information is created, consumed, and destroyed by the components
that make up the other architectures. The information architecture will typically
include a description of the baseline and target architectures, with a series of
transitions defined that can be executed and described on Roadmap diagrams.

Enterprise Architect is a profoundly useful tool for creating and maintaining
information architectures. Its sophisticated and extensive support for standards and
its wide range of tools to support information models, from high-level
classifications and concepts right down to the level of schemas and the elements
and columns that comprise them.

Create Technical Reference The Technical Reference Model (TRM) references generic platform services and
technology elements and acts as a substrate upon which to build a technology
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Models architecture. The TRM provides a set of architectural and solution building blocks
that will ultimately provide the platform for business and infrastructure applications
to deliver the application and infrastructure services.

You can use Enterprise Architect to create any technology model, and you can use
any modeling language to represent the devices, nodes, system software, and any
other technology artifact.

Manage Architecture
Governance

The governance of the architectures is critical for the success of the program and
the architectures it creates. Regardless of how perfect an architecture is, without the
assurance that the technology staff has implemented it correctly, the vision
expressed in the architecture might not be realized, the promise made to the
stakeholders will be empty, and the business value will never eventuate.

You can use Enterprise Architect to govern and manage your architectural practice
and the architectures it produces, including governance boards, the governance
register, and more.
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Business Analysts

A Business Analyst can use Enterprise Architect to create high-level models of business processes, including business
requirements, activities, workflow, and the display of system behavior.

Using Enterprise Architect, a Business Analyst can describe the procedures that govern what a particular business does.
Such a model is intended to deliver a high-level overview of a proposed system.

Business Analyst Tasks

Task Detail

Model High Level
Business Processes

Using Analysis diagrams, you can model the high-level processes of the business.

Analysis diagrams are a subset of UML 2.5 Activity diagrams and are less formal
than other diagram types, but they provide a useful means for expressing essential
business characteristics and requirements.

Model Requirements Gathering requirements is typically the first step in developing a solution, be it for
developing a software application or for detailing a business process; it is an
important step in the implementation of a project.

Using Enterprise Architect, you can define the Requirement elements, connect
Requirements to the model elements for implementation, connect Requirements
together into a hierarchy, report on Requirements, and move Requirements out of
model element responsibilities.

Model Business Activities You can use Activity diagrams to model the behavior of a system and the way in
which these behaviors are related to the overall flow of the system.

Activity diagrams do not model the exact internal behavior of the system but show
instead the general processes and pathways at a high level.

Model Workflow To visualize the cooperation between elements involved in the workflow, you can
use an Interaction Overview diagram, which provides an overview of sub activities
that are involved in a system.

Display System Behavior In displaying the behavior of a system as a Use Case diagram, Enterprise Architect
provides an easily understood tool for mapping the functional requirements and
behavior of a system.
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Systems Engineer

A Systems Engineer can use Enterprise Architect to produce robust and productive models of complex cyber-mechanical
systems. The models can be requirements, structural and behavioral models, including Use Cases, Package Diagrams,
Block Definition Diagrams, Internal Block Diagrams, Activity Diagrams, Sequence Diagrams, State Machine Diagrams,
and Parametric Diagrams. Enterprise Architect has a comprehensive set of tools to assist the engineer and other
stakeholders.

Systems Engineer Tasks

Task Detail

Define and Manage
Requirements and their
Relationships

The field of Requirement Engineering is one of the most critical disciplines in the
solution development lifecycle, and it has a documented impact on the success of
projects.

Enterprise Architect has an unparalleled range of tools for developing, managing,
visualizing, and documenting requirements, including tools to import, integrate, and
synchronize with external requirement management systems.

Describe User Goals with
Use Cases

Systems Engineers use Use Cases as a method for representing functional
requirements from the users' perspective. They are goal-driven because the Use
Case defines the goal that the user is trying to achieve while interacting with the
system. Enterprise Architect fully supports the development of Use Case diagrams
and fully supports the modeling and management of Use Case text; it has a unique
and highly productive tool for working with Use Cases, called the Scenario Builder.

Use Blocks to Model
Structure and Constraints

The Block is the fundamental unit of system structure. Systems Engineers use
blocks to describe an entire system, a subsystem, a component, an item that flows
through a system, a constraint, or entities that reside outside a system. Similar to
our natural languages, a Block can represent something abstract, logical, or
physical.

Enterprise Architect has a rich set of tools that help the systems engineer work with
Blocks and visualize the structure and behavior of these all-important elements in a
system's definition.

Coordinate Behavior with
Activities

The Activity diagram is formally based on a branch of mathematics called Petri
Nets, and it uses a system of tokens to indicate both the sequence of actions and
also the items that flow through the system. The items that flow can be information
items, physical items, or even control signals.

Enterprise Architect provides a rich toolbox to work with these behavioral elements
and their relationships, including allocating system behavior in the form of
Activities and Actions to Blocks and relating these elements to behavioral features
owned by Blocks, such as operations.

Visualize Systems in
Motion with Simulations

Simulation provides a way to see a system in motion and visualize how it behaves
through its lifecycle.

As a leading Systems Engineering tool, Enterprise Architect allows a systems
engineer to construct models using industry-compliant modeling techniques and
languages to represent cyber-mechanical systems. These models act as devices for
communication between collaborating engineers, consultants, and others but can
also be used to generate visualizations and simulations using industry-standard
modeling languages used by OpenModelica and MATLAB's Simulink.
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Software Architects

Software Architects can use Enterprise Architect to map functional requirements with Use Cases, perform real time
modeling of objects using Interaction diagrams (Sequence, Timing, Communication or Interaction Overview), design the
Deployment model and detail the deliverable components using Component diagrams.

Software Architect Tasks

Task Detail

Map Functional
Requirements of the
System

With Enterprise Architect you can take the high level business processes that have
been modeled by the Business Analyst and create detailed Use Cases.

Use Cases describe the proposed functionality of a system and are only used to
detail a single unit of discrete work.

Map Objects in Real Time You can use Interaction diagrams (Sequence and Communication diagrams) to
model the dynamic design of the system.

Sequence diagrams detail the messages that are passed between objects, and the
lifetimes of the objects.

Communication diagrams are similar to Sequence diagrams, but instead display the
way in which the object interacts with other objects.

Map Deployment of
Objects

You can use Deployment diagrams to provide a static view of the run-time
configuration of processing nodes and the components that run on the nodes.

Deployment diagrams show the connections between hardware, software and any
middleware that is used on a system.

Detail Deliverable
Components

Using Component diagrams, you can model the physical aspects of a system.

Components can be executables, libraries, data files or another physical resource
that is part of a system.

The component model can be developed from scratch from the Class model or can
be brought in from existing projects and from third-party vendors.
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Software Engineers

Software Engineers using Enterprise Architect can manually map Use Cases onto Class diagrams, detail the interactions
between Classes, define the system deployment with Deployment diagrams and define software Packages with Package
diagrams.

Software Engineering Tasks

Task Detail

Map Use Cases into
Detailed Classes

Within Enterprise Architect you can study the Use Cases developed by the
Software Architect, and with that information create Classes that fulfill the
objectives defined in the Use Cases.

A Class is one of the standard UML constructs that is used to detail the pattern from
which objects are produced at run time; to record the relationships between Use
Cases and Classes, you can create diagrams linking the elements with Realization
connectors, and/or map the Realization connectors in the Relationship Matrix.

Detail Interaction Between
Classes

You can use Interaction diagrams (Sequence and Communication diagrams) to
model the dynamic design of the system.

Sequence diagrams are used to detail the messages passed between objects, and the
lifetimes of the objects.

Communication diagrams are similar to Sequence diagrams, but instead display the
way in which objects interact with other objects.

Define System Deployment Deployment diagrams provide a static view of the run-time configuration of
processing nodes and the components that run on the nodes.

Deployment diagrams can be used to show the connections between hardware,
software and any middleware that is used on a system, to explain the connections
and relationships of the components.

Define Software Packages You can use Package diagrams to detail the software architecture.

Package diagrams are used to organize diagrams and elements into manageable
groups, declaring the dependencies.

Simple Use Case diagram
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Developers

Developers can use Enterprise Architect to perform round trip code engineering, which includes reverse engineering of
existing code and generation of code from Class elements.

Developer Tasks

Task Detail

Round Trip Engineering Enterprise Architect gives you unparalleled flexibility in 'round tripping' software
from existing source code to UML 2.5 models and back again.

Round trip engineering involves both forward and reverse engineering of code,
keeping the model and code synchronized.

Reverse Engineering In Enterprise Architect, you can reverse engineer code from a number of supported
languages and view the existing code as Class diagrams, which illustrate the static
design view of the system.

Class diagrams show Classes and interfaces, and the relationships between them;
the Classes defined in UML Class diagrams can have direct counterparts in the
implementation of a programming language.

Forward Engineering As well reverse engineering your code into your model, you can forward engineer
elements of your model into code (code generation).

This way you can make changes to your model with Enterprise Architect and
quickly implement the changes in the source code.

Determine the System State To visualize the state of the system you can use StateMachine diagrams to describe
how elements move between States, classifying their behavior according to
transition triggers and constraining guards.

StateMachine diagrams capture system changes over time, typically being
associated with particular Classes; often a Class can have one or more
StateMachine diagrams to fully describe its potential states.

Visualize Package
Arrangement

Package diagrams help you design the architecture of the system; they are used to
organize diagrams and elements into manageable groups, and to declare their
dependencies.

Follow the Flow of Code Activity diagrams help you develop a better understanding of the flow of code.

Activity diagrams illustrate the dynamic nature of the system; you can model the
flow of control between Activities and represent the changes in state of the system.

Simple Class Diagram
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Notes

You can use StateMachine, Package and Activity diagrams to better understand the interaction between code·
elements and the arrangement of the code
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Project Managers

Enterprise Architect provides support for the management of projects. Project Managers can use the system to assign
resources to elements, measure risk and effort, estimate project sizes, and manage element status, change control and
maintenance.

Project Manager Tasks

Task Detail

Provide Project Estimates In Enterprise Architect you have access to a comprehensive project estimation tool
that calculates effort from Use Case and Actor objects, coupled with project
configurations defining the technical and environmental complexity of the work
environment.

Resource Management Managing the allocation of resources in the design and development of system
components is an important and sometimes difficult task; Enterprise Architect
provides you with an effective tool for assigning resources directly to model
elements and tracking progress over time.

Risk Management You can use the Risks window to assign risk to an element within a project; using
risk types you can name the risk, define the type of risk and give it a weighting.

Maintenance Within Enterprise Architect you can assign maintenance-related items to elements
and track them, providing rapid capture and record keeping for items such as
features, changes, documents, issues, defects and tasks.

You can also create and maintain a Project Glossary of processes, procedures, terms
and descriptions.
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Testers

Enterprise Architect provides a design testing facility for Testers and Quality Assurance personnel to create a range of
test scripts against elements in the modeling environment.

Testing Tasks

Task Detail

Test Cases With Enterprise Architect, you can set up a series of tests for each model element.

The test types include Unit, Acceptance, System, Integration, Inspection and
Scenario tests.

Import requirements,
constraints and scenarios

To use testing to maintain the integrity of the entire business process, you can
import requirements, constraints and scenarios defined in earlier iterations of the
development life cycle.

Requirements indicate contractual obligations that elements must perform within
the model.

Constraints are conditions that must be met in order to pass the testing process;
constraints can be:

Pre-conditions (states that must be true before an event is processed)·
Post-conditions (events that must occur after the event is processed) or·
Invariant constraints (which must remain true through the duration of the·
event)

Scenarios are textual descriptions of an object's action over time and can be used to
describe the way a test works.

Create quality test
documentation

Enterprise Architect provides the facility to generate high quality test
documentation in .RTF, DOCX and PDF file formats.

Element defect changes In defect tracking you can allocate defect reports to any element within the model,
so that all who are involved in the project can quickly view the status of defects and
see which defects have to be addressed and which have been dealt with.
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Implementation Managers

Enterprise Architect provides support for the management of project implementation. You can track and assign
maintenance -related items to elements within Enterprise Architect, and rapidly capture and update records of
maintenance tasks such as features, changes, documents, issues, defects and tasks. By providing a centralized facility for
each element involved in the deployment process Enterprise Architect offers a convenient solution for tracing the
maintenance of the items and processes involved in system deployment.

Implementation Tasks and Tools

Task Detail

Develop Deployment
Diagrams

Using Deployment diagrams, you can model the roll out of a project, including
network deployment and workstation deployment.

Users involved in project deployment can add maintenance tasks to the diagram
elements.

Deployment diagrams provide a static view of the run-time configuration of nodes
on the network or of workstations, and the components that run on the nodes or are
used in the workstations.
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Technology Developers

Technology Developers are Enterprise Architect users who create customized additions to the functionality already
present within Enterprise Architect.

Additions include UML Profiles, Patterns, Code Templates, Tagged Value Types, Scripts, Custom Queries,
Transformations, MDG Technologies and Enterprise Architect Add-Ins. By creating these extensions the Technology
Developer can customize the Enterprise Architect modeling process to specific tasks and speed up development.

Developing Technologies

Extension Detail

UML Profiles By creating UML Profiles you can create a customized extension for building UML
models that are specific to a particular domain.

Profiles are stored as XML files and can be imported into any model as required.

Patterns Patterns are sets of collaborating Objects and Classes that provide a generic
template for repeatable solutions to modeling problems.

As Patterns are discovered in any new project, you can publish the basic Pattern
template.

Patterns can be re-used with the appropriate variable names modified for any future
project.

Code Templates Code templates are used to customize the output of source code generated by
Enterprise Architect; in this way you can generate code languages not specifically
supported by Enterprise Architect and define how the system generates source code
to comply with your own company style guidelines.

Tagged Value Types Tagged Values are used in Enterprise Architect to extend the information relating to
an element in addition to the information directly supported by the UML language.

A Tagged Value, strictly, is the value of a property of a modeling item, the property
being called a tag; for example: a Class element called Person might have a tag
called 'Age' with the Tagged Value of '42'.

More loosely, the combination of tag and value can be referred to as a Tagged
Value.

A Tagged Value Type is a group of parameters that define and/or limit the possible
values of a tag and, in many instances, how a specific value is assigned to the tag;
for example, the tag 'Age' might have a Tagged Value Type of 'Integer', so the user
simply types in a numeric value.

Alternatively, the type could be 'Spin', with lower and upper limits of, say, 20 and
120, so the user sets a value by clicking on arrows in the field to increment or
decrement the value within the limits of 20 and 120.

Typically, Tagged Values are used during the code generation process, or by other
tools to pass on information that is used to operate on elements in particular ways.

MDG Technologies MDG Technologies can be used to create a logical collection of resources that can
contain UML Profiles, Patterns, Code Templates, Image files and Tagged Value
types that are accessed through a technology file.

Enterprise Architect
Add-Ins

Using Add-Ins you can build your own functionality into Enterprise Architect,
creating your own mini programs that can extend the capabilities of the system,
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defining your own menus, and creating your own Custom Views.
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Database Developers

Enterprise Architect supports a range of features for the development of databases, including modeling database
structures, importing database structures from an existing database and generating DDL for rapidly creating databases
from a model.

Database Development Tasks

Task Detail

Create Logical Data
Models

With Enterprise Architect you can build database diagrams using the built-in UML
Data Modeling Profile.

This supports the definition of Primary and Foreign Keys, cardinality, validation,
triggers, constraints and indexes.

Generate Schema By using Enterprise Architect's DDL generation function you can create a DDL
script to create the database table structure from the model.

Enterprise Architect currently supports:

DB2·
Firebird·
MS Access·
MySQL·
MS SQL Server·
Oracle·
PostgreSQL·

Reverse Engineer Database Using an ODBC data connection you can import a database structure from an
existing database to create a model of the database.

By generating the model directly from the database you can quickly document your
work and create a diagrammatic account of a complex database through the
graphical benefits of UML.

Example Data Model Diagram
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Model Discussions

Using the 'Discuss' tab of the dockable Discuss & Review window, you can select an individual element or diagram and
develop an informal discussion that is directly associated with that object. This makes it easy to locate, view and
contribute to a discussion, or more than one discussion, on the selected object.

You can participate in discussions on different elements and diagrams simply by clicking on each object in turn; the
Discuss & Review window immediately switches to the discussion of the new selected object, identified by name
underneath the window tab bar.

As a discussion develops, the number of responses is shown below the original post; therefore you can see when a
discussion has a new reply without having to expand and work through the thread. You can apply a priority and status to
a discussion, which helps you to indicate the importance of the discussion and to resolve and close off the points raised
in the discussion so that they do not continue indefinitely. You can also delete the whole posting or specific replies, to
balance retaining discussion history with removing irrelevant information.

If you are using the Discussions facility a lot and want to ensure that the Discuss & Review window and the 'Discuss' tab
are displayed each time you log back in for a new work session. you can set them as a default display. To do this, click
on the 'Hamburger' icon and select the 'Set this Tab as Default' option.

The discussion comments pertinent to an element can also be displayed in that element on a diagram, in the 'Discussion'
compartment of the element.

Access

Select an element or diagram, then open the Discuss & Review window using one of these methods:

Ribbon Start > Collaborate > Discuss > Discuss

Context Menu Browser window > Right-click on object > Collaborate > Discuss

On diagram > Right-click on element > Collaborate > Discuss

Keyboard Shortcuts Ctrl+9 > Discuss

Operations in Discussions

Operation Action

Create a Discussion At the top of the tab, the message Create New Discussion displays. You have two
options, direct entry or indirect entry.

In direct entry (better for short messages), either double-click on the message or
right-click on the window and select the 'Create new Discussion' menu option. Type
or paste your posting. The text automatically wraps at the border of the Discuss &
Review window. As you type, you can right-click on the text and perform the usual
Notes text operations such as formatting and setting translation flags.

There is an option on the Preferences window, 'Window Behavior' page that sets
whether to use either the Enter key or the Ctrl+Enter keys to submit a topic or post.
Whichever you select, you can use the alternative option to break and insert a new
line in your Discussion text.

When you have finished typing, click off the text or press the Enter key (or
Ctrl+Enter keys).
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In indirect entry, press Ctrl+Spacebar to display a simple text window and type or
paste your discussion text there. When you have finished your message, press the
Esc key to transfer the text to the 'Discuss' tab. Then press the Enter key. The
advantage of the indirect method is that you can edit and format the text - especially
in long messages containing several paragraphs - without risk of accidentally
submitting it incomplete as a Discussion item.

When you press the Enter key:

An open expansion arrow and a  icon display to the left of your text·
Your user ID and the time of posting display just underneath your text,·
followed by the text 0 recent

The message Create New Discussion displays above your text·
All new discussions are added to the top of the 'Discuss' tab.

If user security is enabled and you have selected to show avatars, the discussion
icon is replaced by an image representing the user who contributed that item. If a
user does not have an avatar image, a default 'head and shoulders' silhouette
displays as the avatar.

Note that your text might contain words that are automatically underlined. These
are terms for which a Glossary definition has been created, and positioning the
cursor over one of these words will display the definition in a pop-up message box.
If you do not want to indicate glossary terms, right-click on the message and click
on the 'Highlight Glossary Terms' menu option. This will clear the automatic
underlines across the system. Do this again if you want to restore the underlines.

Monitor Discussion Once a discussion has been started on an element or diagram, you can set a flag to
notify you whenever a response is posted to the thread. To set the flag, right-click
on the diagram name in the Browser or the element name in the Browser window or
in a diagram, and select the 'Collaborate > Monitor Discussions' option. The flag
then operates for your user ID.

When a response is posted in a monitored discussion, the notification is a Msg

button  that displays at the right hand end of the application title bar.

Click on the drop-down arrow; a list of the monitored elements that have1.
unopened responses is displayed.

Click on the element to investigate; the  Discuss & Review window displays,2.
showing the 'Discuss' tab and the response to the discussion thread.

If you want to remove a discussion flag - or all discussion flags you have set - on

the 'Discuss' tab of the  Discuss & Review window click on the  icon and select
the 'Manage Monitored Discussions' option. The 'Manage Monitored Discussions'
dialog displays, showing the monitored element names and their type, author and
last-modified date.

Click on a specific element, or Ctrl-click on multiple names, and click on the·
Delete button to stop monitoring the discussions on those elements, or

Click on the Select All button and on the Delete button to clear all elements·
from your monitored discussion list

If you have selected elements but do not want to remove all of them, click on·
the Clear All button and make a different selection

If you are spending time working in diagrams, there is also a convenient facility to
monitor and access Discussions on elements within the diagram. See the
Collaboration Support in Diagrams Help topic.

Add a Response You enter a reply to a discussion topic by clicking on the expansion arrow next to
the discussion item. This changes the display to show just the selected Discussion
topic at the top of the window and any existing responses to that topic underneath
it, after a line broken by the text Open, n Posts.
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You then press the Enter key to place the cursor at the start of the text entry field at
the top of the tab. Either:

Type your response, or·
Press Ctrl+Spacebar and type the text in the 'Post Reply' text box; when you·
have finished, press the Esc key to place the text in the 'Discuss' tab

Click on the Post button.

The response displays at the top of the list of replies·
Your user name displays above the response, with your avatar to the left of it·
(and subsequently the date of posting displays on the right)

The time of posting displays on the left of the response·
As more responses accumulate, the Post count increments·

All new replies are added underneath the Discussion thread they are in response to.
All responses you make before someone else posts are grouped together underneath
your user name.

To return to the Discussion list mode, click on the large arrow to the left of the
reply text box.

Filter Discussions The default order of display of Discussions is to show all open Discussion topics in
a list, with the most recent topic at the top. There are a number of context menu
options available for you to filter which Discussions are listed, and which
Discussions are presented first.

Show Closed Topics - Include in the list topics of discussions that have been·
closed

Visible Timeframe - Confine the list to Discussions created today, in the last 3,·
7, 30 or 90 days, or restore the list to all Discussions; the 'Today+' option
shows Discussions from today and the 20 most recent postings prior to today

Always Visible - Always display Discussions that have one or more of the·
statuses Open, Error, Alert, Accept, or Reject; you also have options to select
discussions of all statuses, or to clear all status selections in the list

Sort by Most recent Activity - Display the list of discussions with the most·
recent exchange of responses at the top, and the least active Discussions at the
end

Edit Postings Whilst you are typing a message, the editor automatically checks the spelling and
underlines possible spelling errors in red. You can backspace or move the cursor to
the errors to correct them. You can also move the cursor anywhere in the message
body and add or delete text (press the Delete key).

Once you have pressed the Enter key to post a message, you can delete the whole
message but you cannot edit it.

Copy Discussion Text If you want to re-use some or all of the text of a saved Discussion item, you can
open the text in a (read only) pop-up dialog, by pressing Ctrl+Space.  You can then
select the text you want and press Ctrl+C to copy it to the clipboard.  Alternatively,
you can right-click a Discussion item and choose "Copy to Clipboard", to copy all
of the text from that item.

The copied text can then be pasted into a new Discussion item or into another
document in Enterprise Architect.

Set Discussion Status
The  icon against a new Discussion indicates that the Discussion has the status of
'Open'. To change the status, right-click on the Discussion item and select either:

Alert·
Error·
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Accept·
Reject·
Closed·

If the Discussion already has one of these statuses, you can also select the 'Open'
option to return the Discussion to 'Open' status.

When you review the Discussions in the Discuss & Review window, you might
want to include Discussions that have the status of 'Closed', or you might prefer to
hide them. To toggle the inclusion of closed Discussions, right-click on the body of
the window and click on the 'Show Closed Topics' option.

Set Discussion Priority As part of the Discussion, you might want to identify the priority of a point being
raised. It might be very important to act on the point, or it might be agreed that the
point discusses a 'nice to have' feature that could be addressed at a later date. To set
the priority, right-click on the Discussion topic and select one of the options:

'Priority | High' ( )·

'Priority | Medium' ( ), or·

'Priority | Low' ( )·
Alternatively, if you decide that an item does not need to be prioritized, select the
'Priority | <none>' option. This leaves the item icon as .

Search for Discussion
items on an element or
diagram

Right-click on the body of the 'Discuss' tab (in discussion list mode for an element)
and click on the 'Search Discussions' option. The Create New Discussion text
changes to Enter text to search discussions.

Double-click on that message and then type in the text you want to locate in any
discussion topics for the selected element. Press the Enter key.

The system runs a search for any topic that either contains that text or has a post
(reply) that contains the text. The search results are listed in the tab, under the text
Displaying search results for term <search term>. You can double-click on this
row to type a new search term and re-run the search.

Clicking on a discussion item in the search list switches to the 'post reply' mode,
where you can read the original topic and all responses to it. Clicking on the large
arrow button returns you to the list of search results.

To return to the normal list of discussion items for an element, press the Esc key,
reload the tab, change context, or right-click and click on the 'Search Discussions'
option again.

Delete a Discussion or
Reply

Right-click on the Discussion or a reply, and select the 'Delete Selected' menu
option. A prompt displays to confirm the deletion. Click on the Yes button.

If you delete a Discussion, all replies associated with that Discussion will be
deleted as well.

Review Discussion History Either:

Click on the object name bar at the top of the window, or·
Right-click within the body of the window, or·
Select the 'Start > Collaborate > Discuss' ribbon option·

In each case, select the 'Discussion History' option.

The Discuss & Review History window displays at the 'Discussions' tab, listing all
existing discussion items on elements and diagrams.
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Notes

The Discussions facility is available in the Corporate, Unified and Ultimate Editions of Enterprise Architect·
If you are working with an External Data Provider in a Cloud-connected model, you can review external data item·
features and characteristics in the 'External' tab of the Inspector window; see the External Item Details Help topic

If the editor does not highlight spelling errors, select the 'Start > Appearance > Preferences > Preferences > Objects'·
ribbon option and deselect the 'Disable Spelling' checkbox

A standard report is available for locating elements that have recently been the subject of Discussions; select the·
'Start > Collaborate > Discuss > Recently Discussed' ribbon option
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Model Reviews

A Review element is a simple yet effective mechanism for capturing, in real time, discussions concerned with a
particular event on one or more elements and/or diagrams. Typically, a Project Manager or other coordinator will create
a Review element specifically to discuss one or more objects for a project phase, project stage or other category of
review, over a defined period. A number of reviewers then 'join' the review and enter discussion points and responses in
the Discuss & Review window. Note that you can only be joined to one Review element at a time.

Review elements can be used in a number of contexts, including model development, testing, delivery, maintenance and
management. They can be added to specific Review diagrams - which have their own 'Review' Toolbox page - or to more
general diagrams, using 'Review' icons from the 'Review', 'Artifact', 'Maintenance' or 'Management' Toolbox pages.

Review elements are generally set up and managed within Enterprise Architect, but users both of Enterprise Architect
and of the WebEA facility can use Review elements to direct their input to discussions on project and model reviews.

If you want to simply comment on or discuss an element or diagram without capturing your discussion in a formal
review, use the 'Discuss' tab of the Discuss & Review window. See the Model Discussions Help topic.

Setting Up a Review

The most direct and structured scenario would be for the review coordinator to create the Review element through the
Reviews view.

The Review element is a composite element to which the review coordinator would add a review diagram (as a 'Review
Set') and then add to that diagram the elements and/or diagrams (as Navigation Cells) to be reviewed. Each Navigation
Cell effectively forms a Review Set of elements itself.

A joined reviewer simply selects objects on the diagram and creates discussion topics or responses on each object using
the 'Review' tab of the Discuss & Review window. The process for an element under review can be monitored and
eventually approved by one or more designated 'Approvers' assigned to the individual element through the 'Review' tab.

The Project Manager might also set a status that, when an element under review reaches it, locks the element against
review until it assumes a different status, as described in the Take Part in a Review Help topic.

The Review element also acts as a bridge to continue focused discussions in subsequent work sessions. If you want to
ensure that the Discuss & Review window and the 'Review' tab are displayed each time you log back in for a new work
session. you can set them as a default display by clicking on the 'Hamburger' icon and selecting the 'Set this Tab as
Default' option.

Using Review Elements

Review elements are used to plan and coordinate a formal review of part of your model, defining:

When the review is to start and end·
What elements or diagrams are to be reviewed (and, as the review progresses, which objects have not yet been·
reviewed)

The current status of the review·
Any specific instructions for performing the review·
Who is involved in the review·
Any resources to use during the review·
The priority of the review·

The start and end date information is defined in two special EAReview Tagged Values (on the Review element
'Properties' dialog, see the 'General' page and 'EAReview' tab):

EndDate - the date on which the Review will be complete with no further discussions expected·
StartDate - the date from which users can join the review, and add discussions and responses·
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Other information can be provided through the Review element's normal element properties including Linked
Documents, Notes and associated Note elements, Tagged Values and attributes. Review elements and their contents can
be the subject of searches and document generation, all of which add to the information-gathering and grouping purposes
of the element. The element also has a child diagram that aids planning, management and coordination of the review, and
that provides a quick overview of and access to the elements under review.

The review comments pertinent to an element can be displayed in that element on a diagram, in the Review
Compartment of the element.
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Create a Review Element

You have two starting points for setting up a review, either:

Create and/or open a diagram and drag onto it the Review element icon from the Diagram Toolbox, or·
Create a Review element from the Manage Reviews view and subsequently add it to an open diagram via the·
Browser window

In either case, your objective is to have a diagram containing a Review element, with a number of model elements and/or
Navigation Cells for diagrams, which are the objects to be reviewed. This forms a simple, tidy, visual tool for managing
the Review.

At the end of each of the two 'create element' processes, you are joined to the Review you have created and can make
preliminary comments for the review.

Create a Diagram First

In the Browser window, on the parent Package for your Reviews, right-click and select the 'Add Diagram' option to1.
display the 'New Diagram' dialog.

In the 'Type' field click on the drop-down arrow and select 'Reviews & Discussions', and in both the 'Select From'2.
and 'Diagram Type' panels click on the 'EAReview' option.
Alternatively, open an existing Review diagram, or create and/or open a diagram of any other appropriate type, as
you prefer.

Drag onto the diagram the 'Review' icon from the Diagram Toolbox; the icon and element have these appearances:3.

    
The element defaults to the Info View style, which you can edit or disable.

Display the element 'Properties' dialog and, on the 'General' page, enter the information as explained in the4.
remaining steps.

If necessary, overtype the element name with a different name.5.

In the 'Status' field click on the drop-down arrow and select the appropriate status - normally 'Proposed', but you can6.
also select from 'Active', 'Deferred' or 'Closed'.

Click on the EAReview tab and, in the 'EndDate' field, click on the drop-down arrow and select the date on which7.
the review should complete.

In the 'StartDate' field, click on the drop-down arrow and select the date on which the review should begin. Click on8.
the OK button.

The populated element displays in the diagram. Right-click on the diagram and select the 'Save current changes'9.
option.

Right-click again and select the 'Join Review' option; the Review is opened to you as a joined reviewer, on the10.
'Review' tab of the Discuss & Review window, and you can create some initial discussion points.

From the Browser window, drag the elements and diagrams to be reviewed onto the diagram. See the Add Objects11.
for Review section.

Create an Element First

(c) Sparx Systems 2024 Page 212 of 300 Created with Enterprise Architect



Project Build & Deploy 16 October, 2024

Open the Reviews View (the 'Start > Collaborate > Review > Manage Reviews' ribbon option).1.

Right-click on the View background and select the 'New Review' option; the 'Create Review' dialog displays, with2.
the 'Name' field defaulting to the name of the currently-selected Package.

If necessary, overtype the 'Name' field with a different name.3.

In the 'Status' field click on the drop-down arrow and select the appropriate status - normally 'Proposed', but you can4.
also select from 'Active', 'Deferred' or 'Closed'.

In the 'Start' field, click on the drop-down arrow and select the date on which the review starts.5.

In the 'End' field, click on the drop-down arrow and select the date on which the review should complete. Click on6.
the OK button.

In response to the prompt for the owner Package, either accept the current Package or browse for a different7.
Package. Click on the OK button.

You are automatically joined to the review, on the 'Review' tab of the Discuss & Review window, and can create8.
some initial discussion points.

Now create and/or open a diagram to contain the Review element and the objects to be reviewed. See the Add9.
Objects for Review section.

Add Objects for Review

A formal review can be of a single element or diagram, or several objects together. To identify and organize the objects
to be reviewed, you drag the objects from the Browser window onto the Review diagram. If you have created the Review
element directly in the Reviews view, you also drag the Review element itself onto the Review diagram.

As you drag each element onto the Review diagram, drop it as a Link.

As you drag a diagram onto the Review diagram, drop it as a Diagram Reference or Navigation Cell.

You might also want to create a Note element on the diagram, containing information and instructions on the review for
the Reviewers.
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Assign Approvers to a Review

An Approver is someone assigned to one or more specific objects in a review to monitor the review of those objects and
ensure it is conducted satisfactorily. If you intend to assign an Approver to an object under review, you can do this
through the 'Review' tab of the Discuss & Review window, after adding the objects to be reviewed to the Review
diagram.

Assign an Approver

In a review that you have joined, work through these steps:

Press Ctrl+9 to display the Discuss & Review window, and select the 'Review' tab.1.

In the Review diagram, or in the Browser window, or in the right-hand panel of the Reviews view, click on the2.
element to be reviewed.

The element name displays on the 'Review' tab; right-click on the name and select the 'Create Approver' menu3.
option. The 'Create Approver' dialog displays.

Click on the Add button and - in the list - double-click on the name of the required Approver. If you want to add4.
more than one Approver, click on the Add button again and select the next Approver.

Click on the Create button. The name of each Approver is added as a separate item to the element in both the5.
Reviews view and the 'Review' tab; if this is not visible, click on the expansion arrow for the element. The
Approvers are listed in alphabetical order.

When an Element Has Approvers

In the 'Review' tab the message 0 out of <n> Approvals displays under the element name, followed by a user name item
for each of the assigned Approvers. In the message, 0 is the count of approvals registered, and <n> is the number of
Approvers required to approve the review of the element. If no Approvers have been assigned, no message displays.

As the review progresses, the Approver(s) will monitor the process until the appropriate point to change the status (from
'Open' to 'Alert' or 'Accept', usually) is reached. The Approver changes the status by right-clicking on their name in the
'Review' tab and selecting the appropriate value.

If there are two or more Approvers, when one changes the status a standard message is automatically sent by Model Mail
to the other Approvers, in this form:

<approver name> has updated the Approval Status for <element_name> in the review Review - <name>.

The status has changed from <original status> to <new status>.

Please check the Review item and action as required.

A link to the element under review enables the Approver to access the element directly.

Alternatively, rather than send a message to indicate they have taken action, an Approver might want to remind another
Approver to take action. In this case, in the Reviews view, the first Approver would right-click on the required Approver
name and select the 'Send Approval Reminder' option. A standard message is displayed and, if required, the sender can
add further text and/or additional addressees. The standard message has this format:

A reminder that you are an Approver on the item <element name> and action may now be required as part of that
Review.

Please check the Review item and action as required.

Again, the recipient has a link to the element under review, to access it directly.
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Locate Review Elements

In order to join a review, you have to list the available Review elements and locate the appropriate one. There are a few
options for doing this.

From the Reviews View

Either:

Select the 'Start > Collaborate > Review > Manage Reviews' ribbon option, or·

In the Discuss & Review window, on the 'Review' tab, click on the  icon and select the 'Manage Reviews' option·
The Reviews view displays, showing the Review elements that exist in the model grouped according to their 'Status'
value, in alphabetical order.

Click on the Review you require and, in the right-hand panel, expand and explore the review for the elements in that
review. The currently-selected item is displayed in the 'Review' tab of the Discuss & Review window.

Further information on the Reviews view is provided in the Manage Reviews Help topic.

Using the  icon you can also get information on a selected review by selecting:

'Current Review Details' to display the discussion history of your current Active review, and to show the details of·
the elements reviewed

'Find Current Review in Browser' to locate your Active Review element in the Browser window·

From the Discuss & Review Window, Review Tab

The 'Review' tab is usually the point at which you begin working on a Review that you have located and joined.
However, you can also use an option on this tab to locate all reviews with the status of Active, and join a selected review
immediately.

Either:

Click on the  icon in the tab heading  and select the 'Join Review' menu option or·
Right-click on the body of the display and select the 'Find Review to Join' menu option·

In either case the 'Select Active Review' dialog displays, listing the Active reviews in the project.
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Before you actually join a review, consider how much work you intend to do on the review, when you intend to do it, and
how inconvenient it might be to locate and join the review again in a subsequent work session. If you would prefer to:

Automatically be joined to the review when you log in again to another work session, clear the 'Disconnect when I·
log out' checkbox

Leave the review when you log out and manually rejoin it at some later time, leave the 'Disconnect when I log out'·
checkbox selected

Now click on the review you want to join, and click on the Join button. The dialog closes and you are joined to the
review.

From Reports

Enterprise Architect provides six reports on Review and Discussion items, which you can access from the Start Page
'Search in Project' tab.

Select the 'Discussions' option in the drop-down list in the third field, and then click on the drop-down arrow in the
second field and select one of these reports:

Recently Discussed Elements - lists the elements that have recently been discussed in reviews·
Recent Element Posts - lists the recent discussion comments that have been posted against elements under review·
Review - lists the Review elements that exist in the model·
Recently Modified Reviews - generates a list of Review elements that have been recently created or modified·
Recently Discussed Reviews - generates a list of Review elements in which discussions have taken place·
Open Reviews - generates a list of Review elements with the status 'Open', which can be joined for discussion·

When you have located your required Review, either:

Click on it to display the Review in the 'Review' tab of the Discuss & Review window, or·
Double-click on it to display the Review details in the Review view·
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Join a Review

When a review is first set up, the person managing the review will send an email inviting the reviewers to join it. This
email is likely to contain links to the Review diagram and the Review element in the Browser window. You can use
those links to highlight the object:

In the Browser window (mouse over the link and click on the  icon)·

In the Review diagram (mouse over the link and click on the  icon), or·
In the Review view (double-click on the link)·

Having located the object, you can join the review on it in a number of ways, both at this initial point and at any
subsequent time when you want to work on the review, as outlined in the sections of this topic. When you join the
review, the Discuss & Review window displays at the 'Review' tab; the name of the Review element then becomes the
button name at the top of the screen, and the name of the selected element being reviewed displays beneath that.

From the Browser Window

Right-click on the Review element in the Browser window and select the 'Join Review' context menu option.
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From the Review Diagram

Right-click on the Review element in the diagram and select the 'Join Review' context menu option.

From the Reviews View

Click on the Review element in the Review view and select the 'Join Review' context menu option. This makes the
Review your Active Review, and the element name displays in bold.

In subsequent work sessions, to display the Review view, select the 'Start > Collaborate > Review > Manage Reviews'
ribbon option.

From the Discuss & Review Window, Review Tab

The Discuss & Review window 'Review' tab is where a joined Review begins, but if you have the tab displayed with no
Review element listed at the top, you can locate all Reviews with the status of 'Active', and join one of them.

Either:

Click on the  icon in the tab heading  and select the 'Join Review' menu option or·
Right-click on the body of the display and select the 'Find Review to Join' menu option·

In either case the 'Select Active Review' dialog displays, listing the Active reviews in the project.

Before you actually join a review, consider how much work you intend to do on the review, when you intend to do it, and
how inconvenient it might be to locate and join the review again in a subsequent work session. If you would prefer to:

Automatically join to the review when logging in for a new work session, clear the 'Disconnect when I log out'·
checkbox

Leave the review when you log out and manually rejoin it at some later time, leave the 'Disconnect when I log out'·
checkbox selected

Now click on the review you want to join, and click on the Join button. The dialog closes and you are joined to the
review.

Note that you can also right-click on the dialog and select the 'Join Review' menu option. There is also an option in the
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menu to locate the Review element in the Browser window.

Result of Joining

When you have joined a review, that is your Active review and the Review element links to the review topics and posts
you create. You can create discussion topics, reply to other users' discussion topics, and adjust the status and priority of
each discussion. See the Take Part in a Review Help topic.

When you have completed your review work, select the 'Leave Review' context menu option or log out. However, note
that the result of logging out depends on the setting of the 'Disconnect when I log out' option in the ' Select Active
Review' dialog, as explained in the From the Discuss & Review Window, Review Tab section.
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Take Part in a Review

After you have joined a review, you create and respond to discussion topics on the 'Review' tab of the Discuss & Review
window (if it is not currently displayed, select the 'Start > Collaborate > Review > Review' ribbon option, or press Ctrl+9
and select the 'Review' tab). Initially, this only displays the name of the Review element.

You then select the element to review, or the Navigation Cell for the diagram to review, in the:

Review diagram·
Reviews view·
Browser window (and right-click on the object | Collaborate | Review)·
Non-Review diagram (and right-click on the object | Collaborate | Review)·

This makes the selected model object the focus of the Discuss & Review window 'Review' tab. Any existing review
topics for the object display in the body of the window in reverse date/time order, with the most recent topic at the top of
the list.

Contributing to a Review

To create a topic for review or make a response to a topic, use the guidelines provided in this table.

Operation Action

Create a Review Topic Below the element name, but above any existing review conversation, the message
Create Review Topic displays. Note that an element under review can be locked
against posting any further topics or responses, according to the element's status. In
this case the message This Review is now <status triggering the lock> and cannot
be updated displays instead.

Double-click on the Create Review Topic message and type your topic as
continuous text. The text automatically wraps at the border of the Discuss &
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Review window.

There is an option on the Preferences window, 'Window Behavior' page that sets
whether to use either the Enter key or the Ctrl+Enter keys to submit a topic or post.
Whichever you select, you can use the alternative option to break and insert a new
line in your topic text.

When you have finished typing, click off the text or press the Enter key (or
Ctrl+Enter keys).

An open expansion arrow and a  icon display at the start of your text, and·
your user name, the time or date of posting and the number of replies (initially
zero) display beneath your text

The message Create Review Topic displays above your current discussion·
topic, and the message Post reply displays underneath the topic

If user security is enabled and you have selected to show avatars, the discussion
icon is replaced by an image representing the user who contributed that item. If the
user does not have a personal avatar image, a default 'head and shoulders' silhouette
displays as the avatar.

Note that your text might contain words that are automatically underlined. These
are terms for which a Glossary definition has been created, and positioning the
cursor over one of these words will display the definition in a pop-up message box.
If you do not want to indicate glossary terms, right-click on the message and click
on the 'Highlight Glossary Terms' menu option. This will clear the automatic
underlines across the system. Do this again if you want to restore the underlines.

Add a Response You enter a reply to a Review topic by clicking on the expansion arrow next to the
Review item. This changes the display to show just the selected Review topic at the
top of the window and any existing responses to that topic underneath it, after a line
broken by the text Open, n Posts.

You then press the Enter key to place the cursor at the start of the text entry field at
the top of the tab. Either:

Type your response in the test entry field, or·
Press Ctrl+Spacebar and type the text in the 'Post Reply' text box, then press·
the Esc key to close the text box

Click on the Post button on the right of the text entry field.

The response displays at the top of the list of replies·
Your user name displays above the response, with your avatar to the left of it·
(and subsequently the date of posting displays on the right)

The time of posting displays on the left of the response·
As more responses accumulate, the Post count increments·

All new replies are added underneath the Review thread they are in response to. All
responses you make before someone else posts are grouped together underneath
your user name.

To return to the Review list mode, click on the large arrow to the left of the reply
text box.

Edit Postings Whilst you are typing a message, the editor automatically checks the spelling and
underlines possible spelling errors in red. You can backspace or move the cursor to
the errors to correct them. You can also move the cursor anywhere in the message
body and add or delete text (press the Delete key).

Once you have posted a message, you can delete the whole message but you cannot
edit it.

Search Reviews Right-click on the body of the 'Review' tab (in list mode for an element) and click
on the 'Search Reviews' option. The Create Review Topic text changes to Enter text
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to search reviews.

Double-click on that message and then type in the text you want to locate in any
Review topics for the selected element. Press the Enter key.

The system runs a search for any topic that either contains that text or has a post
(reply) that contains the text. The search results are listed in the tab, under the text
Displaying search results for term <search term>. You can double-click on this
row to type a new search term and re-run the search.

Clicking on a review item in the search list switches to the 'post reply' mode, where
you can read the original topic and all responses to it. Clicking on the large arrow
button returns you to the list of search results.

To return to the normal list of review items for an element, either press the Esc key,
reload the tab, change context, or right-click and click on the 'Search Reviews'
option again.

Copy Review Topic Text If you want to re-use some or all of the text of a saved Review posting, you can
open the text in a (read only) pop-up dialog, by pressing Ctrl+Space.  You can then
select the text you want and press Ctrl+C to copy it to the clipboard.

The copied text can then be pasted into a new Review posting or into another
document in Enterprise Architect.

Set Review Topic Status A new review topic has the status of 'Open'. To change the status, right-click on the
item and select 'Status' and:

Alert·
Error·
Accept·
Reject, or·
Closed·

If the review topic already has one of these statuses, you can also select the 'Status |

Open' option to return the topic to 'Open' status, indicated by the  icon.

Set Review Topic Priority As part of the review, you might want to identify the priority of a point being
raised. It might be very important to act on the point, or it might be agreed that the
point discusses a 'nice to have' feature that could be addressed at a later date. To set
the priority, right-click on the review topic and select one of the options:

'Priority | High' ( )·

'Priority | Medium' ( ), or·

'Priority | Low' ( )·
Alternatively, if you decide that an item does not need to be prioritized, select the
'Priority | <none>' option. This leaves the item icon as .

Set Approval Status Only the named Approver is able to change the status or priority of their Approver
item. To set the status, the Approver right-clicks on their Approver item and can
select the same options as for a reviewer. However, the final option in this case is
'Approved', which indicates that the selected element has completed review and all
decisions and defined changes are approved.

If the Approver selects the 'Approved' option, the indicator  then displays to the
right of the item and the 0 out of <n> Approvals message is incremented to show
that the element has received one of the required Approvals.

Delete a Review Topic or
Reply

Right-click on the review topic or a reply, and select the 'Delete Selected' menu
option. A prompt displays to confirm the deletion. Click on the Yes button.
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If you delete a review topic, all replies associated with that topic will be deleted as
well.
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Manage Reviews

You manage reviews using the Reviews view, which lists all the Review elements in your model in the left-hand
'Review' panel with - for a selected Review element - the details of the elements and diagrams under review in the
right-hand panel. This allows you to quickly see what reviews are taking place and what is happening within any review
you want to explore.

Access

Ribbon Start > Collaborate > Review > Manage Reviews

Context Menu On a Review element on a diagram or in the Browser window, right-click and select
the 'Properties | Special Action' menu option.

Keyboard Shortcuts In the Browser window, click on an existing Review element and press Shift +·
Enter

On a diagram, click on a Review element and press Enter, or double-click on·
the element

Other In the Discuss & Review window, click on the 'Review' tab and on the 'In Review'
button, and select the 'Manage Reviews' option.

Joining and Leaving Reviews

If you are already joined to a review, that Review element is displayed in the list in bold.

Otherwise, you can join a review by right-clicking on the Review element name and selecting the 'Join Review' option.
Equally, you can leave your active review by right-clicking on it and selecting the 'Leave Review' option.

If you cannot locate a review that covers the objects you want to assess, you can also create a new review based on an
existing selected Package. Select the Package in the Browser window and then right-click on the Review view and select
the 'New Review' option. The 'Create Review' dialog displays; see the Create a Review Element Help topic.

Viewing Information

The columns of the display show a number of properties of the Review element, the Review diagrams, and each object in
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the review. Depending on which column headings you choose to display using the 'Field Chooser' menu option, these
properties can include the start and end dates of the review period, the number of topics posted for the diagram and for
each object, the number of those topics of each status, and the number of topics and replies posted within various periods
of time. As well as choosing which columns to display, you can change the sequence of the columns by dragging the
column headings across the heading band.

You can right-click on:

An object name to display the object's Review topics and comments on the 'Review' tab of the Discuss & Review·
window

A Review element or Topic-level element to expand the branch or expand the whole display, or collapse the exposed·
contents

An object name to find the object in the Browser window (or double-click on the item); this also opens the Discuss·
& Review window for the object

An element name to locate any diagrams that contain the element·
An element name to display the Test Cases window, Maintenance window and/or Resource Allocation window,·
showing tests, maintenance items and resources associated with that element

A diagram name to select the 'Open' option to display the diagram·
The window and select the 'Refresh' option to refresh the list, to include any review topics that have been posted·
since you opened the review

You can also filter the display from the 'Review' panel, by double-clicking on a property. The right-hand panel then
displays the information specific to that property. For example, if you were to double click on the 'Alert' property in this
Review panel, the information shown relates to just that property.

Review Sets

Click on the Review item you have joined, and check the objects under that review in the right-hand panel.

For each Review element there is at least one segment or 'set' of objects; the first set identifies the objects added to the
Review diagram, to be reviewed. There can be other sets of objects that are identified on other Review diagrams
identified to the review.

You can add such sets of objects on their diagram by right-clicking on the Review element name and selecting the 'Add
Review Set' option. The 'Add Review Set' dialog displays, on which you specify the name of the new diagram. Click on
the OK button. The diagram is created as a child of the Review element in the Browser window, and its name is added
under the Review element name in the Review view. You can then populate the diagram with elements and/or diagram
Navigation Cells to form a set to be reviewed as part of this review. Each Navigation Cell effectively defines a Review
Set of elements itself.

The final segment (labeled 'General') identifies any review activity on the Review element itself, or on any other
elements in the model that are added to the review but not included on a Review diagram.

Locking Elements Under Review
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Towards the final stages of a review of an element, the review managers might want to collate information before
inviting final comments, approval or sign-off. Or they might close off the review of the element altogether and not allow
further comments. In such scenarios, the review managers can set one or more status values at which an element under
review will be automatically locked against the posting of review topics and replies. According to the way the managers
want to progress elements through stages, the element under review might be assigned a subsequent status - or revert to a
previous status - that did not lock the element against review comments.

You set up the locking status for elements under review using the 'Review Status Locks' page of the 'Manage Model
Options' dialog. See the Review Status Locks Page Help topic. You can also examine the status locks on that page by
right-clicking on the Review view and selecting the 'Review Status Locks' option.

In the Reviews view, if an element under review is locked because of its status but it has not been fully approved, its
element-type graphic has a red circular icon overlaid by an exclamation point. If the item is expanded, it shows a
message under the element name and above the Approver names. These indicators are illustrated here:
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Discuss & Review - History Window

The Discuss & Review History window provides a simple yet comprehensive summary of the Journal, Chat, Discussion
and Review messages sent and received in the model. Each category of message is presented on a separate tab, showing
details such as the name of the element under discussion, the date the message was posted, and in some cases the opening
text of the post. You can perform operations either on individual items or on the list as a whole, and double-click on an
item in one of the lists to display that item as the focus of the Discuss & Review window.

Access

Ribbon Start > Collaborate > Discuss > Discussion History

Start > Collaborate > Review > Review History

Start > Collaborate > Journal > Journal History

Start > Collaborate > Chat > Chat History

Start > All Windows > Collaborate > Histories > <appropriate option>

Keyboard Shortcuts Alt+3 > Histories > <appropriate option>

Ctrl+Alt+9 > <appropriate tab>

The Journals tab

The 'Journals' tab lists the elements across the model against which comments have been posted, showing details of each
element and the date on which the comment was posted.

On this tab, apart from using the context menu options described in the General Features table, you can also
double-click on an item to open its comments in the Discuss & Review window. You can then add to or edit text in any
comment posted on the element. You can also edit the comments in the preview pane, one of the features discussed in the
General Features table.

For further information on journal entries, see the The Journal Window Help topic.

The Discussions tab

The 'Discussions' tab shows the Discussions that have been recorded on elements across the model, listing the elements
under discussion and showing the text of the topic created against that element. Where there is more than one topic, the
element is listed again for each topic. The tab does not list discussions concerning diagrams.

On this tab, apart from using the context menu options described in the General Features table, you can also
double-click on an item both to open the Discussion topic in the  Discuss & Review window and, at the same time, to
highlight the element under discussion in the Browser window. Note that the timeframe in the  Discuss & Review
window must be able to accommodate the age of the posting; if you have listed Discussions from last month and the
timeframe in the  Discuss & Review window is three days, the Discussion topic will not display.

For further information on Discussions, see the Model Discussions Help topic.

The Reviews tab
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The 'Reviews' tab shows the activity in Formal Reviews across the model, listing the items in which activity has
occurred.

On this tab, apart from using the context menu options described in the General Features table, you can also
double-click on an item both to open its Review discussion in the Discuss & Review window and, at the same time, to
highlight the element under review in the Browser window.

The information includes the name of the topic reviewer.  Note that where the 'Review Topic' field shows a user name, it
indicates that the posting was to add that user as an Approver (effectively, the user name is the text of the discussion).
Also note that the 'Role' column identifies which items are Approver activities and which Reviewer activities.

For further information on Review discussions, see the Model Reviews Help topic.

The Chat tab

The 'Chat' tab lists the Chat conversations that you have been a party to. These conversations can be between yourself
and one other user, or those where you have participated in a Chat with one or more members of a user group. A user in
the Admin user group can open any other Chat user group and join the Chat of that group, without being a defined
member. So even though I'm not a member of, say, Team Green, if I am a member of Admin I can still join and review
that Chat group.

The 'Chat' tab defaults to the 'Summary' list (no timeframe), showing the last conversation you have had with each user
or user group you have communicated with, and the last of your correspondents to send or receive a post in that
conversation.

For a non-Admin user these Chats will be within the User Groups for which you are a defined member·
For an Admin user the Chats will be from every User group·

A red arrow next to the user's name indicates that the person sent you a message, and a green arrow indicates that you
sent a message to that person - the icons are very visible and enable you to tell at a glance which conversations might
require a response from you.

You can change the focus of the list by right-clicking on the panel and selecting the 'Visible Timeframe' option, and an
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option from the submenu. For an Admin user, the list of Chats is now confined to those groups that you are a defined
member of. The tab then shows the number of messages posted in each conversation - in the 'Total' column - and the
names of the participants and the number of posts made by each person - in the 'Participants' column. You can also
double-click on an item to display the complete conversation in the Chat & Mail window, as long as the window has
been set to display posts from the appropriate number of days in the past.

Both 'Summary' and 'Visible Timeframe' options will include recent Chats in conversations between single users.

For further information on Model Chats, see the Model Chat Help topic.

General Features

When the Discuss & Review - History window displays, it lists the items in which activity has occurred in date/time
order. On the tabs the items for today are listed first, in the Today group, followed in sequence by the items active This
Month, Last Month and earlier (Older).

The Discuss & Review - History window automatically refreshes after a short interval, which you define. You might
notice the window flicker when it refreshes.

The tabs default to displaying a number of columns, as shown in the earlier illustrations, but you can remove information
you don't need by dragging column headings out, and add information by right-clicking on the heading row, selecting the
'Field Chooser' option and dragging additional column headings into place. You can also filter the display according to
field value, and regroup the items by setting up a group and subgroup hierarchy in the Group Box. For more information
on tailoring the headings and content, see the List Header Help topic.

Option Description

Review Select this option to open the Discuss & Review window at the 'Review' tab and/or
load the selected element as the element in focus.

Manage Reviews Select this option to display the details of all reviews recorded in the model, in the
Reviews view.

Go to this Discussion On the 'Reviews' tab, this option opens the Discuss & Review window at the
'Review' tab and/or loads the topic thread for the selected element.

Alternatively, click on the item and press the Spacebar.

Discuss On the 'Discussions' tab, this option opens the 'Discuss' tab of the Discuss &
Review window and/or displays the discussion topics for the selected element.
Alternatively, click on the item and press the Enter key.

Open If the object under discussion or review is a diagram, this option opens the diagram
as a tab of the main work area.

Journal Entries On the 'Journals' tab, this option opens the 'Journal' tab of the Discuss & Review
window and/or displays the Journal entries for the selected element.

Edit Discussion On the 'Discussions' tab, select this option to display the Discussion in the 'Discuss'
tab of the Discuss & Review window. You can then set the priority or status, delete
a post or add a further discussion topic or response.

Chat This option opens the 'Chat' tab of the Chat & Mail window and displays the topics
for the selected Chat.

Properties Select this option to display the properties of the selected element under discussion
or review, in the 'Properties' dialog.
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Find in Project Browser This option locates and highlights the element in the Browser window.

Find in Diagrams This option locates and selects the selected element in any diagram in which it has
been used. If the element has been used in more than one diagram, the diagrams are
listed in the 'Element Usage' dialog and you can select from that list. The empty
dialog is also displayed if the element is not used in any diagram.

Visible Timeframe Select this option to display a short menu of numbers of days, from which you can
select a value to list items recorded up to that many days in the past. You can
therefore expand or reduce your list of posted messages.

The 'Summary' option is provided on the 'Chat' tab.

Check for Update Every This option displays a short menu of time options - 1, 2, 5 or 10 minutes - as the
interval between automatic refreshes to pick up new postings. Click on the interval
you want to apply.

On the 'Journal' tab, if you are working in a local or .qea file, this menu also has an
'Enabled' option that you select to allow refresh of the Journal list, or de-select to
prevent refresh of the list.

Show by Status On the 'Reviews' tab, select this option to list either all the Review comments (the
'All' sub-option) or only those against elements having a selected element status.

When you select the 'Configure' option, a dialog displays listing all the possible
status values for the element. Click on the checkbox against each status value you
want to filter the displayed items for. You can click on the Select All or Clear All
buttons to select or clear all checkboxes and reset one or two of them.

When you have made your selection, click on the OK button to filter the elements
under review.

Filter Approvals On the 'Reviews' tab, select this option to set or clear a filter on the list of Reviews
according to the assignment of Approvers to the review items. Select:

Approvals Only - to list only items that have assigned Approvers·
My Approvals - to list only items where you are an assigned Approver·
Hide All Approvals - to hide all items that have assigned Approvers·
No Filter - to remove the filter and list all items, with or without assigned·
Approvers

You can set filters on topics and approvers at the same time.

Filter Topics Select this option to filter the list of topics to show only your own topics, or all
topics except your own. If you have set one of these options, you can also select an
option to remove the filter.

You can set filters on topics and approvers at the same time.

Show All Posts On the 'Reviews' tab and 'Discussions' tab, select this option to show all
Discussions posted, not just the most recent one.

Show Preview Pane Select this option to open a pane on the left or right of the window, or at the bottom
of the window, displaying the text of the currently-selected review topic, discussion
thread or Journal item. As you click on different items in the window, the text in the
pane immediately reflects the new selected item. You can also hide the preview
pane if you no longer need it.

You can edit comments that you have created previously, in the preview pane as
well as in the Discuss & Review window.
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Refresh This option will refresh and redisplay the currently-selected tab of the Discuss &
Review window. You can also press F5 to refresh the contents of the window.

Set This Tab as Default Select this option to set the Discuss & Review History window at the current tab to
automatically redisplay when you log back in to the model in a new work session.
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Model Chat

The 'Chat' tab on the Chat & Mail window provides an extremely useful facility of following and participating in quick
conversations on a point of interest, with members of a selected user group. The user group can contain a number of
users and is defined in User Security, which must be enabled in order for the Chat facility to be available.

You can also select an individual user to chat with; each model user - also as defined in User Security - is nominally a
Chat group of one.

Each initial comment or response is a separate message, listed in date/time order, with the most recent message at the top
of the list. The messages are independent of the currently selected model object and the full list displays whenever the
user group is selected in the 'Chat' tab. As the messages are independent of any model object, they do not appear in the
'Recently Discussed Elements' report, which is element-based.

If you simply want to make notes for yourself, you can use the 'My Diary' tab on which you jot down any notes,
comments, reminders or references that you want to record during the day. Alternatively, you can make similar notes
about a specific element, and effectively chat with other users about that element, through the 'Journal' tab of the Discuss
& Review window.

You can filter the messages by the time interval prior to today, and you can set up a check to notify you when new
messages are posted by members of one or more user groups, including specifically-selected individual users.

This screen capture shows an example of a Chat session:

Access

Ribbon Start > Collaborate > Chat > Chat

Start > All Windows > Collaborate > Personal > Chat

Context Menu Browser window > Right-click on element > Collaborate > Chat

On diagram > Right-click on element > Collaborate > Chat

Keyboard Shortcuts Alt+3 > Personal | Chat
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Select a User Group

Initially, the button at the top of the 'Chat' tab displays the name 'Select a Discussion Group'. Click on the button and, if
you want to communicate with:

A group of several users, select the 'Group Chats' option and the name of the user group to send messages to·
A specific user, select the 'User Chats' option and either the name of a user you have already been chatting with·
previously, or the 'Select Chat Group' option to locate the specific user (on the 'Create New Discussion' dialog, click
on the With button, double-click on the name of the user in the displayed list, then click on the Create button)

The name of the currently-selected user group or user then becomes the name of the button.

If you want to communicate with a different group or user, click on the button again and select the group or user to chat
to, as before.

If you do not want to continue chatting, you can select 'Disconnect from Current Chat'.

Create a Message

Step Description

1 At the top of the 'Chat' tab, in the text field, create your message. You have two
options, direct entry or indirect entry.

In direct entry (better for short messages), type or paste your message as continuous
text (no carriage returns). The text automatically wraps at the border of the text
field. As you type, you can right-click on the text and perform the usual Notes text
operations such as formatting and setting translation flags.

If you need to break your text into paragraphs, press Ctrl+Enter at the point at
which to break the text.

In indirect entry, press Ctrl+Spacebar in the field to display a simple text window
and type or paste your Chat text there. When you have finished your message, press
the Esc key to transfer the text to the 'Chat' tab. The advantage of the indirect
method is that you can edit and format the text - especially in long messages
containing several paragraphs - without risk of accidentally submitting it
incomplete as a Chat item.

Note that your text might contain words that are automatically underlined. These
are terms for which a Glossary definition has been created, and positioning the
cursor over one of these words will display the definition in a pop-up message box.
If you do not want to indicate glossary terms, right-click on the message and click
on the 'Highlight Glossary Terms' menu option. This will clear the automatic
underlines across the system. Do this again if you want to restore the underlines.

2 Whilst you can add quite a lot of text to a Chat message, you might need to send a
larger volume of already-existing text or information in another format such as a
chart or graphic file. You can do this very simply while you are typing, by
right-clicking at the appropriate point in your text and selecting:

'Insert Document', to display a file browser to locate the document in your file·
system, or

'Insert Link to Existing Document', to display the 'Manage Chat Documents'·
dialog and select a document that has already been attached to another Chat
message

'Paste Image as Internal Document', to insert a link to an image previously·
copied onto the clipboard, such as an image asset from a diagram or a screen
capture using the Print Screen button
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After the document link is inserted, you can continue typing the rest of the Chat
message.

3 When you have completed your message in the text field, click on the Send button
or press the Enter key. The message displays at the top of the list underneath the
text field.

If you have selected to show avatars (the 'Settings > Security > Administer > User
Settings > Show user avatars' ribbon option), all messages show an image
representing the user who contributed that message. If a user does not have an
avatar image, a default 'head and shoulders' silhouette displays as the avatar.

Also, if you are chatting with members of a user group, your names are shown in
full. If you are talking to a single user, only your first name displays. There might
be more than one Steve or Dave in your user group, so the surnames identify which
is writing. In a one-to-one Chat you specifically chose to talk to, say, Dave
Brookes, so the surname is not necessary.

Review Messages

Messages you have sent or received are listed in the body of the 'Chat' tab in chronological order, with the most recent
message at the top.  If you post messages in succession, without response from another user, your messages are grouped
together in time order with the most recent at the top, and the time it was sent on the left. If the set of messages spans
more than one day, the date of posting is also displayed.

In a Chat with another individual user, the messages from each person have highlighted backgrounds, so that you can
quickly see where each user's message(s) start and finish.

Once a message has been sent, it cannot be edited. If you want to re-use the text of a message item, you can copy some or
all of the message to the clipboard by pressing Ctrl+C before you send it. You can then paste the text into a new chat
item or into another document in Enterprise Architect. Alternatively, you can copy the whole message by right-clicking
on it and selecting the 'Copy' option.

You can also delete a message by right-clicking on it and selecting the 'Delete Message' option.

Messages sent by other people to the currently-selected User Group display in your screen immediately. Messages
deleted by other users do not disappear immediately. To update your list, right-click on it and select the 'Reload
Messages' option.

Monitor User Groups for Messages

You can set the system to monitor selected user groups, and to notify you when a member of one of those user groups
posts a message whilst the 'Chat' tab is either set to a different user group or not visible. A member of the 'Administrators'
user group can add themselves to any other security group and receive notifications of posts to that group.

Note that you do not have to manually set monitoring for Chat messages posted under the IDs of individual users; these
are all monitored automatically.

The notification is a  that displays at the right of the application title bar when a message is posted from a
monitored user group. The button also displays if a message is posted in the thread you have been reading, and the 'Chat'
tab is not visible. If you still have the thread loaded in the 'Chat' tab, click on the button to redisplay the 'Chat' tab with
the new message in the thread.

The Msg button also provides a menu to indicate which group has posted the new and unread message. When you click
on a group in that menu, the 'Chat' tab displays with the appropriate thread of messages.

To set up a check for messages from a user group:
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Click on the 'Options' icon  on the right of the header of the 'Chat' tab, and select the 'Monitor Groups for new1.
Messages' option.

Select a user group to monitor. If you want to monitor more than one group, either:2.
     -  Do steps 1 and 2 again for each individual group to monitor, or
     -  Select the 'All' group to check for messages from any group

Select the 'Monitor Groups for new Messages' option again, and click on the 'Check for new Messages Every' option.3.
Click on the interval of time at which the system will check for new messages - every minute, or up to every ten
minutes.

If you want to cancel monitoring a specific group, repeat steps 1 and 2. Clicking on a selected group will deselect it.4.

If you want to cancel monitoring all of the selected groups, perform step 1 and then click on the 'None' option.5.

You can also set up a concise and very responsive mechanism on a diagram to notify you of Chat messages sent to you.
For further details, see the Collaboration Support in Diagrams Help topic.

Filter Messages by Age

The 'Options' icon provides a series of options to limit the display of messages to those posted within a certain number of
days prior to today's date.

You can select to display only messages posted today (the default), or within the last 3, 7, 30 or 90 days. The 'Today +'
option also enables you to show postings from today and the 20 most recent postings prior to today

If you do not want to limit the display of messages to an interval you have set, you can cancel it by selecting the 'All'
option.

These options are also available if you right-click on the message list and select the 'Visible Timeframe' option.

Searching the Chat Messages

The 'Chat' tab of the Chat & Mail window also provides a facility for searching through the messages for a specific text
string, and for filtering the messages to those between a certain pair of dates. For information on this facility, see the
Search Within Chats Help topic.
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Managing Chat Documents

An aspect of exchanging Chat messages about any aspect of the project is attaching related documents and similar files
to a message. At any point, you might want to check what documents you have sent and/or received and perhaps perform
some management function on them. You can do this through the 'Manage Chat Documents' dialog.

Access

Ribbon Start > Collaborate > Chat > Chat > Right-click on body of 'Chat' tab | Manage
Chat Documents

Context Menu Right-click on body of Browser window | Collaborate | Chat | Right-click on body
of 'Chat' tab | Manage Chat Documents

Dialog Fields and Options

This table explains the fields and buttons presented on the 'Manage Chat Documents' dialog.

Option Description

Currently showing ...
documents ...

A message indicating what filters and limits have been set on the display. The first
part of the display reads either:

Currently showing sent documents...     or·
Currently showing received documents...·

The second part reads either:

... documents for any chat or·

... documents limited to the active chat·

Name Displays the name of the document attached to the Chat message.
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Sender/Recipient Displays the user name of the person who sent the Chat message containing the
document to you, or received the message containing the document from you

Type Displays the file type of the document.

Size Displays the file size of the document.

Created Displays the time and date the Chat message containing the document was created
(and effectively sent).

Options Click on this button to display a list of options for filtering the display and
managing the Chat documents. These options are the same as the context menu
options for the dialog, as described in the next table.

Context Menu Options

This table describes the menu options listed when you either right-click on the dialog display or click on the Options
button.

Option Description

Load Document Opens the appropriate internal or external viewer to display the contents of the
selected document.

Save As Displays a browser dialog that enables you to save the selected document as a
different file in the appropriate location.

Detach Removes the selected document from the Chat message but not from any internal
location it is stored in.

Filter To Displays the two options to show documents either sent by you or received by you.
Click on the appropriate option.

Limit To Displays the two options to show either all documents attached to any Chat
messages in the 'Chat' tab, or just those documents attached to the
currently-selected Chat message.

Delete Removes the selected document from the Chat message and from the model.
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Search Within Chats

Within the 'Chat' tab of the Chat & Mail window, you can selectively search for historical Chats, filter the currently
displayed Chats and show Chats for a specific time period. These options are available through the Search/Filter bar,
which you can toggle on and off using the 'Toggle Filter/Search Bar' option in the context menu or the Toolbar Options
button on the far right of the window.

The default behavior is to filter the displayed items based on the search term supplied. You can apply a filter or run a
search by pressing the Enter key when the Search/Filter bar is active, or by clicking on the Spyglass icon on the far right
of the bar.

To search historical Chats you must specifically choose that option each time you want to run a search. After the results
are returned the Search/Filter bar becomes a filter again, so you can further filter the returned results.

Search/Filter Bar Options

Clicking on the  button to the left of the Search/Filter bar provides the options described here.

Option Description

Search Open Chats This is the default behavior; this option will load up all the active Chats and filter
the displayed items to those containing the term supplied. For example, if you
choose to filter on date/time or search historical Chats, choose this option to revert
to the latest conversation and filter on those displayed results.

Search Chat History This option places the Search/Filter Bar into a 'once-off search' mode that will
search for the specified term across all Chats for the active Chat group. After the
search is run, the Search/Filter bar reverts to filtering on the displayed Chat results;
that is, further filtering your search results.

To run another search across all Chats, simply choose the option again. You can
cancel running a search by pressing the Esc key, selecting the 'Search Open Chats'
option, or reloading the window.

Show Chats for a Specific
Timeframe

Selecting this option allows you to show all conversations between two chosen
dates.

When you click on the option, the 'Show Chats by Date' dialog displays.

If a Chat is currently selected in the window, the start date is that of the selected
item, which can be helpful after running a search if you want to read all the
conversations from that day forwards. Click on the drop-down arrow to the right of
the 'To' field (and, if necessary, the 'From' field) and select the required date.

Note: This option is also available via the right-click context menu on the Chat list
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control.

Clear If you have

Applied a filter, this option removes the filter and shows all items·
Just run a search, this option clears the search and shows the current items·
Run a search and then applied a filter, this option removes that filter; selecting·
'Clear' again removes the search and displays the current Chats for the
connected group

Additional Context Menu Options

After you have run a search or filtered to a specific time frame, the right-click context menu will contain these additional
options.

Option Description

Show Full Day Displays all conversations on the same day as the selected Chat. The selected Chat
will remain highlighted and visible to help provide context.

Show Context - 4 Displays the next two Chats either side of the currently selected item. This is
helpful when you want more context around the current Chat before taking further
action. For example, after running a search you might want to select an item and see
all the Chats on that given day, but you aren't quite sure if this Chat is the one you
are looking for. You can use this or the 'Show Context - 10' option to provide more
context around the given search result.

Show Context - 10 As for 'Show Context - 4', but this option shows the next 5 Chats either side of the
currently selected item.

(c) Sparx Systems 2024 Page 240 of 300 Created with Enterprise Architect



Project Build & Deploy 16 October, 2024

Model Mail

The Model Mail facility provides you with the ability to send, receive and respond to emails within the project team,
under your User Security ID, either as an individual user or as a member of a group that has a shared mail inbox. The
'Mail' tab of the Chat & Mail window shows all emails that you have received, and the 'Sent Messages' tab in the main
view shows all the emails you have created and sent. Within the facility you can re-organize, forward, delete and mark
the emails, both sent and received.

This facility is available in the Corporate, Unified and Ultimate Editions of Enterprise Architect, with User Security
enabled; the mail system uses the individual and group users defined in User Security.

Access

Ribbon Start > Collaborate > Mail > Inbox

Start > Collaborate > Mail > Sent Mail

Start > All Windows > Collaborate > Personal > Mail

Review your Model Mail Messages

If you already have the 'Mail' tab of the Chat & Mail window open, you will notice new, unread messages in the list,
displayed in bold.

Otherwise, when a new mail message arrives in your inbox, the  icon will display in the top right corner of the
screen. When you click on that, a list displays identifying that you have x number of unread Mail messages and - if
appropriate - x number of unread Chat messages. Click on the Mail message item to open the 'Mail' tab and reveal your
unread mail messages.

Option Action

Open a message Double-click on the message.

If the message contains a hyperlink, click on the link to open or display the target
file or object.

Flag Check the color of the flag to the left of the message to establish the significance of
the message (the meanings of the flag colors should be defined within the project
team).

Status
Check for the read ( ) or unread ( ) icon; unread message items are anyway
displayed in bold. If you have responded to a message, the icon includes a green

arrow ( ).

Sender The name of the project team member who sent the message.

Subject The topic of the message.

Date Indicates the age of the message, whether it was sent:

Today·
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Yesterday·
This week·
This Month·
Last Month·
Older·

Sent The exact date and time the message was sent.

Select Columns Right-click on the column headings and select the 'Field Chooser' menu option,
which enables you to add or remove specific columns from the display.

You can also click on the column headings and drag them across the header bar to
reposition the columns in a different sequence.

Adding the 'To' column will display the user account or group name that this mail
item was sent to; this column is useful to identify whether the message was sent to
you as an individual or as a member of a Group with a Shared Mail inbox - if you
received the message as a member of a shared mail group, remember that your
actions on this message will also affect all other members of this group.

Filter Columns You can filter the mail items listed by displaying the Filter Bar (right-click on the
column headings and select the 'Toggle Filter Bar' option) and typing in the value
(or partial value) to filter on.

For example, if you type your group mail account name in the filter field for the 'To'
column, you will list only those mail items sent to the group mail address, not those
sent to you as an individual.

To clear the value of a filter field, click on the blue cross against that field.

Reorganize messages in the
list

Either:

Click on a column heading to toggle sorting of list items by this column in·
ascending or descending order, or

Right-click on the column heading and select the 'Enable Group Box' option to·
organize the messages into groups

Model Mail Menu Options

These options are available from the context menu when you right-click on messages in the body of the tab.

Option Action

Compose New Message Click to open the 'New Message' tab in the main work area, through which you
create and send a mail message. Alternatively, if you have selected not to use the
main work area, the 'Model Message' dialog displays (see the 'Edit Messages in
Main Tab View' option later in this table).

You can also open the tab or dialog using the 'Start > Collaborate > Mail > Send
Message' ribbon option, or right-click on an element in the Browser window or a
diagram and select the 'Collaborate | Send Message' option.

Reply Create a response to the sender of the message, which includes a copy of the
message and any earlier messages in the thread. If you have left the 'Edit Messages
in Main Tab View' option selected, the '<message subject>' tab opens in the main
work area; otherwise, the 'Model Message' dialog displays.

(c) Sparx Systems 2024 Page 242 of 300 Created with Enterprise Architect



Project Build & Deploy 16 October, 2024

Shortcut: Ctrl+R

Reply to All Create a response to the sender of the message and the other recipients, which
includes a copy of the message and any earlier messages in the thread. If you have
left the 'Edit Messages in Main Tab View' option selected, the '<message subject>'
tab opens in the main work area; otherwise, the 'Model Message' dialog displays.

Shortcut: Ctrl+Shift+R

Forward Forward the message to other project team members with, if necessary, your own
comments. If you have left the 'Edit Messages in Main Tab View' option selected,
the '<message subject>' tab opens in the main work area; otherwise, the 'Model
Message' dialog displays.

Shortcut: Ctrl+F

Set Message Flag Select the appropriate flag color to establish the significance of the message (the
meanings of the flag colors should be defined within the project team).

You can also select:

Complete - to display a tick next to the message, indicating that any actions·
required by the message content have been taken

None - to display only a grayed outline of the message flag, with no status·
color or 'complete' tick

Mark as Unread Mark the selected messages as unread.

Shortcut: Ctrl+U

Mark as Read Mark the selected messages as read.

Shortcut: Press Ctrl+Q, or click on the message and press the R key.

Check for New Messages Refresh the message list to include any new messages waiting in the message
queue, which would otherwise not display until the automatic refresh cycle has run.

Shortcut: Ctrl+F5

Limit Mail Items To Click on this option to display a short list of time intervals - 30, 60 or 90 days - and
select one to filter the list of Mail messages to those received during that interval.
Select 'All' to remove interval filtering from the list.

Show Preview Pane Select this option to show the content of a selected message in a panel either to the
right or beneath the list of Mail messages, according to the sub-option you select.
Click on the 'Hide' sub-option to close the preview panel.

Open Sent Messages Click on this option to open the 'Sent Messages' tab in the main view of the
Enterprise Architect work area, listing the messages you have created and sent.

You can also display the 'Sent Messages' tab by selecting the 'Start > Collaborate >
Mail > Sent Mail' ribbon option.

Edit Messages in Main Tab
View

Defaults to selected to display the 'New Message' tab in the main work area, in
which you compose a new message, a reply to a message sent to you, or an
annotation on a message you are forwarding to someone else. Deselect this option
to open the free-floating 'Model Message' dialog in which you perform the same
functions.

Delete Delete a selected message or messages; you are prompted to confirm the deletion.
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Manage Your Sent Messages on the Sent Messages Tab

Option Action

Open a message Double-click on the message.

From the open message you can reply to yourself (perhaps to annotate what you
sent to the recipients), reply to yourself and all other recipients (to quickly add
more information for the same mail list), or forward the message to other team
members, using the appropriate icon in the toolbar of the message.

Flag Check the flag color to establish the significance of the message (the meanings of
the flag colors should be defined within the project team).

To Check the name(s) of the project team member(s) to whom the message was sent.

Subject The topic of the message.

Date Indicates the age of the message, whether it was sent:

Today·
Yesterday·
This week·
Last Week·
This Month·
Last Month·
Older·

Sent The exact date and time the message was sent.

Sender Show the name of the person who sent the message; that is, either you as an
individual or a member of your user group.

Select Columns Right-click on the column headings and select the 'Field Chooser' menu option,
which enables you to add or remove specific columns from the display.

You can also click on the column headings and drag them across the header bar to
reposition the columns in a different sequence.

Adding the 'Sender' column is useful to identify whether you have sent the message
as an individual, or as a member of a shared mail group.

Reorganize messages in the
list

Either:

Click on a column heading to toggle sorting of list items by this column in·
ascending or descending order, or

Right-click on the column heading and select the 'Enable Group Box' option to·
organize the messages into groups

Reply to All Right-click on the message and select the 'Reply to All' context menu option to send
a further email to yourself and the recipients of the message

The 'New Message' tab of the main work area, or the 'Model Message' dialog,
displays.
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Shortcut: Ctrl+Shift+R

Forward Right-click on the message and select the 'Forward' option to send the selected
message to other team members.

The 'New Message' tab of the main work area, or the 'Model Message' dialog,
displays.

Shortcut: Ctrl+F

Delete messages Right-click on the message and select the 'Delete' option.

You are prompted to confirm the deletion.
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Create a Message

You can use the 'New Message' tab of the main work area, or the 'Model Message' dialog, to compose messages to
project team members within the project, under your Author ID. You use the same tab or dialog to:

Reply to messages from other team members·
Forward messages to other team members·
Link model components to the message, or add hyperlinks to files or other objects of relevance·

The 'New Message' tab displays if the 'Edit Messages in Main Tab View' option is selected on the 'Mail' tab (intray) of
the Chat & Mail window. The 'Model Message' dialog displays if that option is not selected.

Access

Ribbon Start > Collaborate > Mail > Inbox

Start > Collaborate > Mail > Sent Mail

Start > All Windows > Collaborate > Personal > Mail

Start > Collaborate > Mail > Send Message  or

In a diagram or the Browser window, click on an object (or select several objects),
then Start > Collaborate > Mail > Send Message with Link

Context Menu In a diagram or the Browser window, right-click on an object (or select several
objects) | Collaborate | Send Message

Create a New Message or Reply to a Message

Step Action

1 If you have selected one or more elements before selecting the context menu 'Send Message' option or
ribbon 'Send Message with Link' option, the message editor screen immediately displays with links to
each selected object. The recipient of the message will be able to press Ctrl and click on each link to open
the 'Properties' dialog for the corresponding object.

2 Otherwise, the 'Mail' tab of the Chat & Mail window displays. Select the appropriate context menu option
to create or open and reply to or forward a message.

The message editor screen displays.

3 If you are creating or forwarding a message, or you want to send a reply to a wider audience, for each
person you intend to send the message to:

Click on the To: button·
A list of project team member and group IDs displays

Scroll to the required name and double-click on it·
The name is added to the 'To:' field

4 In the 'Subject' field, type or edit the subject of the message as necessary.

In the 'Flag' field click on the drop-down arrow and on the appropriate flag color or option for your
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5 message.

6 In the text panel, write the text of your message.

You can format the text using the facilities of the 'Notes' toolbar at the top of the field.

7 If you intend to link a (further) diagram or model object to this message, place the cursor at the
appropriate position in your message text, click on the object in the Browser window, and click on the
Insert Quick Link button.

A short menu displays, listing the name of the object  you have selected or 'Other' to search for and select
another object. To link to the object you selected, click on its name; a hyperlink to that object is inserted
in the message text.

8 If you intend to link to some other object, or you want to link to another target such as a file, Model
Search or Library message, click on either:

The 'Hyperlink' icon in the message (or Notes) toolbar or·
The Insert Quick Link button and select the 'Other' option·

The 'Hyperlink Details' dialog displays; create the required link.

9 Click on the Send button to send the message to the recipients.

Notes

This facility is available in the Corporate, Unified and Ultimate Editions of Enterprise Architect, with User Security·
enabled (Security provides the user names to address your mail message to)

Once you have sent a message, it is listed on the 'Sent' tab in the main work area; in the 'Mail' tab, right-click and·
select 'Open Sent Messages' to display the 'Sent' tab

Your text might contain words that are automatically underlined, these being terms for which a Glossary definition·
has been created - positioning the cursor over one of these words will display the definition in a pop-up message
box; if you do not want to indicate glossary terms, right-click on the text and click on the 'Highlight Glossary Terms'
menu option to clear (and restore) the automatic underlines across the system
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Your Model Diary

Enterprise Architect provides a great facility for maintaining a personal daily diary, in which you can type all kinds of
ideas, comments, notes, suggestions, events, to-do lists and other reminders of what you have done or intend to do within
the model. This is a good way to keep the momentum flowing day to day. The facility is simple to use, allowing you to
quickly jot down your thoughts as they occur to you.

The 'My Diary' tab is part of the Chat & Mail window, which allows you to take notes as you engage in formal or
informal discussions and chats with other team members, as well as during your work on other screens and dialogs.

Because the Diary entries are specific to your login, this facility is only available within a model for which User Security
has been enabled.

Access

Ribbon Start > Personal > My Diary

Start > All Windows > Collaborate > Personal | My Diary

Keyboard Shortcuts Alt+3 > Personal | Diary

Creating the first Diary Entry

When you first access the 'My Diary' tab, it has the single entry 'Today' in the 'Date' column. You can type freely in the
'Diary' column against 'Today', including carriage returns and text formatting. Right-click on selected text to access the
editing options, which include:

Creating a Glossary definition from the text, and inserting existing definitions in the text·
Generating a new element in the same Package, with the selected text as the name and linked to the text·
Creating a link from the selected text to an existing element in the model·
Creating a hyperlink to a wide range of target objects, including image files, diagram images, web pages, text files,·
Help topics and Enterprise Architect commands

Marking selected text for special translation, or to be omitted from automatic translation·
Searching for instances of the selected text in a range of sources (options derived from the 'Code Editor' context·
menu)

Undoing the latest change to the text·
Editing the text, with cut, copy, paste and delete, selecting all the Diary entry text entered for a day, setting fonts,·
and setting paragraph format

Printing the selected text, and checking meanings and synonyms using the online Thesaurus·
Either highlighting terms that have been defined in the Glossary, or turning highlighting off·

(c) Sparx Systems 2024 Page 248 of 300 Created with Enterprise Architect



Project Build & Deploy 16 October, 2024

When you have finished typing your note, click off that entry.

You can return to the Diary entry at any time and:

Add further notes; you use the same entry to record all your notes and comments on the element throughout the day·
Edit the existing text, including reformatting·
Delete text or complete notes; select the text and click on the Delete key or use the 'Delete' context menu option·

Diary Entries Each Day

Every day, when you open Enterprise Architect and the 'My Diary' tab, it has a 'Today' item at the top, against which you
record the day's Diary entries. Beneath the 'Today' item are the entries for previous days, identified by the date on which
you made them. This only lists dates on which you have made an entry; there are no blank lines for days on which you
did not make an entry.

As well as formatting and editing today's entry, you can edit the entries for previous days. This means you can remove
information that is no longer relevant (such as old reminders) or things you listed to be achieved that you have now
completed. On the other hand, you can also highlight entries that are still significant, and refer back to them from the
'Today' entry.

To help you review your Diary entries, you can show all the entries you have made or restrict the list to the last 1, 3, 7,
15 or 30 that you made. To set the number of entries, right-click on the body of the 'My Diary' tab, select the 'Show this
many entries' option and click on the required number.
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The Model Library

If the project team members require a forum in which to discuss the development and progress of the project - including
holding documents such as specifications, requirements and project guidelines - they can make use of the facilities of the
Enterprise Architect Library window.

Access

Ribbon Start > Collaborate > Model Library

Keyboard Shortcuts Ctrl+Alt+U

Features

Feature Description

Structure A point of discussion and the responses (Comments) to that point are created as
Documents. Documents are held in Topic groups, which are in turn organized into
Categories; your organization decides on the grouping and organization of
Documents.

You can create text to explain Categories and Topics, and you can create and
respond to Documents and Comments on Documents.

Displays The Library window has two main displays:

The Library window itself is used to create new Categories and Topics and to·
delete messages; you operate on it by selecting options from the context menu
Each item in the hierarchy displays a mouse-over tool-tip, showing the item
title, the author's name and the date and time the item was created

The 'Team Document' tab, in the main work area, is used to create, view, edit,·
print, and comment on Documents, and to create and maintain the descriptions
of Topics and Categories
This tab has a status bar that shows the item author's name, the date and time
the item was created, and the date and time the item was last modified

Facilities Within the Library window you can:

Select to display and edit an item in the 'Team Document' tab, by clicking on·
the item name in the Library window

Search for text strings in the item titles to locate Documents on a specific·
subject, using the 'Search' icon in the toolbar of the Library window

Add resources to a Category, Topic or Document, such as diagram images and·
XMI files of Packages; these are held in a Resources folder under the selected
Library item

Link model elements, diagrams, external files and other Documents to a·
Document

Link to a Library Document from the Linked Document on an element·
Change the loading behavior of the Library window·
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Access Libraries from other projects, including those on other servers·

Specification Manager The Library window acts as a repository for the review documents generated in the
Specification Manager. These documents are automatically stored in Topics within
the Formal Reviews Category, but you can redirect documents to a different Topic
from the Library window, using the 'Bind to Project Browser Package' option.

Icons Each item in the Library window has an icon that indicates the nature or status of
the item. The meaning of each of these icons is explained here:

 - Document name·

  - Comment name·
  - Protected by password (also on Category and Topic icons); a blue icon·

indicates that a user with the password has opened the item, and a red icon
indicates that the item is locked

 - Status 'Awaiting Approval' (also on Category and Topic icons)·

 - Status 'Approved' (also on Category and Topic icons)·

  - Status 'Rejected' (also on Category and Topic icons)·

 - Category name·

  - Topic name·

  - Resources folder for a Category, Topic or Document·

  - Linked objects folder for a Category, Topic or Document·

  - Diagram or clipboard image within the Resources folder·

 - XMI file of a Package, within the Resources folder·

Notes

You can transport your Library set-up between projects, using the 'Settings > Model > Transfer > Export Reference·
Data' and 'Import Reference Data' ribbon options

(c) Sparx Systems 2024 Page 251 of 300 Created with Enterprise Architect



Project Build & Deploy 16 October, 2024

Work on Library Items

Within the Library window, you can perform a wide range of operations on the Documents and the Topics and
Categories that contain them. These operations include creating an item, commenting on a Document,
password-protecting an item so that it is not accidentally changed, accessing protected items, adding resources to an
item, and deleting an item. All of these operations are accessed through the context menu in the Library window.

Access

Open the Library window using one of the methods described here, then right-click on an item

Ribbon Start > Collaborate > Model Library

Keyboard Shortcuts Ctrl+Alt+U

Library Options

Option Action

New Category

New Topic

New Document

Add a new Category, new Topic or new Document to the Library window.

Alternatively, click on the 'New Topic' or 'New Document' icon in the window
toolbar.

New Category From
Template

New Topic From Template

New Document from
Template

Add a new Category, new Topic or new Document, based on a defined template.

New Comment Create a response to the selected Document.

Alternatively, click on the 'New Comment' icon in the window toolbar.

Rename Edit the name of the currently-selected item, in situ.

Shortcut: F2

Copy Path to Clipboard Copy the path of the currently-selected item to the clipboard.

You can then paste the path into a document or file to add the discussion to any text
concerning the item.

Shortcut: Ctrl+C

Show Contents Display the description or text of the item selected from the Library window, if the
'Team Document' tab is not yet open.

Share Resource (If anything other than a Resources folder is selected.)

Add an item into the Resources folder under the selected Category, Topic or
Document. If a Resources folder does not exist, one will be automatically created.
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Available options:

Package from Current Model·
Image of Active Diagram·
Active Profiler Report·
Bookmark Active Website·
Image from Clipboard·

Add Package From Current
Model

(If a Resources folder is selected.)

Export a Package as an XMI file from the current model as a resource of the
selected Category, Topic or Document.

You browse for and select the required Package using the 'Select <item>' dialog.

Import to Current Model (If a Package XMI file resource is selected.)

Import the resource Package to the current model.

You browse for and select the required target Package using the 'Select <item>'
dialog; the resource is imported as a child of that Package.

This is a useful option for transferring relevant Packages from the Library of one
model into another model.

Image of Active Diagram (If a Resources folder is selected.)

Add an image of the currently-displayed diagram as a resource of the selected
Category, Topic or Document.

You are prompted to provide a reference name for this image.

Active Profiler Report (If a Resources folder is selected.)

Add an active Profiler Report as a resource of the selected Category, Topic or
Document.

You are prompted to browse for and select the appropriate active report.

Image From Clipboard (If a Resources folder is selected.)

Add an image held on the clipboard as a resource of the selected Category, Topic or
Document.

View Image (If a diagram image resource is selected.)

Open the View Image window, containing an image of the selected diagram.

Alternatively, double-click on the image name.

Copy Image To Clipboard (If an image resource is selected.)

Copy the image or diagram image to the clipboard.

Refresh Category 'xyz'

Refresh Topic 'xyz'

Refresh Document 'xyz'

Refresh Comment 'xyz'

Refresh the currently-open Category, Topic, Document or Comment, getting new
Comments, Documents and Topics that other users might have created.

However, if you open a different Category, Topic or Document the Library window
always displays the latest information from the database.

Alternatively, click on the 'Refresh' icon in the window toolbar.

Reload Current Connection Reload the entire Library connection, getting new Categories, Topics and
Documents.

Assign or clear a status marker against the selected Category, Topic or Document;
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Review Status you can mark the item as:

Awaiting Approval·
Approved·
Rejected·

Or clear the marker (None).

Bind to Project Browser
Package

Bind the selected Topic to a Package in the Browser window, so that Review
Documents created in the Specification Manager for that Package are automatically
stored in the Topic.

When you select this option, the 'Select Package to Bind' dialog displays, on which
you browse for and select the Package to bind the Topic to.

Security Options Access one of three options:

'Apply Password Lock' - to display a prompt to enter a security password·
'Unlock for Editing' - to display a prompt to enter the set password so that you·
can edit the item

'Remove Password Lock' - to display a prompt for the set password, which is·
then removed

When you set the password, an exclamation mark icon is added to the Category,
Topic or Document name.

Connections... Access other Model Libraries from other Enterprise Architect models or models
located on servers.

Alternatively, click on the drop-down arrow in the 'Connection Options' field in the
window toolbar, and select one of the listed models.

Use the '<Configure Connections>' option to add and connect to additional Model
Libraries.

Options... Change the loading behavior of the Library window.

Delete Category 'xyz'

Delete Topic 'xyz'

Delete Document 'xyz'

Delete Resource 'xyz'

Delete Comment 'xyz'

Delete this Category, Topic, Document or Comment and all sub-topics and
sub-documents, or delete the resource attached to the item.

Alternatively, click on the item and press the Delete key.

A confirmation dialog displays; click on the Yes button to remove the item and any
dependent items from the Library window.
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Add a New Category

You can add new Categories to the Library window, in which to store related Topics and Documents.

Access

Ribbon Start > Collaborate > Model Library

Keyboard Shortcuts Ctrl+Alt+U

Create a Category

Step Action

1 Right-click on a blank area in the Library window and select the 'New Category' option.

A new 'Category' icon displays in the hierarchy.

2 Overtype the New Category text with the name of the Category, and click off the name.

The Category description editor displays in the 'Team Document' tab; type the appropriate Category
description, if required.

3 Add new Topics and/or resources to the Category.

Create a Category - Alternative

Step Action

1 Right-click on a blank area in the Library window and select the 'New Category from template' option.

A new 'Category' icon displays in the hierarchy.

2 Overtype the New Category text with the name of the Category, and click off the name.

The 'New Category from Template' dialog displays.

3 Click on the 'Template' drop-down arrow and select a predefined template for the Category description.
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Click on the OK button.

4 The Category description editor displays in the 'Team Document' tab; type the appropriate Category
description, if required.

5 Add new Topics and/or resources to the Category.
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Add a New Topic

In the Library window you can add new Topics to a Category, in which to store related Documents and their Comments.

Access

Ribbon Start > Collaborate > Model Library

Keyboard Shortcuts Ctrl+Alt+U

Create a new Topic

Step Action

1 Either:

Right-click on the required Category name in the Library window and select the 'New Topic' option·
Click on the Category name and click on the 'New Topic' icon in the Library window toolbar, or·
Click on the Category name and press the Ctrl+N keys·

A new 'Topic' icon displays under the Category name.

2 Overtype the New Topic text with the name of the Topic, and click off the name.

The Topic description editor displays in the 'Team Document' tab; type the appropriate Topic description,
if required.

3 Add new Documents and/or resources to the Topic.

Create a new Topic - Alternative

Step Action

1 Right-click on the required Category name in the Library window and select the 'New Topic from
Template' option.

A new 'Topic' icon displays under the Category name.

2 Overtype the New Topic text with the name of the Topic, and click off the name.

The 'New Topic from Template' dialog displays.

3 Click on the 'Template' drop-down arrow and select a predefined template for the Topic description.

Click on the OK button.

4 The Topic description editor displays in the 'Team Document' tab; type the appropriate Topic description,

(c) Sparx Systems 2024 Page 257 of 300 Created with Enterprise Architect



Project Build & Deploy 16 October, 2024

if required.

5 Add new Documents and/or resources to the Topic.

Notes

If you already have the 'Team Document' tab open, the 'New Topic from Template' dialog displays as soon as you·
select the 'New Topic from Template' menu option; you can click on and overtype the Topic name after you have
created the Topic description
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Add a New Document

Within the Library window, you can create a new Document on a Topic as either:

A blank Document·
A Document based on a predefined template, or·
A Document from a file link·

Access

Ribbon Start > Collaborate > Model Library

Keyboard Shortcuts Ctrl+Alt+U

Create a blank Document

Step Action

1 Either:

Right-click on the appropriate Topic name in the Library window and select the 'New Document'·
option

Click on the Topic name and on the 'New Document' icon in the Library window toolbar, or·
Click on the Topic name and press the Ctrl+N keys·

A new 'Document' icon displays underneath the Topic name.

2 Overtype the New Document text with the name of the Document, and click off the name.

The text editor displays in the 'Team Document' tab.

3 Type the text of the Document as required.

Create a Document based on a predefined template

Step Action

1 Right-click on the appropriate Topic name in the Library window and select the 'New Document from
template' option.

A new 'Document' icon displays in the hierarchy.

2 Overtype the New Document text with the name of the Document, and click off the name.

The 'New Document from Template' dialog displays.
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3 Click on the drop-down arrow in the 'Template' field, and select a predefined template for the Document
contents.

4 Click on the OK button.

The template structure is displayed in the 'Team Document' tab.

5 Type in or paste the text of the Document.

Create a Document based on a link to an external file

Step Action

1 Open a file browser (such as Windows Explorer) and locate the file.

2 Click on the file name and drag it onto the appropriate Topic name in the  Library window.

A new 'Document' icon is created underneath the selected Topic, and the body of the Document is shown
in the 'Team Document' tab.

A link to the source file is created at the start of the message.

3 Click twice on the New Document text in the  Library window, and overtype the text with the name of the
Document.

4 In the 'Team Document' tab, create and edit text around the file link, and add further links if required.

When you have created the Document

You can Detail

Create links from the
Document

To elements and diagrams from the:

Browser window·
Model Search·
'Views'  tab of the Focus window, or·
Package Browser·

Create links from the
Document to Library
objects

Such as:

Categories·
Topics, and·
Documents·

Create links from the
Document to external files

These links can be either in the text of the Document or on the Category, Topic or
Document in the Library window (the link is added to the Model Links folder for
the Library item).

Add resources to the It is simple and convenient to link to the resources that are the subject of discussion
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Document or that illustrate points in the discussion.

Receive Comments on the
Document from other users

The purpose of the Library window is to discuss aspects of development, so you
can expect to receive Comments on the Documents that you have posted, and to
create Comments on the material posted by your colleagues.
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Comment on a Document

You use the Library window as a forum for discussion of items and issues within the project, so when you read a
Document on a particular point (or a response to that Document) you might want to respond with your own Comment.

You can create a Comment directly from the Document you are responding to, from material that you want to use as your
response, or from a predefined document template.

Access

Ribbon Start > Collaborate > Model Library

Keyboard Shortcuts Ctrl+Alt+U

Create a Comment in the Library

Step Action

1 Either:

Right-click on the required Document (or Comment) in the Library window and select the 'New·
Comment' option

Click on the Document name and on the 'New Comment' icon in the Library window toolbar, or·
Click on the Document name and press the Ctrl+N keys·

A Re:<Documentname> entry displays underneath the Document you are replying to, and the cursor
becomes active in the 'Library' tab so that you can create and edit your response.

2 Type in, format and save the contents of the Comment.

Create a Comment from external material

Step Action

1 Open a file browser (such as Windows Explorer) and locate a file containing the material you want to use
in your response.

2 Click on the file name and drag it into the Library window, over the Document to which you are replying.

A prompt displays for you to specify whether to:

Create a new Comment containing the text of the file (the file name displays as the Comment name)·
or

Add the file to the original Document as a Model Link·

3 If necessary, edit, format and save the contents of the reply.
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Create a Comment based on a predefined template

Step Action

1 Right-click on the appropriate Document name in the Library window and select the 'New Comment from
template' option.

A new 'Comment' icon displays in the hierarchy, and the 'New Document from Template' dialog displays.

2 Click on the drop-down arrow in the 'Template' field, and select a predefined template for the 'Comment'
contents.

3 Click on the OK button.

The template structure is displayed in the 'Library' tab.

4 Type in or paste the text of the Document.

When you have created the Comment

You can Detail

Create links from the
Comment

To elements and diagrams from the:

Browser window·
Model Search·
'Views' tab of the Focus window, or·
Package Browser·

Create links from the
Comment to Library
objects

These links can be to related Libraries:

Categories·
Topics and·
Documents·

Create links from the
Comment to external files

These links can be either in the text of the Comment or on the parent Category,
Topic or Document in the Library window (the link is added to the Model Links
folder for the Library item).

Add resources to the
Comment

It is simple and convenient to link to the resources that are the subject of discussion
or that illustrate points in the discussion.

Receive replies to the
Comment from other users

The purpose of the Library window is to discuss aspects of development, so you
can expect to receive replies to the Comments that you have posted, and to create
Comments on the material posted by your colleagues.
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Protection Against Editing

When you have created a Library Category, Topic or Document containing text, the item text is exposed to change by
any user who has access to the Library window. You can protect the item against unrestricted changes by setting a
password on it. The password only refers to that item; to protect the text of Topics, Documents or Comments subordinate
to the item, you set a password on each of them as well.

When the password is set, only those users who have the password can edit that item, and only when they specifically
enter the password to unlock that item. Any other user of the Library window can still view the protected item.

The password does not protect the item from operations on the item as a whole, including being deleted.

Notes

The use of a password on an item is indicated by an exclamation mark against the item in the Library window; a·
blue icon indicates that a user with the password has opened the item, and a red icon indicates that the item is locked

When you click on an item to set a password, the item opens; you can edit the item after you have set the password,·
while it is still open

Once a password-protected item is closed, any user who wants to edit the item must first select to unlock the item for·
editing and then enter the password set on the item

Unlocking is specific to the user; the item remains locked to other users until they enter the password themselves·
If the password becomes unnecessary, you can remove it from the item·
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Edit an Item

When you have created a Category, Topic, Document or Comment, you edit the text within it using the Team Document
editor. This is based on the Document editor, which is used to edit report documents and Linked Documents throughout
Enterprise Architect.

You can also change the name of the item by selecting it, pressing F2 and typing the new name.

Access

Open the Library window using one of the methods outlined here, then double-click an item or select the item and press
the Enter key, to open the Team Document editor.

Ribbon Start > Collaborate > Model Library

Keyboard Shortcuts Ctrl+Alt+U

Option Descriptions

The editor menu option descriptions are grouped according to the actions you are performing.

Actions

Creating and importing documents

Configuring the editor page display and formatting tools shown

Incorporating stylesheets, special texts and Tables of Contents

Managing the base styles in the Normal.rtf style template file

Moving through, searching and selecting text

Formatting characters and text strings

Formatting paragraphs and text blocks

Inserting tab points

Inserting sections, columns and page breaks, and repaginating

Inserting and editing page headers and footers, and footnotes and endnotes

Inserting tables

Inserting hyperlinks and bookmarks (including using the 'New', 'Link to Existing Element' and 'Hyperlink' options
on the 'Create' context menu)

Inserting images, OLE objects, frames and drawing objects
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Printer set up and printing documents

Check spelling and use of terms

Tracking, accepting and rejecting changes to the text

Protecting document text from accidental change

Create and refer to definitions of Glossary terms in the Project Glossary (using the 'Create | Glossary Definition'
context menu option)

Notes

To undo one or more immediately previous edits, press Ctrl+Z, or select the 'Layout > Diagram > Undo' ribbon·
option; you can still undo a change even after you have saved the change

To redo one or more immediately previous undone edits, press Ctrl+Y, or select the 'Layout > Diagram > Redo'·
ribbon option
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Add Object Links

In the Library window you can create hyperlinks from a Document to any elements and diagrams that are associated with
it. This helps you to:

Rapidly navigate to the objects in the Browser window·
Access the element properties, and·
Open a diagram directly from the Library window·

You can also create links to:

Other Categories, Topics and Documents in the Library window·
External files from a file browser·

Facilities

Facility Action

Associate an element,
diagram, external file or
Library item with a
message

Drag the object over the required Category, Topic or Document in the Library
window, from the:

Browser window·
Package Browser·
'Views' tab of the Focus window·
Model Search window or·
External file browser·

To create a link to another Library window item, press Ctrl as you drag that item
over the required Category, Topic or Document.

If it does not already exist, a Model Links folder is created under the selected
Library item, and the link to the dragged object is added to the folder.

Associate an external file
with the message text

From any browser, click on and drag the file name into the text of the message.

The filename becomes a link to the file; click on it to display the contents of the
file.

The external file name also becomes a link to the file within the message when you
drag the filename onto a Topic to create a Document.

Review Options

To review an object in the Model Links folder, right-click on the object to display the navigation context menu.

Option Action

Open Open the linked diagram or external file.

Alternatively, double-click on the diagram link.

Properties Display the 'Properties' dialog for the selected element or diagram.

Alternatively, double-click on the element, attribute or operation link to open the
'Properties' dialog of the object.
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Create (Edit) Linked
Document

Either:

Open the 'New Linked Document from Template' dialog, to begin creating a·
new Linked Document on the element, or

Open the 'Linked Document Editor' to change an existing Linked Document·

Find in all Diagrams Open the diagram in which the element is used, or display a list of several diagrams
in which the element has been used.

Find in Project Browser Highlight the element or diagram in the Browser window.

Locate Item Highlight, in the Library window, the Library item linked to the message.

Alternatively, double-click on the link in the Model Links folder.

Delete Model Link
<name>

Delete the association between the Document and the object.
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Library Resources

Whilst having a discussion through the Library window, it is convenient to link to the resources that are the subject of
discussion or that illustrate points in the discussion. Such resources include:

XMI files of Packages within the current project·
Active Profiler reports·
Images of currently-active diagrams·
Images currently captured on the clipboard·
Bookmarks to currently active websites·

You can link to such resources from Category or Topic notes, or from a Document. The resource links are created in a
Resources folder underneath the selected Category, Topic or Document, as shown:

Access

Open the Library window using one of the methods outlined here, then;

     Right-click on <object> | Share Resource | <resource type>

You create the Resources folder by creating a link to a resource underneath the selected Category, Topic or Document.
Similarly, you delete the Resources folder by deleting the last resource within it. Having added a resource, you can
right-click on it and use a further context menu to:

Re-import the Package XMI files to the model or·
Display the images·

Ribbon Start > Collaborate > Model Library

Keyboard Shortcuts Ctrl+Alt+U
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Search Library

The Library window provides the facility to search the titles of all Library items, to locate items referring to a specific
subject.

Search the Library

Step Action

1
In the Library window toolbar, click on the  (Search) icon.

The search panel displays underneath the toolbar.

2 In the blank field, type the text string to search for.

3 If required, select the 'Match Case' checkbox to locate text with the same case as the search string.

4 If required, select the 'Match Whole Word' checkbox to locate only complete words that match the search
string.

5 Click on the Find button.

The search locates the first instance of the search string in the title of a Category, Topic, Document or
Comment, and displays the contents of that item in the Library window.

6 To locate further instances of the text string, click again on the Find button.

7 To close the search panel, click again on the 'Search' icon in the toolbar.
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Library Options

You can change the loading behavior of the Library window, using the 'Library Server Options' dialog. If you change the
settings, the new loading behavior is not applied until you restart the Library.

Access

Open the Team Documents window using one of the methods outlined here, then right-click in the Team Documents
window and select 'Options'.

Ribbon Start > Collaborate > Model Library

Keyboard Shortcuts Ctrl+Alt+U

Library Options

Option Action

Preload items less than Type the threshold item size (in KB) below which the items will be preloaded and
above which item data is only loaded when selected.

Load item data when
required

The fastest loading option. Library window data is only loaded on demand; for
example, when you read a Document.

Preload all data Caches the entire contents of the Library on load; this takes longer to load but, once
completed, navigating the Library window is faster.
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Library Connections

If you are modeling in a different model from the rest of your team, you can switch to Libraries from other Enterprise
Architect models, including models located on servers. This connects only to the Library for the selected model; it does
not change the model open in the Browser window or anywhere else in the system.

Access

Open the Team Documents window using one of the methods outlined here, then either:

Right-click on the Team Documents window and select 'Connections', or·
Click on the 'Connection Options' drop-down field and choose 'Configure Connections'·

Ribbon Start > Collaborate > Model Library

Keyboard Shortcuts Ctrl+Alt+U

Switch to another Library

Step Action

1 Open the Team Review Connections screen.

If the required model is not listed, click on the '<Configure Connections>' option; the 'Team Documents
Server Connections' dialog displays.

Go to Step 3.
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2 Alternatively:

Right-click anywhere in the Library window and select the 'Connections' option; the 'Team Documents
Server Connections' dialog displays.

In the list in the 'Connections' panel, select the checkbox against the appropriate model name to connect to
the Library for that model, then click on the Open button.

The connection now switches to the Library in the selected model.

If the required model is not listed, go to Step 3.

3 Select the appropriate type radio button and click on the New button.

For a project file, a browser dialog displays through which you can search for and select the·
appropriate model

For a model in an ODBC DBMS data repository, the 'Microsoft Data Link' dialog displays, through·
which you can locate and connect to the repository

For a model in a DBMS data repository, the 'Open Server Connection' dialog displays, through which·
you can locate and connect to the repository

4 When you have selected and opened or connected to the required Enterprise Architect model, and returned
to the 'Team Documents Server Connections' dialog, the model name displays in the 'Connection Name'
field and in the 'Connections' panel.

5 Select the checkbox against the model name and click on the Open button to connect to the Library for
that model.

The Library window now shows the discussions in the selected model.

Fields/Options on the 'Team Documents Server Connections' dialog

Option Action

Connection Verify the name of the selected model.

Target Verify the path to the selected model.

New Click on this button to display the list of connection types you can select as the first
step in identifying the model for a new Library connection.

Delete Click on this button to delete the currently selected connection from the
'Connections' list. There is no confirmation prompt; the connection is immediately
removed from the list.

Connections View all Library connections created; click on the checkbox against the required
connection.

Open Click on this button to switch the Library to the selected connection and to close the
dialog.
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The Model Calendar

The Project Calendar provides a project management overview in calendar format of the deployment of resources,
timeframes for tasks, and upcoming project events such as meetings and milestones. The calendar displays in the
Diagram View workspace, consisting of a:

Calendar panel, displaying months of the year·
Diary panel sectioned into days or weeks·
Toolbar at the top of the window, which enables you to define what information is displayed and how it is formatted·

Access

Ribbon Start > Collaborate > Calendar

Features

Screen area Description

Calendar Panel The Calendar panel, when viewed normally on the screen with other windows and
panels, displays a calendar of three months that by default includes the current
month.

By closing or reducing other windows and panels on the screen, and depending on
the size of your screen, you can show the months for a longer period, to a maximum
of 3 years and six months.

You can review data going back over a long period, and plan ahead well into the
future; these periods can theoretically span ten years or more, if required. To
display future or past months, either:

Click on the arrows in the names of the months on the left and right of the top·
row of months, or

Click and hold the mouse on the name of a month so that a list of months and·
years displays, then move the mouse forwards to scroll up the list or backwards
to scroll down the list; when you reach the required month, ensure that it is
highlighted and release the mouse button

On the calendar, today's date has a red border; if you have scrolled the calendar so

that today's date is not shown, click on the second icon in the toolbar ( ) to
position the current month in the top left of the calendar with today's date
highlighted.

Diary Panel The 'Diary' panel displays a set of day fields, each of which can contain one or
more markers for an event or task.

The content of the display is determined by the selections you make in the toolbar,
and principally by the object type you select from the first drop-down field:

Project Calendar·
Allocated Resources·
Project Tasks·

The structure of the display depends on the period you want to review, specified
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using the icons on the toolbar:

1 day (Project Calendar only)·
5 days (Mon - Fri) (Project Calendar only)·
7 days (Mon - Sun)·
31 days·

However, in the 'Calendar' panel you can highlight specific periods of between 1
and 7 days (Project Calendar only) and 14, 21, 28, 35 and 42 days, to display just
those periods in the 'Diary' panel.

If you select a period of between 1 and 7 days, each day is divided into one hour
time intervals; you can adjust the time intervals for these periods, using the toolbar.

For the current day, the current time is also highlighted.

Also, if you click on today's date in the 'Calendar' panel the 'Diary panel' changes to
show the shortest period (7 days or 1 day) for the object type, again with adjustable
time intervals for the times of day.

For displays of 7 or more days, you can scroll up or down to display the
information for earlier or later dates; if you scroll away from today's date, you can
return to it by right-clicking anywhere on the display and selecting the 'Show
Today' option.

Toolbar The toolbar options modify what is displayed on the 'Diary' panel, and help you to
add certain kinds of information.

The icons and fields in the toolbar, from left to right, have these functions:

Add New <object> - enables you to create a new record for an event or task·
Show Today - re-focuses the 'Diary' panel and 'Calendar' panel on today's date,·
for any object type

1, 5, 7, 31 - sets the number of days displayed in the 'Diary' panel·
First drop-down - identifies the type of information to display: Calendar·
events, allocated Resources, or Tasks

Second drop-down - identifies the type or characteristic of object to filter for·
(and depends on the value selected in the first field)

Third drop-down - identifies the subtype of event, such as Planning Meeting or·
People off sick or, for Allocated Resources, the element type to filter for

Options:·
     -  Configure Event Subtypes - displays the 'Configure Subtype' dialog,
        which you use to define categories of event to record on the Calendar
     -  Time Scale - where the display includes times of day; enables you to
        reset the time interval to numbers of minutes
     -  Show End Time - for the Project Calendar, where the times of day
        are NOT shown and an event occurs within one day, this shows or
        hides the time at which the event finishes (the start time displays
        automatically)
     -  Show Time As Clocks - toggle between showing start and end times
         in digital format and as a clock face
     -  Compress Weekend Days - in 31-day format, toggle between showing
        Saturday and Sunday as separate fields and a pair of half-fields
     -  Show ToolTips - toggle between showing and hiding mouse
        roll-over tool-tips

Notes
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The Project Calendar is available in the Corporate, Unified and Ultimate Editions of Enterprise Architect·
In the Lite Edition of Enterprise Architect, you can view Calendar entries but not change them·

(c) Sparx Systems 2024 Page 277 of 300 Created with Enterprise Architect



Project Build & Deploy 16 October, 2024

Calendar

Project Calendar is a display mode of the project Calendar facility. In Project Calendar mode, the 'Diary' panel shows a
selected period of time containing flags for each event that takes place in or through that period. These events can be, for
example, meetings, staff absences or commitments, product releases or public holidays.

You can customize the range of events that you record, using the 'Configure Subtype' dialog.

Access

Ribbon Start > Collaborate > Calendar > Project Calendar

Record an event in the Project Calendar

Step Action

1 Double-click on the required day, or the first day in a longer period.

The 'Project Event' dialog displays.

2 In the 'Subject' field, type the name of the event.

3 If the event is to take place at a specific place, in the 'Location' field type the name of the place or room.

4 In the 'Category' field, click on the drop-down arrow and select the appropriate categorization:

Event (such as an external trade show, or internal presentation)·
Meeting (whether internal or external)·
Milestone/Objective (such as a product test or release)·
People (an absence or commitment of a specific staff member)·

5 If the event is likely to occupy one complete day, select the 'All day event' checkbox; this:

Places the event icon at the top of the day field in the Diary, above any time sections·
Hides the time sections of the 'Start time' and 'End time' fields·

6 In the Start time and End time fields, specify the start and end dates and/or times of the event.

In the date section of each field, either:

Click on the drop-down arrow to display the current month and select the month and date, or·
Click on the 'spin' arrows to roll the date forwards or backwards by one day at a time·

In the time section of each field, click on the hour or minute components (which are separate) and either:

Type in the required time or·
Click on the 'spin' arrows to roll the time backwards or forwards·

7 In the 'Event Type' field, click on the drop-down arrow and select an appropriate type label for the event;
the options change depending on the value you selected for the 'Category' field.
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This provides the fill color for the event icon, as indicated by the fill box next to each option.

8 In the 'Defined as' field, click on the drop-down arrow and select the indicator for whether the event is
internal or external to your organization.

9 If the event consists of a telephone call, select the 'Phone Call' checkbox.

10 In the description field, type any notes required on the event; these display in the mouse roll-over tool-tip
for the event on the 'Diary' panel.

11 If this event repeats at regular intervals, click on the Recurrence button and complete the 'Event
Recurrence' dialog.

12 Click on the OK button to save the event and display it on the Calendar.

Define a recurring event

Step Action

1 In the 'Start' and 'End' fields, specify the start and end times of the event; click on the hour or minute
components (which are separate) and either:

Type in the required time or·
Click on the 'spin' arrows to roll the time backwards or forwards·

2 In the 'Duration' field, click on each of the day(s), hours and minutes portions and either type or 'spin' to
the required value.

The hours and minutes portions are linked to the 'Start' and 'End' fields, so that:

As you edit the 'Start' field or the 'Duration' field, the 'End' field adjusts to maintain the duration·
relative to the start time

As you edit the 'End' field, the 'Duration' field changes to match the difference between the start and·
end times

3 In the 'Recurrence pattern' panel, select the appropriate radio button for the frequency of the event.

As you select the radio button, the fields on the right of the panel change to further define when the event
recurs.

4 Select the appropriate radio buttons and field values, with this guidance:

Daily can be every 1, 2, 3, 4, 5 or 6 days, or every day of the working week·
Weekly is on one or more specific days of the week, the events being separated by a period of·
between 1 and 51 complete weeks

Monthly can be on a specific date or a specific day of the month, the events being separated by a·
period of between 1 and 11 complete months

Yearly can be on a specific date or a specific day of a specific month·

5 In the 'Range of recurrence' panel, in the 'Start' field, specify the date on which the event cycle begins.

Click on the day, month and year components (which are separate) and either:

Type in the required value or·
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Click on the 'spin' arrows to roll the date backwards or forwards·

6 Select the appropriate radio buttons to indicate that the recurrence cycle:

Has no defined end point·
Ends after a specific number of occurrences of the event (type in the number)·
Ends by a specific date (enter the date)·

7 Click on the OK button, and again on the 'Project Event' dialog.

The event icon displays at all points in the Calendar where it is scheduled to occur, as defined in the
'Event Recurrence' dialog; the recurrence is indicated by a graphic depicting two recirculating arrows.

8 If the recurrence is no longer required:

Double-click on the icon for any occurrence of the event, to display the 'Project Event' dialog·
Click on the Recurrence button to display the 'Event Recurrence' dialog·
Click on the Remove Recurrence button; the 'Event Recurrence' dialog closes·
Click on the OK button; the 'Project Event' dialog closes·

Only the first occurrence of the event remains in the Calendar.

Notes

The Project Calendar is available in the Corporate, Unified and Ultimate Editions of Enterprise Architect·
In these Editions, if security is enabled you must have 'Manage Project Calendar' permission in order to create,·
update or delete Project Calendar events; if security is not enabled, you can change data without this permission

In the Lite Edition of Enterprise Architect, you can view Calendar entries but not change them·
You can transport a calendar of defined events between projects, using the 'Settings > Model > Transfer > Export·
Reference Data' and 'Import Reference Data' ribbon options
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Configure Event Subtypes

The 'Configure Subtype' dialog enables you to define additional types of event to record on the Project Calendar, such as:

Define a new event type within a select event category·
Change an existing event type·
Delete an existing event type·

Access

Ribbon
Start > Collaborate > Calendar :  | Configure Event Subtypes

Manage the event types for your project

Step Action

1 On the 'Configure Subtype' dialog, in the 'Category' field, click on the drop-down arrow and select the
appropriate category for the event.

2 Click on the 'Type' field and type a suitable name for the event type (or select an existing event from the
list under the 'Category' field).

3 In the 'Color' field, click on the drop-down arrow and select or define a color for the event icon.

4 Click on the Save button to save the new or edited event type to the list for the specified category.

Click on the New button if you are going to create another event type.

5 If the event type is no longer required, click on the Delete button.

6 If required, you can change the sequence of the event types in the displayed list, using the 'Up Hand' and
'Down Hand' buttons at the bottom of the dialog.

7 Click on the OK button to close the dialog; any new event types are available for use in the Project
Calendar.

Notes

In the Corporate, Unified and Ultimate Editions of Enterprise Architect, if security is enabled you must have·
'Manage Project Calendar' permission in order to create or delete Project Calendar event subtypes; if security is not
enabled, you can change data without this permission

You can transport your defined event types between projects, using the 'Settings > Model > Transfer > Export·
Reference Data' and 'Import Reference Data' ribbon options
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Allocated Resources

'Allocated Resources' is a display mode of the project Calendar facility, that you can use to:

Review the allocation of resources across the project over a period of time·
Review the status of the work assigned to those resources·
Display and edit the details of the task assigned to a resource·
Allocate further resources to an element·
Delete a resource allocation from an element·
Create and send an email to the resource allocated to an element·

In 'Allocated Resources' mode, the 'Diary' panel shows the selected period of time (see the Project Calendar topic), with
at least one icon representing each element in the project to which a resource has been allocated during that period. If an
element has more than one allocated resource, each element:resource combination is represented separately.

Each icon shows the element name and resource name, and indicates the status of the assigned work with one of these
symbols:

a green square, indicating that the resource has been assigned the work·
a green tick, indicating that the resource has completed the assigned work·
a red square, indicating that the resource has not completed the assigned work·
a square divided diagonally with green and red halves, indicating that the assigned work is to be completed within·
one working day

Typically, while the work is in progress a resource is represented by:

An icon with a green square on the day the work is planned to start, and·
An icon with a red square on the day the work is planned to finish·

When the work is complete, the icons on both days display the green tick.

Resources are initially allocated to elements through the:

Resource Allocation window, or·
'Allocated Work' tab of the Personal Tasks window·

You can then edit these allocations through either of those windows or through the Allocated Resources Calendar itself.

Access

Ribbon Start > Collaborate > Calendar > Allocated Resources

Allocate Resources

Option Action

Display/edit details of an
allocated resource

Either:

Double-click on any icon for that element:resource combination, or·
Right-click on the icon and select the 'Properties' option·

The 'Assigned Resources' dialog displays, showing the details of the assignment of
the resource to a task on the element.
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This dialog has the same content, format and functions as the Resource Allocation
window, in Item mode.

Add resource to element Right-click on any icon for the element and select the 'Assign Resource to <element
name>' option.

The 'Assigned Resources' dialog displays, showing the start and end dates both set
to the date from which you selected the icon, and the 'Allocated Time' field set to
'1'; all other fields are blank.

This dialog has the same content, format and functions as the Resource Allocation
window, in Item mode.

Specify the resource and the role or task that resource is performing, and define the
period for which the resource is allocated to the element.

Message Resource Right-click on any icon for the element:resource combination and select the
'Message Resource <resource name>' option.

The 'Model Message' dialog displays, on which you create and send your message
to the resource allocated to the element.

Delete resource from
element

Right-click on any icon for the element:resource combination, and select the 'Delete
Resource from <element name>' option.

A prompt displays to confirm the deletion; click on the Yes button.

The icon and any corresponding icons for that element:resource combination are
deleted from the calendar, and the resource is no longer allocated to that element.

Locate element in diagrams
in which it is used

Right-click on any icon for the element, and select the 'Find in all Diagrams' option.

If the element is used in only one diagram, that diagram displays.

If the element is used in more than one diagram the 'Element Usage' dialog
displays, listing the diagrams in which the element occurs.

Select the required diagram and click on the Open button to display that diagram.

This option also operates on Port and Part Property Type Classifiers.

Locate element in Browser
window

Right-click on any icon for the element, and select the 'Find in Project Browser'
option.

The area of the Browser window containing the element is brought into focus and
expanded, and the element is highlighted.

Locate resource allocation
start date corresponding to
allocation end date

Firstly, click on the end date icon for the element:resource combination to highlight
it; the corresponding start date icon is also highlighted.

If the start date icon is not in view, right-click on the end date icon and select the
'Show Start/End' option; the display scrolls to show the start date and the start date
cell is highlighted.

Locate resource allocation
end date corresponding to
allocation start date

Firstly, click on the start date icon for the element:resource combination to
highlight it; the corresponding end date icon is also highlighted.

If the end date icon is not in view, right-click on the start date icon and select the
'Show Start/End' option; the display scrolls to show the end date and the end date
cell is highlighted.

Refocus display on today's
date

Right-click anywhere on the display and select the 'Show Today' option.

The display returns to today's date, which is highlighted and outlined.
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Notes

The Project Calendar is available in the Corporate, Unified and Ultimate Editions of Enterprise Architect·
In these editions, if security is enabled you must have 'Configure Resources' permission in order to allocate·
resources to or remove resources from the Project Calendar; if security is not enabled, you can change data without
this permission

In the Lite Edition of Enterprise Architect, you can view Calendar entries but not change them·
As the start and end icons for a completed task are identical, and one-day tasks have only one icon, the methods to·
show the corresponding start date or end date for an icon are also useful to show whether the icon is for a start or end
date, or for a one-day task; alternatively, double-click on the icon and review the allocation dates
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Project Tasks

Project Tasks is a display mode of the project Calendar facility, that you can use to:

Review the tasks across the project over a period of time·
Review the progress of those tasks·
Create new tasks·
Display and edit the details of the task·
Allocate a resource to a task·
Delete a task·
Create and send an email to the resource assigned to a task·
Create and send an email to the owner of the task·

In Project Tasks mode, the 'Diary' panel shows the selected period of time (see the Project Calendar topic), with at least
one icon representing each project task scheduled during that period. The icon represents an independent record of the
task - there are no comparisons or validations of the tasks. Therefore you can have separate icons for the same task, with
different resources allocated or no resources allocated; you can even have identical task records, if these serve a purpose
for you.

Each icon shows the task name and resource name, and indicates the status of the task with one of these symbols:

a green square, indicating that the task has been scheduled·
a green tick, indicating that the task is complete·
a red square, indicating that the task is incomplete·
a square divided diagonally with green and red halves, indicating that the task is to be completed within one working·
day

Typically, while a task is in progress it is represented by:

An icon with a green square on the day the work is planned to start, and·
An icon with a red square on the day the work is planned to finish·

When the work is complete, the icons on both days display the green tick.

Tasks can be created and managed through this view of the Project Calendar, or the:

Project Tasks view for the whole project, or·
'Project Tasks' tab of the Personal Tasks window·

Access

Ribbon Start > Collaborate > Calendar > Project Tasks

Manage Project Tasks

Option Action

Create a task Either:

Double-click on the date cell in which the task is to start, or·
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Right-click on the cell and select the 'Add New Task' option, or·
Click on the down-arrow next to the first icon in the Calendar toolbar, and·
select the 'New Task' option

The 'Task Details' dialog displays, through which you create the task.

Display and edit a task Either:

Double-click on the task·
Right-click on the cell and select the 'Properties' option, or·
Click on the down-arrow next to the first icon in the Calendar toolbar, and·
select the 'Properties' option

The 'Task Details' dialog displays; if necessary, edit the information.

Allocate a resource to a
task

Certain tasks might not initially be assigned to a resource, but might later require
specific assignment to finish them off.

Open the task to edit it, click on the drop-down arrow in the 'Assigned' field and
select the required resource.

Delete a task Right-click on any icon for the required task and select the 'Delete <task-name>'
option.

You are prompted to confirm the deletion; click on the Yes button.

Create and send a message
to the task owner

Right-click on any icon for the task and select the 'Message Owner' option.

The 'Model Message' dialog displays, on which you create and send your message
to the user who owns the task (as identified in the 'Task Details' dialog).

If the task does not have a defined owner, this option does not operate.

Create and send a message
to the resource assigned to
the task

Right-click on any icon for the task and select the 'Message Assigned <resource
name>' option.

The 'Model Message' dialog displays, on which you create and send your message
to the resource assigned to complete the task (as identified in the 'Task Details'
dialog).

If the task does not have a defined resource, this option does not operate.

Locate task start date
corresponding to task end
date

Firstly, click on the end date icon for the task to highlight it; the corresponding start
date icon is also highlighted.

If the start date icon is not in view, right-click on the end date icon and select the
'Show Start/End' option; the display scrolls to show the start date and the start date
cell is highlighted.

Locate task end date
corresponding to task start
date

Firstly, click on the start date icon for the task to highlight it; the corresponding end
date icon is also highlighted.

If the end date icon is not in view, right-click on the start date icon and select the
'Show Start/End' option; the display scrolls to show the end date and the end date
cell is highlighted.

Refocus display on today's
date

Right-click anywhere on the display and select the 'Show Today' option.

The display returns to today's date, which is highlighted and outlined.

Notes
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The Project Calendar is available in the Corporate, Unified and Ultimate Editions of Enterprise Architect·
In the Lite Edition of Enterprise Architect, you can view Calendar entries but not change them·
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Collaboration Support in Diagrams

Enterprise Architect provides a simple yet extremely useful facility to notify you immediately via the current diagram
when any Discussion postings are made concerning elements on the diagram, or when Chat postings are made to you by
specific users or groups. Having seen the notification, you can click on it to get instant access to the conversation,
without having to establish who sent the message, on what element, or by what means. Two applications of this facility
are:

You can set up a diagram that monitors Chats with your team members or other regular project contacts (each·
represented by an Actor element), notifying you of any Chat messages from each of them and allowing you to
immediately respond to each message without having to establish connections in the Chat & Mail window; you
could display this diagram as a floating diagram parked in a convenient section of your work area

You can work on and discuss elements in the diagram and maintain the conversation without having to re-establish·
focus in the Discuss & Review window and in the diagram with each exchange

As an additional boost to your work, a context menu is available against each element on any diagram, containing
options that give you instant access to the tabs of the Discuss & Review window, Chat & Mail window and the 'Model
Message' dialog.

A different icon ( ) could be shown against one of your Chat correspondents on the diagram, if you don't have an
unread Chat message; this indicates that the user is currently in a Chat conversation with you, or was the last person to
send you a Chat message.

There are three steps in the process of setting up Collaboration Support in a diagram:

Create/open and populate the diagram in which you will be working and/or monitoring for new Discussion or Chat·
posts

Set a flag on elements in the diagram and on Chat user groups to monitor for messages (not required for messages·
from individual users)

Set a value for the 'Support Collaboration' option in the diagram 'Properties' dialog or Properties window·

Set Up Diagram

If you want to monitor Discussions on elements that you are working on in a diagram, you can do so in any type of
diagram containing any type of element. Simply create or open the appropriate diagram and add and/or configure the
required elements.

If you want to monitor Chat messages from certain people (team members, other project groups, internal stakeholders;
anyone who is defined in User Security as a user or member of a user group) you add an Actor element to the diagram
for each one of those people or groups. In theory you could add the Actor to any diagram that you might be working in,
but it is far more practical to hold all your 'Collaboration' Actors in one separate diagram (a Use Case diagram for
preference) that is always available to monitor receipt of messages during the day.

In either case:

Create/open the diagram and add to it the required number of Actor elements (perhaps use the 'Add Multiple1.
Elements' facility - see the Add Multiple Elements Help topic).

Give each Actor element the name of the security user or user group it represents.2.

For each Actor element, in the 'Alias' field of the Properties window, type the user ID of the user that the element3.
represents. If the Actor represents a user group, give the group ID the prefix group :: - for example:
      group:: LOB_analysis

Ask each user to place a user lock (or, for a user group, a group lock) on their Actor element, to allow 'locking user'4.
identification of the element during the monitoring process. This also gives the user ownership of the Actor element
for other purposes, and provides a level of security for their communications with you.

Your discussions diagram might resemble this:
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The diagram contains three individual users, a user group, and an element against which discussion items can be raised.

Set Monitoring On

In order to display a notification whenever a user posts to a Discussion thread on an element, or to a group Chat with
you, you need to first set the 'Monitoring' flag on the appropriate elements and/or Chat User Groups.

To set up monitoring for Discussions on elements, right-click on the element in the diagram and select the 'Collaborate |
Monitor Discussions' option. For further information, see the Discussions Help topic. You must also set the interval
between checks for new messages, as part of this process.

To set up monitoring for Chat User Groups, display the 'Chat' tab of the Chat & Mail window, click on the options icon
in the top right corner, select the 'Monitor Groups for New Messages' option and select the User Group to monitor. For
further information see the Model Chat Help topic. You must also set the interval between checks for new messages, as
part of this process.

Messages sent to and from Chat threads with individual users (User Chats) are automatically monitored and display a
notification without a flag specifically being set.

Set 'Support Collaboration' on the Diagram

The third step for enabling Discussion and Chat notifications on a diagram is to provide a value for the 'Support
Collaboration' option in the diagram 'Properties' dialog or Properties window. Either:

Open the diagram, right-click on the background, select the 'Properties' option and, on the 'Properties' dialog, select·
the 'Element' tab; at the bottom right of the tab is the 'Support Collaboration' option, or

Click on the open diagram or the diagram name in the Browser window and, in the Properties window, locate the·
'Support Collaboration' option at the bottom of  the 'Appearance' section

Click on the drop-down arrow and select a value.

Select 'None' to turn off Collaboration Support on the diagram for both Discussions and Chats, so no notifications of·
messages will be shown on the diagram

Select any other value to activate Collaboration Support for Discussions; any element for which a Discussion·

message has been posted that you have not yet displayed will show a  notification icon off the top left corner

The other values operate on Actor elements that represent the project members and groups defined in User Security;·

when a Chat message is received by you from another project member, a  notification icon displays on the
diagram to the right of the Actor element representing that person

Select 'With Alias' to check the Actor elements to locate the one that has the poster's user ID or group ID in the·
'Alias' field; the Chat notification icon is displayed against that Actor element

Select 'With Locking User' to check the Actor elements for the one that has been locked under the poster's user ID or·
group ID; the Chat notification icon is displayed against that Actor element

Select 'With Both' to check both characteristics of the Actor elements - firstly for the user ID that locked the element·
and, if that is not found, for the 'Alias' field containing the poster's user ID

Click on the OK button to save the setting.
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The Support Collaboration Facility in Operation

Using the example in the Set Up Diagram section, let us suppose that Hugh has sent a Chat message to the person who is
currently logged in. In the diagram, that user sees the Chat notification icon appear against the 'Hugh' Actor element.

The icon displays against the element whether it is within the current Package or external to it.

If the 'Chat' tab of the Chat & Mail window is open, the owner can click on the Actor element to immediately display the
latest message on the tab, with the cursor positioned ready to create a reply to that message. If the 'Chat' tab is not
displayed, the owner can click on the notification icon, which will open the 'Chat' tab and show the Chat conversation,
again ready to enter a response to the message.

If the 'Team Meeting Items' element has a Discussion item posted against it, the element will show the Discussion
notification icon:

Again, if the 'Discuss' tab is not displayed on the Discuss & Review window, clicking on the icon opens the tab ready to
continue the Discussion; if the tab is displayed, clicking on the element puts this Discussion in focus on the tab.

Context Menus

If you click on this icon, a short context menu displays with options that open the Discuss & Review window at the
'Journal', 'Discuss' and 'Review' tabs, respectively. The same options are also available via the right-click context menu,
'Collaborate' option.

You can therefore open out your conversations on an element to include Journal items and Reviews.

On the Mail icon, when you click on the 'Send Message' option and display the 'Model Message' dialog, it automatically
contains two hyperlinks - one to the selected element, and one to the diagram that contains the selected element. You
specify the recipients of the message, and those people can use the links to directly access the diagram and element under
discussion. The exception is if you have selected an Actor element with a user ID in the element's 'Alias' field; in this
case the message is automatically addressed to the user represented by the Actor, but does not automatically contain any
hyperlinks. You can simply send a message directly to the other user.
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Use Case Estimation

Project estimation is the task of working out how much time and effort is required to build and deploy a solution.

The Use Case metrics facility in Enterprise Architect provides a starting point for estimating project effort; using this
facility you can get a rough measure of the complexity of a system and some indication of the effort required to
implement the model. Like all estimation techniques, Use Case metrics requires some experience with previous projects
to 'calibrate' the process.

There is additional information available on Use Case metrics on the Sparx Systems website.

Access

Ribbon Settings > Reference Data > Model Types > Estimation Factors

Processes

Process Description

Calibrating These values must be carefully calibrated in order to gain the best possible
estimates:

Technical Complexity Factors, which are values that attempt to quantify the·
difficulty and complexity of the work in hand

Environment Complexity Factors, which are values that attempt to quantify·
non-technical complexities such as team experience and knowledge

Default Hour Rate, which sets the number of hours per Use Case point·

Estimating Once you have entered all the calibration values, you can estimate the project
timescale through the 'Use Case Metrics' tab of the QA Reports View.

The estimation process also draws on information on Use Cases recorded on the
'Resource Allocation' tab.
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Technical Complexity Factors

Technical Complexity Factors (TCFs) are used in the Use Case Metrics estimation technique.

The EABase.qea and EABase.eap model contains a default set of TCFs, which you can add to or modify using the
'Estimation Factors' dialog. This set of factors should include all factors that could affect the technical complexity of the
project environment.

Access

Ribbon Settings > Reference Data > Model Types > Estimation Factors > Technical
Complexity Factors

Maintain Technical Complexity Factors

Step Action

1 On the 'Technical Complexity Factors' tab, either:

Click on the New button to add another TCF, or·
Click on the required factor in the 'Defined Technical Types' list to edit it (go to step 3)·

2 In the 'Factor Number' field, type the appropriate TCF number.

3 In the 'Description' field, type or edit the TCF description.

4 In the 'Weight' field, type or edit the technical complexity weighting.

This indicates how much technical complexity you assign to a factor; for example, 'the system is to be
developed in ADA' might warrant a higher weight than 'the system is to be a shell script'.

5 In the 'Value' field, type or edit a value representing the degree of influence the factor has on the project.

As a suggested gauge:

0 indicates no influence·
3 indicates average influence·
5 indicates strong influence·

6 Click on the Save button.

7 Examine the 'Defined Technical Types' list, and scroll across it to show the 'Ex Value' column (Weight x
Value).

The summed Ex Values yield the 'Unadjusted TCF value' (at the bottom of the dialog).

The 'Unadjusted TCF value' is combined with the Environment Complexity Factors to skew the overall
complexity up or down, depending on the level of technical complexity and the corresponding level of
environmental support.
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Notes

The TCF Weight evaluates its respective factor, but is irrelevant to a project; the 'Value' field assesses each factor's·
role within a project and, for most purposes, is the only field requiring adjustment

The supplied factors and their associated weights are defined by the Use Case Points Method, although they can be·
adjusted to suit a project's specific requirements

You can transport the Technical Complexity Factors between models, using the 'Settings > Model > Transfer >·
Export Reference Data' and 'Import Reference Data' ribbon options
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Environment Complexity Factors

Environment Complexity Factors (ECFs) are used in the Use Case Metrics estimation technique.

The EABase.qea and EABase.eap models contain a default set of ECFs, which you can add to or modify using the
'Estimation Factors' dialog. This set of factors should include all factors that could affect the general design and
development environment, including team experience and knowledge, team size, expertise and other non-functional
environmental factors.

Access

Ribbon Settings > Reference Data > Model Types > Estimation Factors > Environment
Complexity Factors

Maintain Environment Complexity Factors

Step Action

1 On the 'Environment Complexity Factors' tab, either:

Click on the New button to add another ECF, or·
Click on the required factor in the 'Defined Environment Types' list to edit it (go to step 3)·

2 In the 'Factor Number' field, type the appropriate ECF number.

3 In the 'Description' field, type or edit the ECF description.

4 In the 'Weight' field, type or edit the environment complexity weighting.

This indicates how much complexity you assign to a factor.

5 In the 'Value' field, type or edit a value representing the degree of influence the factor has on the project.

As a suggested gauge:

0 indicates no influence·
3 indicates average influence·
5 indicates strong influence·

6 Click on the Save button.

7 Examine the 'Defined Environment Types' list, and scroll across it to show the 'Ex Value' column (Weight
x Value).

The summed Ex Values yield the 'Unadjusted ECF' value (at the bottom of the dialog).

The Unadjusted ECF value is combined with the Technical Complexity Factors to skew the overall
complexity up or down, depending on the level of technical complexity and the corresponding level of
environmental support.
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Notes

The ECF Weight evaluates its respective factor, but is irrelevant to a project; the 'Value' field assesses each factor's·
role within a project and, for most purposes, is the only field requiring adjustment

The supplied factors and their associated weights are defined by the Use Case Points Method, although they can be·
adjusted to suit a project's specific requirements

You can transport the Environment Complexity Factors between models, using the 'Settings > Model > Transfer >·
Export Reference Data' and 'Import Reference Data' ribbon options
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Default Hours

Setting an hourly rate is the most difficult factor in an accurate estimation. Typical ranges can vary from 10 to 30 hours
per Use Case point.

Studying the Use Case Points Method, from which this variable is defined, can help you to understand its role in the
estimation and facilitate selection of a suitable initial value.

The best way to estimate this value is through analysis of previous completed projects. By calculating the project
estimation on a completed project for which the Use Cases and environment are configured within Enterprise Architect,
you can adjust the hour rate to render an appropriate value for your unique work environment.

Access

Ribbon Settings > Reference Data > Model Types > Estimation Factors > Default Hour
Rate

Set the default hour rate per adjusted Use Case point

Step Action

1 In the 'Duration' field, type the number of hours per Use Case Point.

2 In the 'Hourly Rate' field, type the cost per hour.

3 Click on the Close button.

Notes

The values you enter are stored as local settings on your computer only·
This option is also active in the 'Lite', read-only version of Enterprise Architect·
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Estimating Project Size

Enterprise Architect uses a simple estimation technique based on the established:

Number of Use Cases to be built·
Difficulty level of those Use Cases·
Project environment factors and·
Build parameters·

This technique is of value only once you have developed a couple of known projects to use as a baseline. Please DO
NOT use the provided 'guesstimates' as a real world measure until you have some real world base lines to measure
against.

Access

Ribbon Click on the required Package in the Browser window, then:

Construct > Project Management > QA > QA Reports > Use Case Metrics

Complete a Use Case Metrics Estimation

Field Action

Root Package Confirm the root Package in the hierarchy.

All Use Cases under this Package could potentially be included in the report.

Reload Re-run the load from the selected Package, usually after you change the filter
criteria.

Phase like Include Use Cases with a phase that matches the wildcard value in the field.

Use * to match any characters; for example, 1.* for 1.1 and 1.2.

Keyword like Include Use Cases with a keyword that matches the wildcard value in the field.

Use * to match any characters.

Bookmarked Include all Use Cases, or only those that are tagged, or those that are not tagged.

Use Cases Check the total count of Use Cases in the estimate.

The Use Cases and their parameters are listed in the panel underneath this field.

Include Actors Select to include Actors in the estimate.

Technical Complexity
Factor

Review the parameters that describe the degree of technical complexity of the
project.

While the 'Unadjusted TCF Value' comes from the 'Technical Complexity Factors'
tab of the 'Estimation Factors' dialog, the other values compose the Use Case Points
Method formula.
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Modify these fields with caution.

The final project estimate is directly proportional to the TCF.

Environment Complexity
Factor

Review the parameters that calculate the degree of environmental complexity of the
project, from factors such as programmer motivation or experience.

The listed parameters compose the formula calculating the ECF, defined by the Use
Case Points Method; the only parameter affected by the project is the Unadjusted
ECF Value, derived from the 'Environment Complexity Factors' tab of the
'Estimation Factors' dialog.

The final project estimate is directly proportional to the ECF.

Unadjusted Use Case
Points (UUCP)

Check the sum of the Use Case complexity numbers.

Ave Hours per Use Case Check the average number of hours assigned to easy, medium and difficult Use
Cases.

You cannot change these figures.

Total Estimate Review the detailed breakdown of the final figure.

You must tailor the hours per Use Case Point figure to the level that matches your
type of project and capability based on known previous project outcomes.

Default Rate Set the default number of hours to be fed into the final calculation.

Re-Calculate Re-run the estimate, usually after you change the hours or Use Case point number.

Report Produce a rich text formatted report from the current estimate.

View Report Display the last-generated report.
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